Cifrix.

Citrix Workspace app for Mac

Citrix Product Documentation | https://docs.citrix.com March 8, 2025


https://docs.citrix.com

Citrix Workspace app for Mac

Contents

Citrix Workspace app for Mac 3
About this release 5
Features in Technical Preview 104
Citrix Workspace app for Mac 2503 - Preview 125
System requirements and compatibility 135
Install, uninstall, and upgrade 142
Updates and plugins management 149
Update 149
Plug-ins management 162
Configure Citrix Workspace app 166
Mobile Device Management 169
Store configuration 181
Security and Authentication 189
Authenticate 189
Security 199
Secure communications 200
App experience 209
Application delivery 209
Enhanced virtual apps and desktops launch experience for Workspace 211
App preferences 212
Data collection and monitoring 230
HDX and multimedia 232
Browser Content Redirection 233
© 1999-2025 Cloud Software Group, Inc. All rights reserved. 1



Citrix Workspace app for Mac

Graphics and display 237
Optimized Microsoft Teams 242
HDX transport 249
HDX direct 250
Devices 250
Audio and Microphone 251
Client drive mapping 254
Keyboard 255
Printing 274
usB 276
Webcam 282
Session experience 284
Troubleshooting 297
Deprecation 303

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 2



Citrix Workspace app for Mac

Citrix Workspace app for Mac

January 28,2025

Citrix Workspace app for Mac is an easy-to-install app that provides access to your applications and
desktops using Citrix Virtual Apps and Desktops and Citrix Daa$ (formerly Citrix Virtual Apps and Desk-
tops service) from a remote client device. Citrix Workspace app for Mac combines ease of deployment
and use, and offers quick, secure access to hosted applications and desktops.

For detailed information about the features, fixed issues, and known issues, see the About this Release
page.
For information about deprecated items, see the Deprecation page.

You can use Citrix Workspace app on various devices running macOS. For information about the fea-
tures available in Citrix Workspace app for Mac, see Citrix Workspace app Feature Matrix.

Language support

Citrix Workspace app for Mac is adapted for use in languages other than English. For a list of languages
supported by Citrix Workspace app for Mac, see Language support.

Earlier versions

Citrix Workspace app 2411 for Mac (PDF Download)
Citrix Workspace app 2409.10 for Mac (PDF Download)
Citrix Workspace app 2409 for Mac (PDF Download)
Citrix Workspace app 2405.11 for Mac (PDF Download)
Citrix Workspace app 2405 for Mac (PDF Download)
Citrix Workspace app 2402.10 for Mac (PDF Download)
Citrix Workspace app 2402 for Mac (PDF Download)
Citrix Workspace app 2311 for Mac (PDF Download)
Citrix Workspace app 2309 for Mac (PDF Download)
Citrix Workspace app 2308 for Mac (PDF Download)
Citrix Workspace app 2307 for Mac (PDF Download)

Citrix Workspace app 2306 for Mac (PDF Download)
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Citrix Workspace app 2305 for Mac (PDF Download)
Citrix Workspace app 2304 for Mac (PDF Download)
Citrix Workspace app 2301.1 for Mac (PDF Download)
Citrix Workspace app 2301 for Mac (PDF Download)
Citrix Workspace app 2211 for Mac (PDF Download)
Citrix Workspace app 2210 for Mac (PDF Download)
Citrix Workspace app 2209 for Mac (PDF Download)
Citrix Workspace app 2208.1 for Mac (PDF Download)
Citrix Workspace app 2206.1 for Mac (PDF Download)
Citrix Workspace app 2204 for Mac (PDF Download)
Citrix Workspace app 2203.1 for Mac (PDF Download)
Citrix Workspace app 2201 for Mac (PDF Download)
Citrix Workspace app 2112 for Mac (PDF Download)
Citrix Workspace app 2111 for Mac (PDF Download)
Citrix Workspace app 2110 for Mac (PDF Download)
Citrix Workspace app 2107 for Mac (PDF Download)
Citrix Workspace app 2104 for Mac (PDF Download)
Citrix Workspace app 2102 for Mac (PDF Download)
Citrix Workspace app 2101 for Mac (PDF Download)

Documentation for these product versionsis provided as PDFs because they are not the latest versions.
For the most recently updated content, see Citrix Workspace app for Mac current release documenta-
tion. That documentation includes instructions for upgrading from earlier versions.

NOTE:

Links to external websites found in these PDFs take you to the correct pages, but links to other
sections within the PDF are no longer usable.

Reference articles

 Tech Brief: Citrix Workspace

Developer Documentation

Global App Configuration service

App Protection
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Workspace user interface (Ul)

Microsoft Teams optimization in Citrix Virtual Apps and Desktops environments

Citrix Workspace app for iOS

Citrix Workspace app release timelines

What’s new in related products

Citrix Enterprise Browser: About this release

Citrix Workspace: What’s new
Citrix DaaS: What’s new
StoreFront: What’s new

Secure Private Access: What’s new

Legacy documentation

For product releases that have reached End of Life (EOL), see Legacy documentation.

About this release

March 3, 2025

Learn about new features, enhancements, fixed issues, and known issues for Citrix Workspace app for
Mac.

Alist of featuresin Technical Preview is maintained in the Features in Technical Preview section, so you
can find them in one place. Explore our preview features and share your feedback using the attached
form link.

Note:

+ The auto-update service is supported on version 2304 or later. If you’re using Citrix Work-
space app for Mac versions 2301 or earlier, you can’t update to the latest versions through
the auto-update service. Instead, you must manually install Citrix Workspace app for Mac
versions 2304 or later by downloading the .dmg file available on the Downloads page. For
more information, see Manual install.

« Starting with the 2405 version, Citrix Workspace app for Mac provides a single unified build
that is compatible natively on both Apple silicon and Intel-based Macs.
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What’s new in 2411.10

This release addresses areas that improve overall performance and stability.

Deprecation announcement of XenApp Services

Citrix is planning to deprecate the XenApp Services (also known as PNAgent) in future releases. For
more information, see Deprecation.

Citrix Enterprise Browser

This release includes Citrix Enterprise Browser version 132.1.1.25, based on Chromium version 132.
For more information, see the Citrix Enterprise Browser documentation.

Fixed issuesin 2411.10

« Citrix Workspace app for Mac becomes unresponsive when using Microsoft Teams. [HDX-74085]
+ When Authentication Domain of Cloud Store changes, Citrix Workspace app might not function
properly and requires deletion and addition of Store account. [RFMAC-17025]

Known issues in 2411.10

There are no new known issues in the release.

Earlier releases

This section lists features in previous releases along with their fixed and known issues. Releases reach
End of Life (EOL) 18 months after the release date. For details about lifecycle dates for the supported
versions, see Lifecycle Milestones for Citrix Workspace app and Citrix Receiver.

2411

What’s new

Enhancing Citrix security with pre-populated user name
+ Version control using MDM and GACS

+ Auto updates support scheduling

« Auto-update enhancement for active users
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+ UCSDK HID Implementation

« Enhanced keyboard and IME diagnostics tool

« HDX Direct

+ Support for log collection when session launch fails

« Support for plug and play webcam redirection

+ Seamless drag and resize improvements

» Support for browser content redirection (Technical Preview)

« Enhanced display control with Multi-Monitor selector (Technical Preview)

« USB Redirection of mass storage devices (Technical Preview)

» HDX Direct for non-shield scenario (Technical Preview)

» Enable Audio Quality Enhancer to improve audio performance (Technical Preview)
+ Mandate end users to authenticate and access apps and desktops through native app
+ Auto-update support for user groups

Enhancing Citrix security with pre-populated user name

Starting with version 2411, administrators can use Mobile Device Management (MDM) to push the user
name in a specific format to manage devices. Citrix Workspace app reads this configuration, retrieves
the user name, and pre-populates it within the authentication prompt, making it read-only. This en-
sures that only end users to whom a Mac is registered can authenticate to the Citrix Workspace app
on that specific machine. This feature enhances sign-in security and gives administrators greater con-
trol over authentication. For more information, see Enhancing Citrix security with pre-populated user
name.

Version control using MDM and GACS

Starting with version 2411, administrators can configure Citrix Workspace version control and
Client App Management using Mobile Device Management (MDM) and Global App Configuration
Service (GACS). This capability enables administrators to configure the start date and end date for
auto-update of specific versions of Citrix Workspace app. For more information, see Version control
using MDM and GACS.

Support for auto-update scheduling

Starting with version 2411, admins can schedule auto-updates for the Citrix Workspace app during
convenient hours. This capability allows them to determine the rollout period, minimizing disruption
to end-users, and improving adoption of the auto-update service, which was previously controlled
by Citrix. Additionally, admins can specify the time of day for users to receive notifications about
available updates. For more information, see Support for auto-update scheduling.
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Auto-update enhancement for active users

Starting with version 2411 of Citrix Workspace app for Mac, the auto-update feature has been en-
hanced to trigger only for active users. This change aims to provide better control by ensuring that
auto-update is available only for users with Global App Configuration service (GACS) or Mobile De-
vice Management (MDM) policies, or who are actively using the app. For more information, see Auto-
update enhancement for active users.

Support for WebHID APl in UCSDK

Starting with the 2411 version, Citrix Workspace app for Mac supports the WebHID API to redirect Hu-
man Interface Devices (HIDs) from endpoint to Unified Communication SDK application on the VDI.
It complies with the HID standard for bi-directional communication between the application based
on UCSDK and the HID devices connected to the endpoint. For more information, see Support for
WebHID APl in UCSDK.

Enhanced keyboard and IME diagnostics tool

Starting with version 2411, a new self-service command-line tool hosted in Windows Virtual Delivery
Agent (VDA) is supported by Citrix Workspace app for Mac to diagnose keyboard and Input Method
Editor (IME) related issues. This tool meets various user requirements, provides platform versatility,
and caters to personalized needs. For more information, see Enhanced keyboard and IME diagnostics
tool.

HDX Direct

Starting with the 2411 version, Citrix Workspace app for Mac supports HDX Direct transport for the con-
nection between Citrix Workspace app and the VDA server. For more information, see HDX Direct.

Support for log collection when session launch fails

Starting with version 2411, Citrix Workspace app for Mac supports direct log collection when session
launch fails, allowing for quicker troubleshooting and easier access to logs. For more information, see
Support for log collection when session launch fails.

Support for plug and play webcam redirection

Starting with the 2411 version, Citrix Workspace app for Mac supports plug and play (PnP) webcam
redirection for Linux VDA and Windows VDA. With this feature, when you connect a built-in or external
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camera to your device, it is automatically detected in the virtual sessions. For more information, see
Support for plug and play webcam redirection.

Seamless drag and resize improvements

Starting with version 2411, the seamless drag and resize enhancement feature is automatically en-
abled when Citrix Workspace app for Mac connects to a Windows VDA version 2311 or later. This
enhancement provides a smoother drag and resize experience for virtual apps, ensuring seamless
interaction. For more information, see Seamless drag and resize improvements.

Mandate end users to authenticate and access apps and desktops through native app

Starting with version 2411, admins can mandate users on Mac devices to access Citrix Workspace app
exclusively through the native app. When this feature is enabled, users attempting to access the store
URL and third-party browsers are automatically redirected to the Citrix Workspace app. This ensures
they can take advantage of all the native app’s capabilities and enjoy a seamless user experience. For
more information, see Enforcing Citrix access using Citrix Workspace app.

Auto-update support for user groups

Starting with version 2411, customers can configure different app versions for different user groups
through Configuration Profile in Global App Configuration Service (GACS). For more information, see
Auto-update support for user groups.

Citrix Enterprise Browser

This release includes Citrix Enterprise Browser version 130.1.1.12, based on Chromium version 130.
For more information, see the Citrix Enterprise Browser documentation.

Technical previews

» Support for browser content redirection

+ Enhanced display control with Multi-Monitor selector

« USB Redirection of mass storage devices

+ HDX Direct for non-shield scenario

» Enable Audio Quality Enhancer to improve audio performance

For a complete list of Technical Preview features, see the Features in Technical Preview page.
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Fixed issues

« You might experience Server File Type Association (SFTA) redirection failure in an Mu-
tual Transport Layer Security (mTLS) workflow when accessing internal URLs from Mac.
[CVADHELP-26806]

« The webcam H.264 encoder has a bandwidth limit for resolutions up to 1080p. [HDX-69178]

« You might encounter issues deploying Citrix Workspace app for Mac through Intune.
[CVADHELP-27098]

2409.10
What’s new

This release addresses areas that improve overall performance and stability.

Citrix Enterprise Browser

This release includes Citrix Enterprise Browser version 128.1.1.32, based on Chromium version 128.
For more information, see the Citrix Enterprise Browser documentation.

Fixed issues in 2409.10

« Citrix Workspace app for Mac might not function as expected if background elements are dis-
abled. End user is prompted to enable background items. For more information, see Citrix
Knowledge Center article - CTX691439. [RFMAC-15942]

« You might encounter issues with multi-monitor support, leaving one screen appearing gray.
[HDX-70907]

+ Transport Protocol status in the Connection Strength Indicator might incorrectly display a mes-
sage indicating HTML5. [HDX-71031]

+ You might see the session notification pop-up in the lower right corner and remain visible.
[CVADHELP-26474]

2409
What’s new

+ Support for macOS 15 Sequoia
+ Client App Management
» Support for restricting users to modify the update channel

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 10
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+ Support for Rapid Scan

« Enhanced virtual desktop screen resizing experience

» Enhanced desktop launch experience

» Enhanced clipboard support for HTML text, files and folders

+ Support for managing composite USB device redirection using DDC policies
« Enhancements to the smart card reader authentication

» Enhanced Desktop Viewer toolbar

« Connection Strength Indicator

« HDX Direct (Technical Preview)

+ Support for multiple webcam resolutions (Technical Preview)

+ Support for Plug and play webcam redirection (Technical Preview)
+ Feature flag management

Support for macOS 15 Sequoia

Citrix Workspace app for Mac is supported on macOS 15 Sequoia.

Client App Management

Starting with version 2409, Citrix Workspace app for Mac offers Client App Management capability that
makes the Citrix Workspace app a single client app required on the end point to install and manage
agents such as Citrix EndPoint Analysis (EPA) and Zoom VDI plug-ins. With this feature, administrators
can easily deploy and manage required agents from a single management console. You can configure
this feature using the Global App Configuration service (GACS). For more information, see Client App
Management.

Support for restricting users to modify the update channel

Starting with the 2409 version, the Citrix Workspace app for Mac allows the admin to manage the Se-
lect the update channel option. With this feature, you have control over the update channel prefer-
ence, ensuring that end users cannot modify it. This ensures that the update channel remains consis-
tent and secure, as per your administrative settings. For more information, see Support for restricting
users to modify the update channel update.

Support for Rapid Scan

Starting with the 2409 version, Citrix Workspace app for Mac supports the Rapid scan feature. You
can use this feature to scan multiple documents with an iOS device, and then transfer those scanned
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documents to a Mac device using the Citrix Workspace app for Mac and iOS. For more information, see
Support for Rapid Scan.

Enhanced virtual desktop screen resizing experience

Starting with the 2409 version, Citrix Workspace app for Mac ensures a smooth transition and pre-
vents dark screens and flickers when resizing or stretching your virtual desktop screen. This feature
is enabled by default.

Enhanced desktop launch experience

Starting with version 2409, Citrix Workspace app for Mac ensures an enhanced desktop launch ex-
perience. You’ll experience a seamless, flicker-free transition to your desktop without intermediate
screens. The app also eliminates dark screens and flickering during resizing or stretching, providing
a stable and modern interface. This feature is enabled by default.

Enhanced clipboard support for HTML text, files, and folders

Starting with version 2409, Citrix Workspace app for Mac supports the seamless copying and pasting
of HTML-formatted text, files, and folders between a Mac local app and a virtual app or desktop ses-
sion running through Citrix Workspace app for Mac. For more information, see Enhanced clipboard
support for HTML text, files, and folders.

Support for managing composite USB device redirection using DDC policies

Starting with the 2409 version, you can manage the composite USB device redirection using the DDC
policies. For more information, see Support for managing composite USB device redirection using
DDC policies.

Enhancements to the smart card reader authentication

Starting with the version 2409, Citrix Workspace app supports the Fast smart card feature. Fast Smart
card is an improvement over the existing HDX PC/SC-based smart card redirection. It improves per-
formance significantly when smart cards are used in high-latency WAN environments. For more infor-
mation, see Enhancements to the smart card reader authentication
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Enhanced Desktop Viewer toolbar

Starting with the 2409 version, the virtual Desktop Viewer toolbar is enhanced to be more intuitive,
modern, and user-friendly. With this feature, you can now customize the Citrix Workspace app toolbar
by adding and removing options on the toolbar. For more information, see Enhanced Desktop Viewer
toolbar

Connection Strength Indicator

Starting with version 2409, Citrix Workspace app for Mac supports the Connection Strength Indicator
(CSI) on the Desktop Viewer toolbar. This feature displays a network strength icon that alerts you
of network issues. By clicking the icon, you can view real-time connection statistics for the client,
gateway, and VDA, and copy diagnostic information to share with IT for advanced troubleshooting.
For more information, see Connection Strength Indicator

Feature flag management

Citrix is changing the way it manages feature flags, allowing access to preview features and enabling
dynamic management of features in production. To ensure optimal functioning of features which are
under feature flags, you need to enable traffic to the URL features.netscalergateway.net.
For more information, see Feature flag management.

Citrix Enterprise Browser

This release includes Citrix Enterprise Browser version 128.1.1.32, based on Chromium version 128.
For more information, see the Citrix Enterprise Browser documentation.

Fixed issues in 2409

+ You might notice that the settings configured for Citrix Workspace app using the Global App
Configuration Service are not applied on the Mac device. [CVADHELP-25674]

« When you customize the themes for Citrix Workspace app for Mac on StoreFront deployment,
you might notice that the menus or text on the Ul become invisible based on the themes applied.
[CVADHELP-25427]

« When using the built-in camera in the virtual desktop session, you might notice that the video
is stretched in the output. [HDX-66510]

+ You might experience URL redirection failures for URLs containing “%2f”. [CVADHELP-26067]

+ When using Citrix Workspace app for macOS to run the new Teams in optimized mode, you
might notice that the peer user cannot take control. [CVADHELP-26227]
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« When Plug and Play (PnP) is enabled, you might fail to switch webcam from the apps that shows
only one camera with a generic name “Citrix HDX Web Camera’. [HDX-69729]

2405.11
What’s new

Citrix Workspace app for Mac 2405.10 has been rolled back due to a bug. The bug has been fixed in
Citrix Workspace app for Mac 2405.11.

Citrix Workspace app for Mac 2405.11 release addresses a few issues that help to improve overall per-
formance and stability.

Citrix Enterprise Browser

This release includes Citrix Enterprise Browser version 126.1.1.22, based on Chromium version 126.
For more information, see the Citrix Enterprise Browser documentation.

Fixed issues in 2405.11

« When you open the Citrix Workspace app for Mac through the custom web portal, you might
notice that the links on the landing page direct you to blank pages. [CVADHELP-25665]

+ You might have noticed that the newly added apps are not visible to the end user on the auto-
matic refresh of Citrix Workspace app. [CVADHELP-25189]

« When the Citrix Viewer is moved to an external monitor, you might notice that the Citrix Viewer
disappears if you unplug the external monitor. [HDX-68620]

2405
What’s new

Support for unified build for both Apple silicon and Intel-based Mac devices Previously, Citrix
Workspace app for Mac provided separate build to support natively on Apple silicon and Intel-based
Mac devices.

Starting with the 2405 version, Citrix Workspace app for Mac supports a single unified build that is
compatible natively on both Apple silicon and Intel-based Macs.

Support for Mac with M3 chips Starting with the 2405 version, Citrix Workspace app for Mac sup-
ports the Mac with M3 series along with the M1 and M2 series that was previously supported.
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Support for Activity Manager on the quick access menu for cloud stores Starting with the 2405
version, Citrix Workspace app for Mac supports the Activity Manager feature. This feature lets end
users view and interact with all their active apps and desktop sessions at one place. You can discon-
nect or terminate the active sessions directly from the Activity Manager. For more information, see
Support for Activity Manager on the quick access menu for cloud stores and Activity manager.
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Support for resetting Citrix Workspace app Starting with the 2405 version, Citrix Workspace app
for Mac supports the Reset App Data option. This feature allows users to quickly resolve issues result-
ing from conflicts caused by cache or settings by resetting the app and get unblocked without external
assistance.

When you reset the Citrix Workspace app:

« The app is reverted to its default state (similar to just after fresh installation).
+ All caches are cleared.

« Any added stores are removed.

« Preference settings are returned to their default state.

For more information, see Support for resetting Citrix Workspace app.
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Support for device touch ID for FIDO2 password-less authentication Previously, Citrix Work-
space app supported FIDO2 password-less authentication through the roaming authenticators (USB
only) with PIN code and touch.

Starting with the 2405 version, Citrix Workspace app now supports device touch ID for FIDO2
password-less authentication, enhancing the sign-in experience for users. With this feature, users
can securely sign in to the store configured on the Citrix Workspace app using the device touch ID,
eliminating the need for passcodes or passwords. This feature enhances both the usability and
security of Citrix Workspace app for macOS users. This feature is enabled by default. For more
information, see Support for device touch ID for FIDO2 password-less authentication.

Enhanced virtual apps and desktops launch experience for on-premises stores and custom web
portals Starting with the 2405 version, the enhanced virtual apps and desktops launch experience
is now supported for on-premises stores and custom web portals. This feature enhances the opening

experience of Citrix resources to be more intuitive, informative, and user-friendly.
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The launch progress notification now appears at the lower-right corner of your screen. A progress

status of the resources, which are in the process of being opened is shown. You cannot retrieve the
notification once you dismiss it. The notification stays for a few seconds from the time you start the
session. If the session fails to start, then the notification shows the failure message.
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If the problem persists, contact your admin with this
transaction ID.
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For more information, see Enhanced virtual apps and desktops launch experience.

Support for automaticinstallation of the End-Point Analysis (EPA) plug-in with Citrix Workspace
app Previously, users were required to manually download and install the End-Point Analysis (EPA)
plug-in during the Citrix Workspace app login.

Starting from 2405 version, Citrix Workspace app supports the automatic installation of the EPA plug-
in during installation or updates. When you install or update Citrix Workspace app, the EPA plug-in is
included by default. This enhancement eliminates the need for separately installing the EPA plug-in,
resulting in a smoother experience during Citrix Workspace app setup. For more information, see Sup-
port for automatic installation of the End-Point Analysis (EPA) plug-in with Citrix Workspace app.

Support for optionally installing Citrix Enterprise Browser Starting with 2405 version, you have
the flexibility to choose whether to install Citrix Enterprise Browser during the installation of the Citrix
Workspace app for Mac. Also, if you’ve already installed Citrix Enterprise Browser with Citrix Work-
space app, you can uninstall Citrix Enterprise Browser using the Global App Configuration service and
Mobile Device Management (MDM). This feature allows administrators to maintain compliance by con-
trolling whether Citrix Enterprise Browser is allowed for use on their managed devices. For more in-
formation, see Support for optionally installing Citrix Enterprise Browser.

Support for Citrix Workspace widgets Starting with the 2405 version, Citrix Workspace app for
Mac supports widgets for quick access to its virtual apps and desktops. With this feature, you can
easily access your favorite virtual apps and desktops from the widget that is added to your desktop or
Notification center.
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Citrix Workspace supports two types of widgets, small and large widgets. The small widget can hold
either one virtual app or desktop. The large widget can hold six favorite virtual apps and desktops
with desktop listed at first. For more information, see Support for Citrix Workspace widgets.

All Widgets @ Citrix Workspace

o ) Tsvda19
\d Batteries
WSVDA

@ Blinkit Calculator

Tsvda19 l  Concur

Calendar

| Notepad

(G, citrix Workspace (B

View your favourite apps/desktops at View your favourite apps/desktops at

% Clock Quick Access Quick Access
- a glance. a glance.

° ! Contacts

Provision to manage multiple proxy servers using PAC files Starting with the 2405 version,
you can use multiple proxy servers that allow the HDX sessions to select appropriate proxy servers
for accessing specific resources. This selection is based on the proxy rules configured in the Proxy
Auto-Configuration (PAC) file. Using this file, you can manage the network by mentioning which
network traffic must be sent through a proxy server and which must be sent directly. Also, the PAC
URL supports both http:// and file:// protocols. For more information, see Provision to manage
multiple proxy servers using PAC files

Upgraded version of WebRTC for the optimized Microsoft Teams The version of WebRTC that
is used for the optimized Microsoft Teams is upgraded to version M117. For more information, see
Upgraded version of WebRTC for the optimized Microsoft Teams.

Support for printing PDF documents with selected orientation Starting with the 2405 version,
you can now print PDF documents with the correct orientation whether it’s portrait or landscape.
This feature ensures that the printed output aligns perfectly with the intended layout. This feature
is enabled by default. For more information, see Support for printing PDF documents with selected
orientation.

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 18


https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/app-experience/app-preferences#support-for-citrix-workspace-widgets
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/security-authentication/secure-communications#provision-to-manage-multiple-proxy-servers-using-pac-files-technical-preview
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/security-authentication/secure-communications#provision-to-manage-multiple-proxy-servers-using-pac-files-technical-preview
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/hdx-multimedia/optimized-microsoft-teams#upgraded-version-of-webrtc-for-the-optimized-microsoft-teams
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/devices/printing#support-for-printing-pdf-documents-with-selected-orientation
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/devices/printing#support-for-printing-pdf-documents-with-selected-orientation

Citrix Workspace app for Mac

Enable Packet Loss Concealment to improve audio performance Starting with the 2405 version,
thejitter buffer mechanismisimproved, and the Packet Loss Concealment (PLC) is added for the Adap-
tive audio codec. PLC helps to reconstruct the lost data packets. This enhancement helps to improve
the packet loss tolerance and jitter tolerance and thus improves audio performance for loss tolerant
mode (EDT lossy) for audio. For more information, see Enable Packet Loss Concealment to improve
audio performance.

Modernized Citrix Virtual Channel SDK for Citrix Workspace app for Mac  Starting with the 2405
version, the Citrix Virtual Channel Software Development Kit (VCSDK) supports the desktop and screen
sharing VCSDK API and gbuffer sharing.

For more information, see Virtual driver screen sharing and app-sharing functions.

Enhancement to the keyboard Settings Starting with the 2405 version, Citrix Workspace app now
provides animproved keyboard settings user interface (Ul) by categorizing setting options and adding
helpful tip icons. Enhancement to the keyboard Settings.

[ y »

[—— —

® Keyboard

General Accounts File Access Devices

System shortcuts take effect on: Local device e

Keyboard layout synchronization settings: = Sync only once - when session starts

Keyboard input mode settings: = Unicode e
Choose keyboard shortcuts configuration for Unicode mode:
Send Control character using: 3 Command (left) or ~ Control -
Send Alt character using: 3\ Command (left)-Option -

Send Windows logo key using ¥ Command (right)

Send special keys unchanged (press $ Command (left) for some keys)

Show the remote language bar for the published applications

Changes will take effect once you reconnect to this application.
Learn more Restore Defaults

Support for extending the desktop session to external monitors automatically Starting with the
2405 version, Citrix Workspace app supports the extension of desktop sessions to external monitors
automatically. With this feature, when you launch the desktop session on the endpoint, if the external
monitors are already connected to the endpoint, then the session is extended to external monitors
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automatically. When you disconnect the external monitor, the session can automatically adjust to
extend only to the connected monitors. For more information, see Support for extending the desktop
session to external monitors automatically.

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 126.1.1.20, based
on Chromium version 126. For more information, see the Citrix Enterprise Browser documentation.

Modify the user-agent of Citrix Enterprise Browser Administrators can now modify the Citrix
Enterprise Browser’s user-agent for any internal web or SaaS apps. You can configure this setting
through the Global App Configuration service. This feature provides the flexibility to create different
variations of the user-agent for Citrix Enterprise Browser, which you can use for various uses.

One such use-case is the ability to restrict the internal web or SaaS apps to open only in Citrix Enter-
prise Browser. In addition to modifying the user-agent, you need to configure the Identity Provider
(IdP) to perform a conditional check that verifies whether the end user is trying to open the app us-
ing Citrix Enterprise Browser or a native browser. The IdP opens the app only if the end user tries
to access it using Citrix Enterprise Browser. This restriction prevents users from accessing sensitive
information in these apps from other browsers.

For more information, see Use Case 3c - Restrict apps to Citrix Enterprise Browser by modifying its
user-agent

Additional security restrictions for the Citrix Enterprise Browser Citrixintroduces additional ac-
cess restrictions to enhance the security and user experience of Citrix Enterprise Browser with Secure
Private Access and Global App Configuration service (GACS).

Restrictions managed through Secure Private Access Copy

Administrators can enable or disable copying of data from a SaaS or internal web app with this access
policy when accessed via Citrix Enterprise Browser. The default value is Enabled.

For more information, see the Copy restriction in the Secure Private Access product documentation.
Paste

Administrators can enable or disable pasting of copied data into the SaaS or internal web app with
this access policy when accessed via Citrix Enterprise Browser. The default value is Enabled.

For more information, see the Paste restriction in the Secure Private Access product documenta-
tion.

Personal data masking
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Administrators can use the Personal data masking restriction to mask various types of sensitive infor-
mation such as credit card numbers, social security numbers, and dates. Also, you have the flexibility
to define custom rules for detecting specific types of sensitive information and masking it accordingly.
The Personal data masking restriction has the option to fully or partially mask the information.

For more information, see Personal data masking.
Upload restriction by file type

Administrators can restrict file uploads based on MIME (multi-purpose internet mail extensions) types.
Unlike the Uploads policy, which allows you to enable or disable all file uploads, the Upload restric-
tion by file type restriction allows you to enable or disable file uploads for specific MIME types.

For more information, see Upload restriction by file type.
Download restriction by file type

Administrators can restrict file downloads based on MIME (multi-purpose internet mail extensions)
types. Unlike the Downloads policy, which allows you to enable or disable all file downloads, the
Download restriction by file type restriction allows you to enable or disable file downloads for spe-
cific MIME types.

For more information, see Download restriction by file type.
Printer management

Enterprises can now prevent the printing of confidential documents and unauthorized data sharing.
Admins can configure this policy through Secure Private Access. Admins can configure the behavior
for network printers, local printers, and prints using the Save as PDF option.

Thefollowing options are available for administrators to control access to printers for the end users:

+ Network printers: A network printer is a printer that can be connected to a network and used
by multiple users.

- Disabled: Printing from any network printers in the network is disabled.
- Enabled: Printing from all network printersis enabled. If printer hostnames are specified,
then all other network printers apart from the ones specified are blocked.

Note:

Printers are identified by their hostnames.

+ Local printers: A local printer is a device directly connected to an individual computer. This
connection is typically facilitated through Bluetooth, USB, parallel ports, or other direct inter-
faces.

- Disabled: Printing from all local printers is disabled.
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- Enabled: Printing from all local printers is enabled.
+ Print using Save as PDF

- Disabled: The Save as PDF option for saving the content in PDF format is disabled.

- Enabled: The Save as PDF option for saving the content in PDF format is enabled.

Note:

« Ifthe admin has disabled certain printing options, then those options appear grayed out to
the end users.
« End users can’t use the network printer if it is renamed on their device.

Clipboard restriction for Security groups

In Secure Private Access, administrators can restrict clipboard access to any designated group of apps.
These designated groups of apps are created as Security groups in Secure Private Access, so that the
end users are permitted to copy and paste contents only within that Security groups. There is also an
Advanced option to enable copy and paste contents between Security groups and other local apps on
the machines or unpublished web apps.

For more information, see Clipboard restriction for Security groups.

Restrictions managed through Global App Configuration service Clipboard restriction

In GACS, administrators can use the Enabled Sandboxed Clipboard option to manage clipboard ac-
cess. When you restrict clipboard access through GACS, all content copied from any website accessed
within the Citrix Enterprise Browser can’t be pasted outside the Enterprise Browser. Similarly, any
content copied from native apps can’t be pasted into any website accessed within the Enterprise
Browser.

For more information, see Clipboard restriction.
Audio Capture Allowed

Administrators can use this setting to enable or disable audio capture access. When an administrator
enables this setting, or leaves it unset, users are prompted to allow audio capture access. When an
administrator disables this setting, these prompts are turned off, and audio capture is blocked.

For more information, see Audio Capture Allowed.
Video Capture Allowed

Administrators can use this setting to enable or disable video capture access. When an administrator
enables this setting, or leaves it unset, users are prompted to allow video capture access. When an
administrator disables this setting, these prompts are turned off, and video capture is blocked.

For more information, see Video Capture Allowed.
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Technical Preview

« Support for Mac VoiceOver on the virtual desktop and seamless app sessions
« Support for Plug and play webcam redirection

+ Support for managing composite USB device redirection using DDC policies
« Support for HTML format on the Citrix Workspace app for Mac clipboard

+ Support for sharing system audio on Microsoft teams

+ Support for YUV444 color format

« Enhancements to the smart card reader authentication

 Support for fast smart card

» Support for browser content redirection

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues in 2405

» When using the optimized Microsoft Teams in the virtual session, you might notice that the echo
cancellation feature is not working in the virtual session. [HDX-65123]

+ When using Citrix Workspace app on the macOS Sonoma, you might notice that the USB devices
such as mouse and keyboard are not accessible locally once connected to the virtual session.
[CVADHELP-2413]

« When using the optimized Microsoft Teams 2.1 in the virtual session, you might notice that the
sender and receiver sees the video stretched with an incorrect aspect ratio during the call. [HDX-
66354]

« After upgrading from Citrix Workspace app version 2402 or 2402.10 to 2405, you might rarely
notice that the resource icons are not displayed correctly on Citrix Workspace app for the
on-premises stores. For more information, see Citrix Knowledge Center article - CTX677048.
[RFMAC-16042]

2402.10
What’s new

This 2402.10 release addresses a few issues that help to improve overall performance and stability.

Enhancements to quit functionality of Citrix Workspace app Starting with the 2402.10 version,
the quit functionality of Citrix Workspace app is improved and matches Apple’s Quit menu behavior.
When you exit the Citrix Workspace app using one of the following options, the app closes and no
longer runs in the background.

« Quit Citrix Workspace from the menu bar,
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+ Quit from the dock,
+ Quit from the Quick Access menu, or
+ Press the Command-Q keys.

Fixed issues in 2402.10

« The security vulnerability that allowed local authenticated users to elevate their privileges to
root users has been fixed. For more information, see CTX675851. [CVE-2024-5027]

2402
What’s new

Improved loading experience of virtual apps and desktops for on-premises deployments Citrix
Workspace app for Mac has improved the first-time user experience for on-premises deployments.
After successful authentication, the enumeration of virtual apps and desktops is faster than before.

Support for H.265 video decoding Starting with the 2402 version, Citrix Workspace app for Mac
supports the use of the H.265 video codec (HEVC) for hardware acceleration of remote graphics and
videos. The h.265 video codec (HEVC) supports YUV 4:2:0 color space by default. H.265 video codec
must be supported and enabled on both the VDA and Citrix Workspace app. If your Mac device doesn’
t support H.265 decoding using the VideoToolbox interface, then the H.265 decoding for graphics pol-
icy setting is ignored and the session falls back to the H.264 video codec. For more information, see
Support for H.265 video decoding.

Support for system shortcuts on HDX desktop sessions Previously, the system keyboard short-
cuts such as Option-Command-ESC, Command-Space bar, Command-Tab, Control-Command-Q,
Shift-Command-Q, Control Up/Down/Left/Right took effect only on macOS locally since they were
consumed by macOS at first.

Starting with the 2402 version, Citrix Workspace app for Mac supports passing the macOS system key-
board shortcuts to the VDA (HDX session) in window mode and full-screen mode. This feature allows
you to set preferences on how the system shortcut must take effect on macOS locally or the HDX desk-
top session in window or full-screen mode.

The following options in the keyboard settings allow you to control the system shortcuts:

+ Local device: The system shortcuts can take effect only on macOS locally. It does not affect the
HDX session. The Local device option is the default option.
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+ Fullscreen HDX session only: The system shortcuts take effect on HDX sessions when the ses-
sionisin full-screen mode. If the session isin window mode or there are no active sessions, then
the system shortcuts have no effect on HDX sessions.

+ Active HDX session: The system shortcuts take effect on HDX sessions when the session is in
window mode and full-screen mode. If there is no active HDX session or the active session win-
dow on the front, then the system shortcuts can take effect only on the macQOS locally.

To enable the system shortcuts to take effect on the HDX session, open the HDX session. In the Citrix
Viewer menu bar, navigate to Devices > Keyboard > System shortcuts take effect on and select
Fullscreen HDX session only or Active HDX session.

Note:

When enabling system shortcuts for HDX sessions, you are prompted to provide accessibility ac-
cess to Citrix Viewer to use this feature. To provide accessibility access to Citrix Viewer, click
Open System Settings in the dialog box and enable accessibility access to Citrix Viewer. For

more information, see Allow accessibility apps to access your Mac in the Apple support article.

Send Ctri-Alt-Del
Webcam »  Send Windows Shortcut

Send Key
Send Function Key

System shortcuts take effecton > | + Local device _
@ © ® Rdst Fullscreen HDX session only = AWTSVDA-1M

Active HDX sess{3n

XE

Alternatively, you can enable the system shortcuts to take effect on HDX sessions in full-screen or win-
dow mode by navigating to Preferences > Keyboard. Select Fullscreen HDX session only or Active
HDX session options from the System shortcuts take effect on drop-down menu.
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For more information, see Support for system shortcuts on HDX desktop sessions.

Support for background blur for webcam Starting with the 2402 version, Citrix Workspace app
for Mac supports background blur when using a webcam. You can enable the background blurring
feature by navigating to Preferences > Mic & Webcam and select Turn on blur when using webcam.

For more information, see Support for background blur for webcam.

r
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Support for audio volume synchronization Previously, audio volume control is independent be-
tween the Virtual Delivery Agent (VDA) and your device. You’ve to adjust the volume on both sides
to maintain the desired volume. Also, if you’ve muted the volume in your device, then it restricts to
unmute the volume in the VDA.

Starting with the 2402 version, Citrix Workspace app for Mac supports synchronization of audio vol-
ume between the VDA and your audio devices. You can now tune the volume using the VDA audio
volume slider and have the same volume on your device and the other way around. By default, this
feature is enabled. For more information, see Support for audio volume synchronization.

Loss tolerant mode for audio Starting with the 2402 version, Citrix Workspace app supports loss
tolerant mode (EDT lossy) for audio redirection. This feature improves the user experience for real-
time streaming when users are connecting through networks with high latency and packet loss. By
default, this feature is enabled. For more information, see Loss tolerant mode for audio.

Upgraded HDX Reducer to Version 4 Previously, Citrix Workspace app for Mac supported HDX Re-
ducer V3. Starting with the 2402 version, Citrix Workspace app for Mac supports HDX Reducer V4. This
feature reduces the network bandwidth required for a typical session and improves response time.
For more information, see Upgraded HDX Reducer to Version 4.

Support for screen sharing when App Protection is enabled Starting with the 2402 version, you
can share content through Microsoft Teams with HDX optimization, even when App Protection is en-
abled. With this feature, you can share a screen in the virtual desktop session to its full potential. For
more information, see Compatibility with HDX optimization for Microsoft Teams.

Enhanced Global App Configuration service Starting with the 2402 version, the enhanced Global
App Configuration service (GACS) for Citrix Workspace now supports the following features:

+ Settings are secured with user authentication
« Enhanced the discovery workflow

« Support for full StoreFront URL

For more information, see Global App Configuration service.

Support for administrator to restrict the user from changing the store name Previously, users
were able to change the store name by using the Edit Account option.

Starting with the 2402 version, Citrix Workspace app for Mac provides administrators an option to
restrict the user from changing the store name. With this feature, administrators can easily identify
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and maintain consistency in the store names. For more information, see Support for administrator to
restrict the user from changing the store name.

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 121.1.1.26, based
on Chromium version 121. For more information, see the Citrix Enterprise Browser documentation.

Security indicator when visiting websites Citrix Enterprise Browser now displays a security indi-
cator on the address bar when users visit any websites. The indicator aims to inform users about the
security aspects of the websites, such as whether it is an internal site or if there are any potential se-
curity restrictions. The indicator provides more information when you click it. The indicator appears

on the Enterprise browser by default, and it enhances the user experience.
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Simplified single sign-on for Web and Saa$S apps through the Global App Configuration service

NOTE:

For the Mac operating system, this feature was previously available only for StoreFront starting
with the release 119.1.1.115. Now, with the release of 121.1.1.26, it is also available for Work-

space.

Previously, single sign-on (SSO) was configured in Citrix Enterprise Browser using the PowerShell mod-
ule. From this version, you can configure the simplified SSO feature in Citrix Enterprise Browser by us-
ing a newly introduced setting in the Global App Configuration service (GACS). Administrators can use
this new setting to enable SSO for all web and SaaS apps in Citrix Enterprise Browser. This method
eliminates the need for the complex PowerShell module.

For more information on how to manage SSO through GACS, see Manage single sign-on for Web and
Saa$S apps through the Global App Configuration service.

Citrix Enterprise Browser introduces additional settings in the Global App Configuration service
The following additional settings have been added into the Global App Configuration service (GACS)
for configuring Citrix Enterprise Browser:

+ “Enable autofill address”- Allows administrators to enable or disable the autofill suggestions for
addresses.

« “Enable autofill credit card”- Allows administrators to enable or disable the autofill suggestions
for credit card information.

+ “Auto launch protocols from origins”- Allows administrators to specify a list of protocols that
can launch an external app from the listed origins without prompting the user.

+ “Enable command-line flag security warnings”- Allows administrators to display or hide secu-
rity warnings, which appear when potentially dangerous command-line flags try to launch the

Enterprise Browser.
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« “Manage default cookies setting”- Allows administrators to manage cookies for a website.

« “Manage default pop-ups setting”- Allows administrators to manage pop-ups from a website.

« “Extension install sources”- Allows administrators to specify valid sources for users to install
extensions, apps, and themes.

+ “Disable lookalike warning pages”- Allows administrators to specify the preferred domains
where lookalike warning pages don’t display when the user visits pages on that domain.

» “Enable payment method query”- Allows administrators to enable websites to check whether
the users have saved payment methods.

« “Manage saving browser history”- Allows administrators to manage the saving of Enterprise
browser history.

+ “Manage search suggestion”- Allows administrators to enable or disable search suggestions in
the Enterprise browser’s address bar.

« “Enable export bookmark”- Allows administrators to enable an option to export the bookmarks
in the Enterprise Browser.

» “Force ephemeral profiles”- Allows administrators to clear or persist user profile data when
users close the Enterprise Browser.

For more information, see Manage Citrix Enterprise Browser through Global App Configuration ser-
vice.

Technical Preview

+ Support for single sign-on to Citrix Secure Access automatically through Citrix Workspace app
+ Client App Management for Zoom VDI plug-in

« Enhanced the Desktop Viewer toolbar

« Customize the Desktop Viewer toolbar

« Enable Packet Loss Concealment to improve audio performance

+ Support for extending the desktop session to external monitors automatically

« Sustainability initiative from Citrix Workspace app

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

+ When connecting to Citrix Workspace app for Mac version 2311, you might get the following
error message:

Http/1.1 Internal Server Error 43524
[CVADHELP-24631]

+ You might notice that the Global App Configuration service policies are not applied on some
older Mac devices. [CVADHELP-24863]
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2311
What’s new

Support for authentication using FIDO2 when connecting to on-premises store Previously,
FIDO2 based password-less authentication was supported for connecting to cloud stores. For more
information, see FIDO2 based authentication when connecting to cloud store.

With this version, users can also connect to on-premises stores using FIDO2 authentication. FIDO2 se-
curity keys provide a seamless way for enterprise employees to authenticate to apps or desktops that
support FIDO2 without entering a user name or password. This feature currently supports roaming au-
thenticators (USB only) with PIN code and touchlD. This feature is supported on macOS 12 and later
versions. For more information, see FIDO2-based authentication when connecting to on-premises
store.

Enhanced Universal Architecture builds for virtual apps and desktops session Starting with the
2311 version, the Universal Architecture build can now automatically choose to run the virtual ses-
sions in the native Apple Silicon mode or Intel mode on Macs with the Apple Silicon chipset. It uses
the Rosetta emulation to launch the virtual session in Intel mode. The virtual session launches in the
native Apple Silicon mode, if the virtual channel SDK is built based on the native Apple Silicon archi-
tecture or there’s no virtual channel SDK. However, the virtual session launches in the Intel mode
using the Rosetta emulation, if the virtual channel SDK is built based on the x86_64 Intel-based archi-
tecture.

This enhancement to the Universal Architecture build improves the launch experience on Macs with
the Apple Silicon chipset. For users on Macs with the Intel-based chipset, there is no change, and the
Universal Architecture build continues to run the virtual sessions natively.

For more information, see Enhanced Universal Architecture builds for virtual apps and desktops ses-
sion.

Enhanced virtual apps and desktops launch experience for Workspace (Cloud users only) The
opening experience of Citrix resources has been enhanced to be more intuitive, informative, and user-
friendly. From the 2311 version, this feature is supported for custom web stores and hybrid launch.
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The launch progress notification now appears at the lower-right corner of your screen. A progress
status of the resources, which are in the process of being opened is shown. You cannot retrieve the
notification once you dismiss it. The notification stays for a few seconds from the time you start the
session. If the session fails to start, then the notification shows the failure message. For more informa-
tion, see Enhanced virtual apps and desktops launch experience for Workspace (Cloud users only).

@ WSVDA
Close

0 Failed to start

Your session "WSVDA" did not launch successfully due to
error code "2519". Please contact your administrator for
more information about the error.

4ABESB08-9D94-4A40-8DB3-1A828EBOCA3A

If the problem persists, contact your admin with this
transaction ID.

Note:

This feature is available for both Workspace (cloud) and StoreFront sessions.
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Modernized Citrix Virtual Channel SDK for Citrix Workspace app for Mac Starting with the 2311
version, the Citrix Virtual Channel Software Development Kit (VCSDK) supports writing server-side
applications and client-side drivers for more virtual channels using the ICA protocol. The server-side
virtual channel applications are on Citrix Virtual Apps and Desktops servers. This version of the SDK
supports writing new virtual channels and screen sharing for Citrix Workspace app for Mac.

For more information, see Citrix Virtual Channel SDK for Citrix Workspace app for Mac in the Developer
documentation and Modernized Citrix Virtual Channel SDK for Citrix Workspace app for Mac.

Support for TLS protocol version 1.3  Starting with the 2311 version, Citrix Workspace app for Mac
supports the latest Transport Layer Security (TLS) version 1.3. To enable the TLS version 1.3, navigate
to Preferences > Security and Privacy > TLS and select the TLSv1.0, TLSv1.1, TLSv1.2 and TLSv1.3
option from the TLS versions drop-down menu.

r

@ Security & Privacy = 1 -4 >
General Accounts File Access Devices
TLS Smart Card  Privacy

These settings allow you to control how TLS is configured for secure HDX
connections.

Compliance mode: None
Crypto module; Standard [

TLS versions! TLSv1.0, TLSv1.1 and TLSv1.2
TLSv1.1 and TLSv1.2
TLSv1.2

TLSv1.0, TLSv1.1, TLSv1.2 and TLSv1.3

Certificate revocation list;

Restore Defaults

[ .

For more information, see TLS.

Support for multiple audio devices Starting with the 2311 release, Citrix Workspace app for Mac
displays all available local audio devices in a session with their names. In addition, plug-and-play is
also supported. For more information, see Support for multiple audio devices.
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Support for extending multiple monitors in full-screen mode on up to five monitors Previously,
Citrix supported a maximum of three monitors in full-screen mode, including the primary monitor.

Starting with the 2311 version, you can now use full-screen mode on up to five monitors, including
the primary monitor, at the same time. For more information, see Support for extending multiple
monitors in full-screen mode on up to five monitors.

Deprecation of International menu from the keyboard settings Previously, you can enable or
disable the Use Client IME, Use Composing Mark and Use Client keyboard layout features in the
Citrix viewer by navigating to Devices > Keyboard>International.

From the 2311 version, the International menu for the keyboard settings in the Citrix Viewer is dep-
recated. From this version, the client-side IME is enabled by default. For more information, see Dep-
recation of International menu from the Keyboard settings.

Deprecation announcement of the SDP format (Plan B) from WebRTC Citrix is planning to depre-
cate the current SDP format (Plan B) support from WebRTC in future releases. You must use a version
of Citrix Workspace app that supports the Unified Plan to continue using certain optimized Microsoft
Teams functionalities. For more information, see Deprecation announcement of the SDP format (Plan
B) from WebRTC.

Citrix Enterprise Browser This release includes Citrix Enterprise Browser version 119.1.1.115,
based on Chromium version 119. For more information, see the Citrix Enterprise Browser documen-
tation.

Improved user experience Previously, Citrix Enterprise Browser displayed a reconnection modal
when you attempted to perform an action after your session expired. Starting with Citrix Workspace
app for Mac version 2311 (which corresponds to the Chromium version 119.1.1.115), there is no longer
a reconnection modal. Instead, a loading icon now appears on the browser tab when you attempt to
perform any action after your session expires.

Improved watermark design Citrix Enterprise Browser now has a new watermark design that is
less intrusive and provides a better user experience.

Support for custom browser extension Citrix Enterprise Browser has expanded its extension ca-
pabilities. Previously, only extensions from the Chrome Web Store were permitted. Citrix Enterprise
Browser now allows you to add custom extensions securely. Administrators can configure custom
extensions as part of the mandatory list. End users can access and use these extensions either via
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citrixbrowser: or by clicking the Extensions option under More button as
needed. For more information on how to configure the custom extensions, see Mandatory custom
browser extension in the Citrix Enterprise Browser documentation.

Simplified SSO for Web and SaaS apps through the Global App Configuration service
Note:

This feature is available only for StoreFront.

Previously, SSO was configured in Citrix Enterprise Browser using the PowerShell module. From this
version, this simplified SSO feature allows you to configure SSO in Citrix Enterprise Browser by using
a newly introduced setting in the Global App Configuration service (GACS). Administrators can use
this new setting to enable SSO for all web and SaaS apps in Citrix Enterprise Browser. This method
eliminates the need for the complex PowerShell module. For more information on how to manage
SSO through GACS, see the Manage single sign-on for Web and SaaS apps through the Global App
Configuration service.

Enhanced capabilities on monitoring end user activities Previously, administrators were unable
to monitor end user activities such as App accessed and Traffic type. Starting with Citrix Workspace
app for Windows 2311 and Mac 2311 versions (corresponding to Chromium version 119.1.1.115), you
can now monitor these details as well.

« App accessed: Enterprise Browser provides information about all the apps accessed by the end
user, provided the app is listed in the policy document.

« Traffic type: Enterprise Browser provides information about whether data is sent directly or
through Secure Private Access authentication.

To monitor the end user activities from the Enterprise Browser, use the Citrix Analytics service using
your Citrix Cloud account. After signing in to Citrix Cloud, navigate to Analytics > Security > Search.
There, you can refer to Apps and Desktops under the Self-Service Search section. For more informa-
tion on Citrix Analytics, see Getting started.

App Protection

Support to configure App Protection for Authentication and Self-Service plug-in for on-
premises stores Previously, Citrix Workspace app for Mac supported configuring App Protection
for Authentication and Self-Service plug-in using the Global App Configuration service Ul for
customers on cloud stores only.
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Starting with the 2311 release, this feature is supported for customers on both cloud and on-premises
stores. For more information, see Configuration using the Global App Configuration service Ul in the
App Protection documentation.

Technical Preview

+ Loss Tolerant mode for Audio

 Support for Audio volume synchronization
+ Support for H.265 video decoding

« Upgraded HDX Reducer to Version 4

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues in 2311

+ When the first time users add the Store URL, they might not see the FIDO2 authentication
browser window. [RFMAC-14518]

« When using Citrix Workspace app for Mac to access virtual sessions, the mouse scrolling speed
might be too fast or too slow in the virtual sessions. [CVADHELP-23514]

+ When using Citrix Workspace app for Mac, you might not be able to switch between recent apps
inside the virtual app session by clicking Options + tab keys after upgrading to VDA 2212
or later. [CVADHELP-23464]

+ You might notice that the macOS dock is blocking the windows taskbar of the Remote Desktop
Protocol app session launched from Citrix Workspace app for Mac. [CVADHELP-23681]

+ When using Citrix Workspace app for Mac, you might experience issue with authentication when
persistent session is used for on-premises store. [CVADHELP-24062]

2309
What’s new

Support for macOS 14 Sonoma Citrix Workspace app for Mac is supported on macOS 14
Sonoma.

Citrix Enterprise Browser This release includes Citrix Enterprise Browser version 115.1.1.103,
based on Chromium version 115. For more information, see Citrix Enterprise Browser documenta-
tion.
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Citrix will now release independent upgrades for Citrix Enterprise Browser. Starting with Citrix Work-
space app 2309 for Mac, you can upgrade Citrix Enterprise Browser independently to compatible ver-
sions through the auto-update feature or install manually when the upgrades are available at Down-
loads. Theindependent upgrades of Citrix Enterprise Browser are supported only on the latest version
of Citrix Workspace app for Mac at any given time.

Technical Preview
+ Support for Citrix Secure Private Access for On-premises stores

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

« In optimized Microsoft Teams, you might hear the ringtone sound randomly if you answer the
call before it rings. [HDX-55799]

« The USB settings to connect devices automatically, which is available on the Devices tab of
the Preferences window, might not work as expected in Citrix Workspace app 2308 for Mac.
[RFMAC-14658]

« On macOS Sonoma devices, when you copy an image (.jpeg/.png format) from your Mac to the
virtual session, the copied image in the virtual session might get corrupted. [HDX-55307]

Known issues

« No new issues have been observed in this release.

2308
What’s new

Citrix Workspace app for Mac on macOS Sonoma Beta Citrix Workspace app 2308 for Mac has
been tested on macOS Sonoma Public Beta 7 Version 23A5337a. Use this setup in a test environment
and provide your feedback.

Improved graphics performance Starting with the 2308 version, the performance of graphics is
improved for seamless app sessions. This feature also optimizes the load on CPU usage. For more
information, see Improved graphics performance.
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Improved network congestion control Starting with the 2308 version, the Citrix-proprietary trans-
port protocol called Enlightened Data Transport (EDT) is improved to efficiently control network con-
gestion. This feature improves data throughput and reduces latency. For more information, see Im-
proved network congestion control.

Increase in the number of supported virtual channels Previously, Citrix Workspace app for Mac
supported up to 32 virtual channels. Starting with the 2308 version, you can use up to 64 virtual chan-
nels in a session. For more information, see Increase in the number of supported virtual channels.

App Protection

Support for Policy tampering detection Policy tampering detection feature prevents the user
from accessing the virtual app or desktop session if the App Protection anti-screen capture and
anti-keylogging policies are tampered. If policy tampering is detected, then the virtual app or
desktop session is terminated. For more information about the policy tampering detection feature,
see Policy tampering detection.

Citrix Enterprise Browser This release includes Citrix Enterprise Browser version 115.1.1.103,
based on Chromium version 115. For more information, see Citrix Enterprise Browser documenta-

tion.

Technical Preview

Enhanced the high DPI option

« Store-based configuration of file access

+ Support for Activity Manager on cloud stores

+ Support for screen sharing when App Protection is enabled

+ Support for authentication using FIDO2 when connecting to on-premises store

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

+ When using Citrix Workspace app for Mac to access the virtual desktop, the size of the mouse
pointer in the virtual desktop might fluctuate irregularly. [CVADHELP-23158]

« You might not see the icons of active apps in the activity manager. [WSUI-8011]

« Citrix Workspace app might consume a lot of application memories after a few minutes of usage.
[CVADHELP-23528]
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2307
What’s new

Native support for Macs with M2 chips Starting with the 2307 version, Citrix Workspace app for
macOS supports M2 series (along with M1 series that was previously supported) of Apple silicon na-
tively. For more information, see Native support Apple silicon.

Citrix Workspace app for Mac on macOS Sonoma Beta Citrix Workspace app 2307 for Mac has
been tested on macOS Sonoma Public Beta 1 Version 23A5286i. Use this setup in a test environment
and provide your feedback.

Caution:

Do not use Citrix Workspace app for Mac on macOS Sonoma Beta versions in production environ-
ments.

Deprecating support for macOS version Catalina As announced in the 2304 version, support for
macOS version Catalina (10.15) is deprecated in the 2307 release and will be removed for future re-
leases. For more information, see Deprecation.

Support for authentication using FIDO2 when connecting to a cloud store  Starting with the 2307
version, users can authenticate using FIDO2 based password-less authentication when connecting to
a cloud store. FIDO2 security keys provide a seamless way for enterprise employees to authenticate to
apps or desktops that support FIDO2 without entering a user name or password. This feature currently
supports roaming authenticators (USB only) with PIN code and touchlID. This feature is supported on
macOS 12 and later versions. For more information, see FIDO2-based authentication when connect-
ing to cloud store.

Support for authentication using FIDO2 within an HDX session Starting with the 2307 version,
users can authenticate using FIDO2 based password-less authentication within an HDX session. FIDO2
security keys provide a seamless way for enterprise employees to authenticate to apps or websites
that support FIDO2 without entering a user name or password. This feature currently supports roam-
ing authenticators (USB only) with PIN code. This feature is supported on macOS 12 and later versions.
For more information, see FIDO2-based authentication within an HDX session.

Note:

This release supports only one passkey in a FIDO2 supported device. If your FIDO2 supported
device has multiple passkeys then the first passkey is used to authenticate the HDX session.
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Auto-update version control Administrators can now manage the auto-updated version of Citrix
Workspace app for the devices in the organization.

Administrators can control the version by setting the range for maximumAllowedVersion and
minimumAllowedVersion properties in the Global App Configuration service.

Example JSON file in Global App Configuration service:
{

"serviceURL": {

"url": "https://serviceURL:443"
}

)

"settings": {

"name": "Version Control for Citrix Workspace",

"description": "Provides admin ability to Version Control for
Citrix Workspace",

"useForAppConfig": true,

"appSettings": {

"macos": [

{

"category": "AutoUpdate",

"userOverride": false,

"assignedTo": [
"AllUsersNoAuthentication"

1,
"settings": [
{
"name": "Auto update plugins settings",
"value": [
{
"pluginName": "Citrix Workspace",
"pluginId": "D99C3E77-FBF5-4B97-8EDA-4E381A1E0826",
"pluginSettings": {
"deploymentMode": "Update",
"upgradeTolLatest": false,
"minimumAllowedVersion": "23.07.0.63",
"maximumAllowedVersion": "23.07.0.63",
"delayGroup": "Medium",
"detectRule": ""
+
+
]
}
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}

When the range is set, Citrix Workspace app on the user device is automatically updated to the highest
available version that falls between the mentioned range.

If you want to auto-update Citrix Workspace app to a specific version, enter the same version in the
maximumAllowedVersion and minimumAllowedVersion properties in the Global App Configuration
service. For more information, see Auto-update version control.

Note:

+ To achieve auto-update version control, set the upgradeTolLatest setting to false in the
Global App Configuration service. If the upgradeTolLatest setting is true, maximumAllowed-
Version and minimumAllowedVersion is ignored.

« Do not modify the pluginld. The pluginld is mapped to Citrix Workspace app.

« If the administrator hasn’t configured the version in the Global App Configuration service,
Citrix Workspace app is updated to the latest available version by default.

+ You can only use the version ranges that are set to update Citrix Workspace app. However,
a downgrade isn’t supported.

« This feature is supported from release 2307 onwards.

Quick access menu for StoreFront  Starting with the 2307 version, you can navigate to your favorite
apps and desktops quickly and easily using the quick access feature for on-premises stores. To enable
quick access, right-click Citrix Workspace in the toolbar, navigate to Preferences > General, and then
select Show Quick Access for Storefront experience. This feature allows you to see your favorite
data directly from the Mac menu bar.
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You can enable the quick access feature by using Preferences.

General . EJ

Accounts File Access Devices
App access across devices: Reconnect apps when | sign in to Workspace
Reconnect apps when | start or refresh apps

: & Show Workspace in menu bar
¥ Show Quick Access for Storefront experience

Auto Start: & Start Workspace on system startup

High DPI: Enable and match client DPI scale settings

Passwords: Delete Passwords...

File download location: | Ask for each download ¢

Administrators can enable or disable the quick access feature by using the Mobile Device Management
(MDM) or Global App Configuration service (GACS) methods. For more information, see the Quick ac-
cess menu for StoreFront.

Enabling or disabling quick access using MDM To enable quick access through MDM, administra-
tors must use the following settings:

<key>ShowQuickAccessForStoreFront</key>
<false/>

Enabling or disabling quick access using GACS To enable quick access through GACS, administra-
tors must use the following settings:

enableQuickAccessForStoreFront

Store-based configuration of microphone and webcamaccess Starting with the 2307 version, the
per-store microphone and webcam access are included as part of the client-selective trust feature.
This enhancement allows you to provide access to a microphone and webcam on a per-store basis.

To enable microphone and webcam access for a store, you must select Preferences > Mic & Webcam.
In the Mic & Webcam tab, select the store and the type of access required for that store. For more
information, see Store-based configuration of microphone and webcam access.

Send feedback on Citrix Workspace app The Send feedback option allows you to inform Citrix
about any issues you might encounter while using the Citrix Workspace app. You can also send sug-
gestions to help us improve your Citrix Workspace app experience.
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You must select Help > Send feedback to view and fill the issue details in the Send feedback form.
You can add details like the examples provided in the form.

& Send feedback

Provide a descriptive title*

Tell us more*

Logs

Basic logs are attached. We recommend you click 'Record my issue’ to
capture detailed logs.

For more information, see Log collection

( Record my issue ) WorkspaceLogs_2023_07_18-14_23_43.zip Tl

Attachments
Screenshots or screen recordings of the problem.

Choose files

Your feedback will be used to improve Citrix Workspace app. If you don't
use the Mail app on your Mac, please send feedback to cwa-mac-
feedback@cloud.com with files added manually.

You can attach the existing log files or generate new log files. To generate log files, click Record my is-
sue > Start Recording and then reproduce the issue. After theissue is reproduced, click Stop Record-
ing. The log file is saved automatically and replaces the existing logs with the reproduced logs.

Note:

Citrix does not collect any Personally Identifiable Information (PIl) from the logs.

You can attach screenshots or screen recordings describing the issue to help us understand what you’
re experiencing. Click Choose files and add the attachments such as screenshots or screen recordings.
You can attach a maximum of four files.
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Onceyou’ve entered the necessary information, click Send to have a new email automatically created
in your Mail app with the information you added. From there, click the Send button to share the
feedback with Citrix. For more information, see Send feedback on Citrix Workspace app.

Note

If you aren’t using the default Mail app, then send feedback to cwa-mac-feedback@cloud.com

from your mail client. Add the issue details, log files, screenshots, or screen recordings to the
email manually.

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 113.1.1.34, based
on Chromium version 113. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Split view support Citrix Enterprise Browser on macOS supports split view for ease of multitasking.
With split view, you can use Citrix Enterprise Browser and another window next to each other, without
having to manually move and resize windows. For more information, see Apple’s support article.

& rewo < e

aaaaaaaaa @ Workspace

cifrix

cilrix
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Citrix Enterprise Browser shortcut Starting with Citrix Workspace app for Mac 2307 version, an
administrator can configure and control the presence of the Citrix Enterprise Browser shortcut on the
launch pad.
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Note:

By default, this feature isn’t configured.

Configuration

An IT administrator can configure the presence of the Citrix Enterprise Browser shortcut in one of the
following ways:

+ Mobile Device Management (MDM)
+ Global App Configuration service (GACS)
+ web.config file.

Note:

« All the configuration methods have equal priority. Enabling any one of them enables the
shortcut.

+ Ifyou haven’t configured the shortcut but have one or more Workspace stores, the shortcut
gets automatically enabled.

« For end users, the Citrix Enterprise Browser shortcut appears if the user makes it as a fa-
vorite app irrespective of the configuration.

+ Todisable this feature for Workspace stores, administrators must apply one of the following
settings:

- Set the CEBShortcutEnabled attribute to false in the MDM or web.config file.
- Disable the Enable Citrix Enterprise Browser shortcut property in GACS.

Mobile Device Management (MDM)
Administrators can push the settings CEBShortcutEnabled set as true to the user’s device.
For more information on how to use MDM, see Mobile Device Management (MDM).

Note:

This way of configuration is applicable on Workspace and StoreFront.

Global App Configuration service (GACS)

Navigate to Workspace Configuration > App Configuration > Citrix Enterprise Browser and enable
Enable Citrix Enterprise Browser shortcut property.
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List Of Allowed Extensions

0 Configured, 0 Unsaved Vv
You can add a list of extensions that the end users can install within the Citrix Enterprise
Browser. The end user can't install other extensions apart from the allowed list. Learn More.

‘Add Managed Bookmarks

0 Configured, 0 Unsaved VvV
You can add a list of bookmarks to the Citrix Enterprise Browser. The end user can't modify
these bookmarks.

Delete Browsing Data On Exit

0 Configured, 0 Unsaved vV
YYou can configure what type of data the Citrix Enterprise Browser can delete when the end user
exits the browser. Note: Deleting the browsing data can affect usability. Learn More

Enable Citrix Enterprise Browser Shortcut

N
Creates a Citrix Enterprise Browser shortcut on the Start menu in Windows and Launchpad in 0 Configured, 2 Unsaved

macOS. If a user marks Enterprise Browser as favorite, a shortcut is created irrespective of the
configuration.

Mac Enabled Unsaved

Windows pisabled (I3 Unsaved

You have saved drafts that are not yet published in Production. You may continue editing or publish now Review 2 unsaved setting(s) Discard Publish Drafts
to apply changes to Workspace for your end users

For more information about how to use the GACS Ul, see the User interface article in the Citrix Enter-
prise Browser documentation.

Note:

This way of configuration is applicable on Workspace and StoreFront.

web.config file

Enable the attribute CEBShortcutEnabled under the properties.

<properties>
<property name="CEBShortcutEnabled" value="
True" />

</properties>

Note:

This way of configuration is applicable on StoreFront.

Using web.config

To enable the Citrix Enterprise Browser shortcut, do the following:

1. Use a text editor to open the web.config file, which is typically at C: \inetpub\wwwroot\
Citrix\Roaming directory.

2. Locate the user account element in the file (Store is the account name of your deployment).

Forexample: <account id=... name="Store">
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3. Beforethe </account>tag, navigate to the properties of that user account and add the following:

<properties>
<property name="CEBShortcutEnabled" value=
"True" />
</properties>

The following is an example of the web.config file:

<account>
<clear />
<account id="d1197d2c-ac82-4f13-9346-2ee14d4b0202" name="F84Store"
description="" published="true" updaterType="Citrix"
remoteAccessType="None'">
<annotatedServices>
<clear />
<annotatedServiceRecord serviceRef="1__Citrix_F84Store">
<metadata>
<plugins>
<clear />
</plugins>
<trustSettings>
<clear />
</trustSettings>
<properties>
<property name="CEBShortcutEnabled" value="True" />
</properties>
</metadata>
</annotatedServiceRecord>
</annotatedServices>
<metadata>
<plugins>
<clear />
</plugins>
<trustSettings>
<clear />
</trustSettings>
<properties>
<clear />
</properties>
</metadata>
</account>

How to configure using web.config

1. Useatexteditortoopentheweb.configfile, whichistypically at C:\inetpub\wwwroot\Citrix\Roaming
directory.

2. Locate the user account element in the file (Store is the account name of your deployment).
For example: <account id=... name="Store">

3. Beforethe </account>tag, navigate to the properties of that user account and add the following:
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<properties>
<property name="CEBShortcutEnabled" value=
"True" />
</properties>

Technical Preview

» Keyboard accessibility support for the toolbar on the Virtual Desktop

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

« While launching the published app through the browser, the app does not launch directly but
downloads an ICAfile. The user might have to open the downloaded ICA file manually to launch
the app. [CVADHELP-20835]

+ Attemptsto start a session mightfailif the StoreFront keyword is set to “KEYWORDS:LogoffOnClose=true
PromptMessage="Do you want to Log off?”””. [CVADHELP-23170]

+ You might not be able to select the required gateway from the list of options provided when
using Citrix Workspace app for Mac. [CVADHELP-22777]

Known issues

No new issues have been observed in this release.

2306
What’s new

Log traceability and user activity Starting with the 2306 version, when a user reports an issue,
the administrators can go through the log files to view the basic information such as macOS version,
Citrix Workspace app version, details about the previous upgrade, number of stores added, and other
details. Administrators can now view the following activities in Citrix Workspace app for Mac:

« The app launched along with the macOS version, number of stores, and other metadata.

» The store addition and deletion operation and the metadata that is required to add an account.
+ The session start time and launch status.

+ Auto update activation and status.

« System events such as moving the app to the background, sleep mode, or quitting.
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Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 112.1.1.23, based
on Chromium version 112. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Fixed issues

« After upgrading Citrix Workspace app for Mac to version 2305, certain third-party virtual apps
that have pop-up dialogs for entering username and password might become unresponsive
upon opening. [CVADHELP-23032]

Known issues

No new issues have been observed in this release.

2305
What’s new

Support for horizontal scroll Previously, Citrix Workspace app for Mac supported only vertical
scroll on a trackpad. Starting with the 2305 version, a horizontal scroll is also supported. For more
information, see Support for horizontal scroll.

Improved audio echo cancellation support Citrix Workspace app now supports echo cancellation
in adaptive audio and legacy audio codecs. This feature is designed for real-time audio use cases, and
itimproves the user experience. Citrix recommends using adaptive audio. For more information, see
Improved audio echo cancellation support.

Improved graphics performance [Technical Preview] Starting with the 2305 version, the perfor-
mance of graphics is improved for seamless sessions. This feature also reduces the load on CPU us-
age.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.
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Support for Certificate-based authentication Starting with the 2305 version, Workspace adminis-
trators can configure and enforce Azure Active Directory conditional access policies for users authen-
ticating to Citrix Workspace app.

The following methods can be used to enable the authentication using conditional access:

+ Mobile Device Management (MDM)
+ Global App Configuration service (GACS)

The flag values read by Citrix Workspace app take precedence in the following order:

+ Mobile Device Management (MDM)
+ Global App Configuration service (GACS)

For more information, see Support for Certificate-based authentication.

Channel support for Global App Configuration service The Global App Configuration service for
Citrix Workspace allows a Citrix administrator to deliver Workspace service URLs and Workspace App
settings through a centrally managed service. Global App Configuration service now allows adminis-
trators to test the settings before rolling it out to all users. This feature allows to resolve any issues
before applying the global app configurations to the entire user base. For more information, see Chan-
nel support for Global App Configuration service.

Improved auto-update experience The auto-update feature automatically updates the Citrix
Workspace app to the latest version without the need for any user intervention.

Citrix Workspace app periodically checks and downloads the latest available version of the app. Cit-
rix Workspace app determines the best time to install based on user activity not to cause any disrup-
tions.

For more information, see Improved auto-update experience.

Opened apps appear in the dock with native app icons Previously, clicking virtual apps in the
Citrix Workspace app triggered the Citrix Viewer where these apps would be available. If you open
many apps, the apps or its instances are opened in the Citrix Viewer. You can view the open apps by
right-clicking the Citrix Viewer icon.
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Presentationl - PowerPoint
Presentation2 - PowerPoint

Sign in to your account - Google Chrome
Documant] - Ward

Dptlans

Show All Windows

Starting with the 2305 version, when you open virtual apps, they appear in the Dock (bottom-right
corner of the screen) with their respective icons and are easily identifiable. You can then access the
virtual app from the dock itself. If you open multiple instances of an app, these instances aren’t du-
plicates in the Dock but are grouped within one instance in the Dock.

For more information, see the Opened apps appear in the dock with native app icons page.

Improved Mission Control and App Expose experience Previously, using the Mission Control or
App Expose feature in a virtual app session resulted in the overlapping of many windows that were
opened.
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Google = 4 Google

[Tl

Starting with the 2305 version, when you use the Mission Control or App Expose feature in a virtual
app session and open many windows, the windows do not overlap, and you can easily choose from
among them.
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For more information, see Improved Mission Control and App Expose experience.

Enhancement to sleep mode for optimized Microsoft Teams call Previously, when using the op-
timized Microsoft Teams meeting, if there’s no mouse or keyboard interaction, Citrix Workspace app
or the optimized Microsoft Teams screen might go to sleep mode.

Starting with the 2305 version, Citrix Workspace app or the optimized Microsoft Teams screen doesn’
t go to sleep mode even if there’s no mouse or keyboard interaction during an optimized Microsoft
Teams meeting.

For more information, see Enhancement to sleep mode for optimized Microsoft Teams call.

Support for continuity camera With the Continuity Camera, you can now use the iPhone as your
webcam. For a seamless connection, mount your iPhone such that its camera is available to the Mac
device. You must select Webcam > Automatic Camera Selection for the iPhone to appear automat-
ically on the Mac device as an external camera. You can switch to any other camera manually, for
example by selecting Webcam > FaceTime HD Camera. The Continuity Camera works wired or wire-
lessly and provides a high-quality image. For more information, see Support for continuity camera.
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Increase in the number of supported virtual channels [Technical Preview] In earlier versions of
the client, sessions supported up to 32 virtual channels. Starting with the 2305 version, you can use
up to 64 virtual channels in a session.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Store-based configuration of microphone and webcam access levels [Technical Preview] Start-
ing with the 2305 version, the per-store microphone and webcam access are included as a part of the
client-selective trust feature. This enhancement allows you to change the settings based on a per-
store basis. You can click a store to enable the required microphone or camera access. The selected
setting for microphone or camera access is applied on a per-store basis.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Support for authentication using FIDO2 when connecting to cloud stores [Technical Preview]
Starting with the 2305 version, users can authenticate using passwordless FIDO2 security keys when
connecting to Citrix Workspace app for Mac. Users can sign into the cloud stores using the FIDO2
security keys. The security keys support different types of security inputs such as security pins, bio-
metrics, card swipe, smart card, Public Key Certificates. This feature is supported on macOS 12 and
later versions. For more information about FIDO2 see FIDO2 Authentication.

Citrix Workspace app uses the user’s default browser for FIDO2 authentication (Webauthn). Admin-
istrators can configure the type of browser to authenticate to Citrix Workspace app. The configured
setting can be pushed using the Mobile Device Management (MDM), Global App Configuration service
(GACS), or the command line interface methods. The FIDO2 feature is not supported for on-premises
stores. For more information on the web browser settings, see Global App Configuration service doc-
umentation.

The following settings allow you to select the type of browser used for authenticating an end userinto
Citrix Workspace app:
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Embedded: Allows you to authenticate within Citrix Workspace app. Citrix Workspace app saves the
session data or cookies for single sign-on (for example, SaaS apps) when the enhanced single sign-on
feature is enabled. This authentication method does not support passwordless authentications such
as FIDO2.

EmbeddedWithPrivateSession: This setting is similar to the Embedded setting. Single sign-on isn’
t supported as session data or cookies aren’t present in Citrix Workspace app.

System: Allows you to use the user’s default browser for authentication (for example, Safari
or Chrome). Authentication occurs outside Citrix Workspace app. Use this setting to support
passwordless authentication. This setting tries to use the existing user session from the user’s
browser.

SystemWithPrivateSession: This setting is like the System setting. Citrix Workspace app uses a pri-
vate session in the browser for authentication. The browser doesn’t save authentication cookies or
data. Single sign-on isn’t supported in this option.

Enabling authentication using MDM To enable authentication through MDM, administrators must
use the following settings:

<key>WebBrowserForAuthentication</key>
<string>System</string>

Enabling authentication using GACS To enable authentication through GACS, administrators must
use the following settings:

{

"serviceURL": {

"url": "https://serviceURL:443"
}

"settings": {

"name": "Productivity Apps",

"description": "Provides access to MS Office and other basic apps
n

J
"useForAppConfig": true,
"appSettings": {

"macos": [

{

"assignedTo": [
"AllUsersNoAuthentication"
1,
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"category'": "authentication",
"settings": [
{
"name": "web browser for authentication",
"value'": "SystemWithPrivateSession"
}
1,
"userOverride": false
}
]
}

Enabling authentication using the command-line interface To enable authentication using the
command-line interface, administrators must run the following command:

defaults write com.citrix.receiver.nomas WebBrowserForAuthentication
System

This feature is a request-only preview. To get it enabled in your environment, fill out the Podio form.
Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in

production environments.

Keyboard input mode enhancements Citrix Workspace app for Mac provides Ul to configure the
keyboard input mode.

To configure keyboard input mode by using the GUI, do the following:

1. From the Citrix Workspace app icon in the menu bar, click the account icon in the top-right cor-
ner and navigate to Preferences > Keyboard.

The Keyboard input mode settings appear

2. Select from one of the following options:

+ Scancode -Sends the key position from the client-side keyboard to VDA and VDA generates
the corresponding character. Applies server-side keyboard layout.
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+ Unicode - Sends the key from the client-side keyboard to VDA and VDA generates the same
character in VDA. Applies client-side keyboard layout.

This enhancement is enabled by default.

[ ] Keyboard = - 2 P

General Accounts File Access Devices

Choose keyboard shortcuts to send commands to your applications.
Send Control character using: 3 Commanad (left) or ~ Control B
Send Alt character using:  3£°C Command (left)-Option <
Keyboard layout synchronization settings:  Sync only once - when session starts B

Keyboard input mode settings:  Unicode B
Mote: Scancode is the recommended option for the "Don't sync® setting.
Send Windows logo key using 3 Command (right)
Send special keys unchanged (press ¥ Command (left) for some keys)
Show the remote language bar for the published applications

Changes will take effect once you reconnect to this application.

Learn more
Restore Defaults

For example, consider a scenario where you’re using a US international keyboard layout and the VDA
isusing the Russian keyboard layout. When you choose Scancode and type the key next to Caps Lock,
the scancode “1E”is sent to the VDA. The VDA then uses “1E”to display the character “d”. If you choose
Unicode and type the key next to Caps Lock, the character “a”is sent to the VDA. So, even if the VDA
uses the Russian keyboard layout, the character “a”appears on the screen.

Citrix recommends the following keyboard input mode for the different keyboard layout sync op-
tions:

« Scancode mode for Don’t Sync option.

« Unicode mode for Allow dynamic sync and Sync only once - when session starts

Note:

The keyboard configuration changes take effect once you reconnect to the application.

You can change the configuration of Keyboard input mode in the Citrix Workspace app Ul. However,
for best performance, use the Citrix-recommended modes for different scenarios, physical keyboards,
and client devices.
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For more information on configuration details and limitations, see Keyboard input mode enhance-
ments.

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 112.1.1.23, based
on Chromium version 112. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Modification in SPA policy implementation on internal Web and SaaS apps This feature
enhances the security policies implementation on Web and SaaS apps. When a webpage and iframes
within the webpage have different policies, we now have a stricter policy implementation where a
union of all policies is applied on the entire webpage, including the iframes. However, the watermark
is applied to the webpage only.

Support for browser extensions You can add extensions that are provided by your administrator
to the Citrix Enterprise Browser in a secure way. An administrator can deploy, manage, and control the
extensions. End users can view and use the extension under citrixbrowser://extensions as required.
For more settings, see Global App Configuration service.

For information on how to configure, see the Support for browser extensions documentation.

Use GACS to manage Citrix Enterprise Browser The administrator can use the Global App Con-
figuration service (GACS) for Citrix Workspace to deliver Citrix Enterprise Browser settings through a
centrally managed service.

The GACS is designed for administrators to easily configure Citrix Workspace and manage the Citrix
Workspace app settings. This feature allows admins to use GACS to apply various settings or system
policies to the Citrix Enterprise Browser on a particular store. The administrator can now configure
and manage the following Citrix Enterprise Browser settings using APIs or the GACS Admin Ul:

+ “Enable CEB for all apps”- Makes the Citrix Enterprise Browser the default browser for opening
web and SaaS apps from the Citrix Workspace app.

+ “Enable save passwords”- Allow or deny end users the ability to save passwords.

+ “Enable incognito mode”- Enable or disable incognito mode.

+ “Managed Bookmarks”- Allow the administrator to push bookmarks to the Citrix Enterprise
Browser.

+ “Enable developer tools”- Enable or disable developer tools within the Enterprise Browser.

+ “Delete browsing data on exit”- Allow the administrator to configure what data the Citrix Enter-
prise Browser deletes on exit.

« “Extension Install Force list”- Allow the administrator to install extensions in the Citrix Enterprise
Browser.
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« “Extension Install Allow list”- Allow the administrator to configure an allowed list of extensions
that users can add to the Citrix Enterprise Browser. This list uses the Chrome Web Store.

For more information, see Use Global App Configuration service to manage Citrix Enterprise
Browser.

Notes:

« The name and value pair are case-sensitive.
« All the browser settings in Global App Configuration service are under the following cate-

gory:

"category": "browser",
"userOverride": false,
"assignedTo": [
"AllUsersNoAuthentication"
]

}

« The administrator can apply the settings to unmanaged devices as well. For more informa-
tion, see Global App Configuration service documentation.

User interface
To configure Citrix Enterprise Browser through the GACS Admin Ul, do the following:
1. Signin to citrix.cloud.com with your credentials.
Note:
« Refer to the Sign Up for Citrix Cloud article for step-by-step instructions to create a

Citrix Cloud account.

2. Upon authentication, click the menu button in the top left corner and select Workspace Con-
figuration.
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The Workspace Configuration screen appears.

3. Click App Configuration > Citrix Enterprise Browser.

Learn more

Learn more

You can now configure, modify, and publish Citrix Enterprise Browser feature settings.

For more information, see Use Global App Configuration service to manage Citrix Enterprise

Browser.

Technical Preview

+ Client APP Management

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

« With this enhancement, the location data can be collected and sent to Microsoft Teams to sup-

port the dynamic emergency calling feature. [CVADHELP-21117]

+ When you scroll in a MacBook using a touchpad in a user session that is opened through Citrix
Workspace app for Mac, the scroll experience might not be smooth. [CVADHELP-21427]

+ When using Citrix Workspace app for Mac, external users might get disconnected from the ses-

sions intermittently. [CVADHELP-22191]

+ Attempts to add a store URL that contains a query parameter might fail in Citrix Workspace app

for Mac with this error message:
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This store doesn’t exist. Please retry or contact support.
[CVADHELP-22445]

« On an on-premises store, when you attempt to open Citrix Workspace app from the Menu bar,
you might experience an indefinite wait time. [CVADHELP-22688]

2304
What’s new

Enhanced auto start experience Previously, Citrix Workspace app for Mac used to start automati-
cally whenever a computer was turned on. Starting with the 2304 version, you can choose to disable or
enable the auto start feature on Citrix Workspace app for Mac by navigating to Preferences > General
> Start Workspace on system startup. The auto start setting is enabled by default.

General
File Access

App access across devices: Reconnect apps when | sign in to Workspace
+ Reconnect apps when | start or refresh apps

Menu bar: & Show Warksnace in menu har

Auto Start: & Start Workspace on system startup

High DPI: Enable and match client DPI scale settings

Passwords: Delete Passwords...

File download location: | 8 Downloads

For more information, see Enhanced auto start experience.

Improved experience for optimized Microsoft Teams video conference calls Starting with the
2304 version, by default simulcast support is enabled for optimized Microsoft Teams video confer-
ence calls. With this support, the quality and experience of video conference calls across different
endpoints are improved. It is achieved by adapting to the proper resolution for the best call experi-

ence for all callers.
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With thisimproved experience, each user might deliver multiple video streams in different resolutions
(for example, 720p, 360p, and so on) depending on several factors including endpoint capability, net-
work conditions, and so on. The receiving endpoint then requests the maximum quality resolution
that it can handle thus giving all users the optimum video experience.

Note:

This feature is available only after the roll-out of an update from Microsoft Teams. For informa-
tion on ETA, go to https://www.microsoft.com/and search for the Microsoft 365 roadmap. When
the update is rolled-out by Microsoft, you can check CTX253754 for the documentation update

and the announcement.

For more information see,
Improved experience for optimized Microsoft Teams video conference calls.

Support for Certificate-based authentication [Technical Preview] Starting with the 2304 ver-
sion, Workspace administrators can configure and enforce Azure Active Directory conditional access
policies for users authenticating to Citrix Workspace app.

The following methods can be used to enable the authentication using conditional access:

+ Mobile Device Management (MDM)
+ Global App Configuration service (GACS)

The flag values read by Citrix Workspace app take precedence in the following order:

+ Mobile Device Management (MDM)
+ Global App Configuration service (GACS)

For more information, see Support for Certificate-based authentication.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in

production environments.

Force login prompt for Federated identity provider Citrix Workspace app now honors the Fed-
erated Identity Provider Sessions setting. For more information, see Citrix Knowledge Center article

CTX253779.

You no longer need to use the Store authentication tokens policy to force the login prompt. For more

information, see Force login prompt for Federated identity provider.
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Support for non-English-language Input Method Editors (IME) keyboard layouts Support for
non-English language IME keyboard layouts continues to work uninterrupted after the Carbon APIs
are deprecated with the Cocoa APIs. For more information, see Support for non-English-language
Input Method Editors (IME) keyboard layouts.

Log collection Log collection simplifies the process of collecting logs for Citrix Workspace app. The
logs help Citrix to troubleshoot, and, in cases of complicated issues, facilitate support. Users can now
collect logs quickly by using the new option provided in the Help menu by navigating to Help and
selecting the Logging... or Email Log Files option. This feature improves the user experience during
the log collection process.

Citrix Workspace Help

Logging...
Email Log Files

«+ Logging... - clicking this option directs you to Preferences > Advanced > Logging
« Email Log Files —clicking this option allows collecting the latest logs.

For more information, see Log collection.

Support synchronization for more keyboard layouts Starting with the 2304 version, Citrix Work-
space app for Mac supports keyboard layout synchronization for the following layouts or Input Method
Editors (IMEs):

+ English ABC
English ABC - India
Chinese, Traditional: Zhuyin - Traditional

Chinese, Traditional: Sucheng - Traditional

Google Japanese IME

Sougou Chinese IME

For more information, see Support synchronization for more keyboard layouts.

Microsoft Teams enhancement

Configuring a preferred network interface You can now configure a preferred network interface
for media traffic. Run the following command in a terminal:
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defaults write com.citrix.HdxRtcEngine NetworkPreference -int <value>

Select one of the following values as required:

« 1: Ethernet
o 2: Wi-Fi

+ 3: Cellular

* 4: VPN

« 5: Loopback
« 6: Any

By default and if no value is set, the WebRTC media engine chooses the best available route.

For more information, see Configuring a preferred network interface.

Limiting video resolutions Administrators with users on lower-performance client endpoints can
limit incoming or outgoing video resolutions to reduce the impact of video encoding and decoding
on those endpoints. Starting from Citrix Workspace app 2304 for Mac, you can limit these resolutions
using client configuration options.

For more information, see Limiting video resolutions.

Support for horizontal scroll [Technical Preview] Previously, Citrix Workspace app for Mac sup-
ported only vertical scroll on a trackpad. Starting with the 2304 version, a horizontal scroll is also
supported.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in

production environments.

Keyboard input mode enhancements Citrix Workspace app for Mac provides Ul to configure the
keyboard input mode.

To configure keyboard input mode by using the GUI, do the following:

1. From the Citrix Workspace app icon in the menu bar, click the account icon in the top-right cor-
ner and navigate to Preferences > Keyboard.

The Keyboard input mode settings appear
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2. Select from one of the following options:

« Scancode-Sends the key position from the client-side keyboard to VDA and VDA generates
the corresponding character. Applies server-side keyboard layout.

+ Unicode - Sends the key from the client-side keyboard to VDA and VDA generates the same
character in VDA. Applies client-side keyboard layout.

This enhancement is enabled by default.
= »

General Accounts File Access Devices

@ Keyboard

Choose keyboard shortcuts to send commands to your applications.
Send Control character using: 3 Command (left) or ~~ Control E
Send Alt character using: 3£ Command (left)-Option %]
Keyboard layout synchronization settings:  Sync only once - when session staris ﬂ

Keyboard input mode settings: Unicode E

Mote: Scancode is the recommended option for the "Don't sync® setting.
Send Windows logo key using 3 Command (right)

Send special keys unchanged (press 3 Command (left) for some keys)
Show the remote language bar for the published applications

Changes will take effect once you reconnect to this application.

Learn more
Restore Defaults

For example, consider a scenario where you’re using a US international keyboard layout and the VDA
isusing the Russian keyboard layout. When you choose Scancode and type the key next to Caps Lock,
the scancode “1E”is sent to the VDA. The VDA then uses “1E”to display the character “d”. If you choose
Unicode and type the key next to Caps Lock, the character “a”is sent to the VDA. So, even if the VDA
uses the Russian keyboard layout, the character “a”appears on the screen.

Citrix recommends the following keyboard input mode for the different keyboard layout sync op-

tions:

+ Scancode mode for Don’t Sync option.

« Unicode mode for Allow dynamic sync and Sync only once - when session starts

Note:

The keyboard configuration changes take effect once you reconnect to the application.
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You can change the configuration of Keyboard input mode in the Citrix Workspace app Ul. However,
for best performance, use the Citrix-recommended modes for different scenarios, physical keyboards,
and client devices.

For more information on configuration details and limitations, see Keyboard input mode enhance-
ments.

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 109.1.1.31, based
on Chromium version 109. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Technical Preview

» Rapid Scan
+ Enhanced virtual apps and desktops launch experience
 Support for multiple audio devices

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

+ When you create two XML files on a Mac local client, the VDA might open the incorrect XML file.
For example, the VDA opens the Snapshot.xml file instead of opening the SnapshotPopup.xml
file. [HDX-45326]

+ When you change the active audio devices in the sound settings on the endpoint, Microsoft
Teams might not receive any notification about the change. As a result, Microsoft Teams fails to
pick the changes. [HDX-47080]

+ The Citrix Viewer might quit occasionally when you close a VDA session. [HDX-45668, HDX-
47138]

« The responder policy configured using Citrix ADC might fail to work with Citrix Workspace app
for Mac. The issue occurs when the policy configured checks if the user agent has sent CWAWE-
BVIEW, Citrix Receiver, or Citrix Workspace as a substring, which does not match. As a result,
users might be redirected to a different Citrix Gateway URL. [CVADHELP-20519]

» When you connect to Citrix Gateway Store and attempt to sign in to Citrix Workspace app for
Mac, the sign-in might get stuck or take time with a spinning wheel. [CVADHELP-21323]

« Citrix Workspace app for Mac might fail to start a session if the File Type Association is set for
an app under Application Settings in Citrix Studio. [CVADHELP-21371]
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+ Asign-in window might appear automatically in Citrix Workspace app for Mac when you power
on or restart your system. [CVADHELP-21484]

« Citrix Workspace app for Mac might quit unexpectedly when the Universal Windows Platform
(UWP) apps within the VDI attempt to authenticate using the FIDO2 authentication. [CVADHELP-
21576]

+ Attempts to open the web resources might fail with this error message:

Switch to another store with the necessary permissions. If the issue persists, contact your
admin with error details.

[CVADHELP-21787]

« Citrix Workspace app for Mac might use anincorrect user agent CitrixReceiver instead of Citrix
Workspace as a substring. As a result, the authorization policies aren’t honored. [CVADHELP-
21969]

» When using the notch screen feature, a part of the text might be cut. [CVADHELP-22134]

+ When you open Citrix Enterprise Browser from the dock, instead of a new tab, it shows that
the page is loading. As a workaround, enter the URL in the address bar or open another tab to
continue browsing. [CTXBR-4706]

+ When using the Citrix Secure Private Access enabled store, an infinite loading spinner might
appear while launching the published content. The issue occurs when Citrix Enterprise Browser
isn’trunning on the user device. As aresult, you can’t view the published content. [CTXBR-4813]

2301.1
What’s new

This 2301.1 release addresses a few issues that help to improve overall performance and stability.

Fixed issues
+ You might face issues when you add or authenticate a store, or start a resource (apps or desk-
tops) using the native Citrix Workspace app. [CVADHELP-22372]

« Theincomingvideo and screen sharing might not work during Microsoft Teams optimized video
calls. [HDX-50059]
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Known issues in 2301.1

+ You can’t update to Citrix Workspace app for Mac version 2301.1 using the auto-update service.
As a workaround, you must manually install the Citrix Workspace app for Mac version 2301.1 by
downloading the .dmg file available on the Downloads page.

2301
What’s new

Background blurring and replacement for Citrix Optimized Microsoft Teams Citrix Optimized
Microsoft Teams in Citrix Workspace app for Mac now supports background blurring and background
replacement. You can use this by selecting More > Apply Background Effects when you are in a
meeting or a P2P call.

Auto-update version control [Technical Preview] Administrators can now manage the auto-
updated version of Citrix Workspace app for the devices in the organization.

Administrators can control the version by setting the range in the maximumAllowedVersion and
minimumAllowedVersion properties in the Global App Configuration service.

Example JSON file in Global App Configuration service:

{

"serviceURL": {

"url": "https://serviceURL:443"
}

)

"settings": {

"name": "Version Control for Citrix Workspace",

"description": "Provides admin ability to Version Control for
Citrix Workspace",

"useForAppConfig": true,

"appSettings": {

"macos": [

{

"category": "AutoUpdate",

"userOverride": false,

"assignedTo": [
"AllUsersNoAuthentication"

1,

"settings": [

{
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"name": "Auto update plugins settings",
"value": [
{
"pluginName": "Citrix Workspace",

"pluginId": "D99C3E77-FBF5-4B97-8EDA-4E381A1E0826",
"pluginSettings": {

"deploymentMode": "Update",
"upgradeTolLatest": false,
"minimumAllowedVersion": "23.04.0.36",
"maximumAllowedVersion": "23.04.0.36",
"delayGroup": "Medium",

"detectRule": ""

}

When the range is set, Citrix Workspace app on the user’s device is automatically updated to the high-
est available version that falls between the mentioned range.

If you want to auto-update Citrix Workspace app to a specific version, enter the same version in the
maximumAllowedVersion and minimumAllowedVersion properties in the Global App Con-
figuration service.

Note:

+ To enable auto-update version control, the upgradeToLatest setting in the Global
App Configuration service must be set to false. If the upgradeToLatest setting is true, the
maximumAllowedVersionand minimumAllowedVersionisignored.

+ Do not modify the pluginld. The pluginld is mapped to Citrix Workspace app.

« If the administrator hasn’t configured the version in the Global App Configuration service,
Citrix Workspace app is updated to the latest available version by default.

+ You can only use the version ranges that are set to update Citrix Workspace app. However,
a downgrade isn’t supported.
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« This feature is supported from release 2301 onwards.

You can provide feedback for this technical preview by using the
Podio form.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in

production environments.

Improved auto-update experience [Technical Preview] The automatic update feature automat-
ically updates the Citrix Workspace app to the latest version, without any user intervention. Citrix
Workspace app periodically checks for any latest updates and downloads the latest available version
of the app. By default, automatic updates are enabled, unless your admin disable the automatic up-
dates.

Installation starts when the Citrix Workspace app or the sessions are idle.
Note:

Citrix Workspace app cannot be accessed during the installation.

When you start the Citrix Workspace app, a notification appears to indicate the status of the installa-

tion.

You can disable the auto-update feature by navigating to Preferences > Advanced > Updates and
unselecting the Automatically keep Workspace app up to date option.

You can provide feedback for this technical preview by using the
Podio form.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrix does not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in

production environments.

Enhanced notch screen support Starting with the 2301 version, Citrix Workspace app for Mac sup-
ports Macs with a notch display. Macs support a native notch screen in full screen mode for retina
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and multi-monitor displays. The area of the session in the notch screen is now much bigger and pro-
vides the customers with more screen space. This enhancement also supports high DPI scaling. The
mouse position also appears accurate in all the external monitors connected. For more information,
see Enhanced notch screen support.

Note:

Ensure not to select the Scale to fit below built-in camera option in the Citrix Viewer. This
option isn’t selected by default and can be found only on Macs with notch display.

App Protection enhancement Starting with the 2301 version, App Protection is enhanced to pro-
tect the Citrix Workspace app. This enhancement includes protecting the authentication screen and
the screen that you see after signing into the Workspace app. For more information, see App Protec-
tion.

Global App Configuration service channel support [Technical Preview] The Global App Config-
uration service for Citrix Workspace allows a Citrix administrator to deliver Workspace service URLs
and Workspace App settings through a centrally managed service. For more information, see Global
App Configuration service documentation.

Administrators can now use the Global App Configuration service to define settings, which are applic-
able to specific user-groups. This feature ensures that some features or functionalities can be made
available to only certain users as required, and not to others.

You can provide feedback for this technical preview by using the
Podio form.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in

production environments.

Enhanced menu bar support Starting with the 2301 version, the CWA fully supports the Automat-
ically hide and show the menu bar in full screen option in MacOS. For versions earlier than macOS
13, you must navigate to System Preferences > Dock & Menu Bar and clear the Automatically hide
and show the menu bar in full screen option. For macOS 13 and later versions, you must navigate to
System Preferences > Desktop & Dock and clear the Automatically hide and show the menu barin
full screen option. You have the provision to either enable or disable this option. This enhancement
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also supports high DPI scaling. The mouse position also appears accurate in all the external monitors
connected. For more information, see Enhanced menu bar support.

The figure below illustrates a window where the menu bar is hidden

The figure below illustrates a window where the menu bar appears

W Citrix Viewer \View Devices Debug

- |

Fecycle Bin

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 107.1.1.13, based

on Chromium version 107. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Set Citrix Enterprise Browser as the work browser You can now configure Citrix Enterprise
Browser as a work browser to open all work links. You can select an alternate browser to open
non-work links.

Awork linkis a link that is associated with the web or Saa$S apps that the administrator configures for
the end user. When a user clicks any link within a native application, if it’s a work link, it’s opened
through the Enterprise Browser. If not, it’s opened through any other browser that the end-user se-
lects.

For more information, see Set Citrix Enterprise Browser as the work browser.

Fixed issues

« HTTP Live Streaming (HLS) protocol with High-Efficiency Advanced Audio Coding (AAC-HE)
stream fails to play back audio on Citrix Enterprise Browser. [CTXBR-3899]

+ When you click a hyperlink in the custom portal, an error message appears before opening the
link. Later, the link opens in a system browser, for example, Google Chrome instead of Citrix
Enterprise Browser. [CTXBR-4051]
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+ When using Citrix Workspace app for Mac with a custom web store URL, the versions of the oper-
ating system and Citrix Workspace app might not be shown in the user agent string. [CVADHELP-
21377]

« With this fix, certain third-party apps such as Epic or Kronos might not freeze when you start
them. [HDX-46140]

+ When you attempt to start a session using an ICA file from Citrix Workspace app 2301 for Mac
Beta build for the first time, the session might quit unexpectedly. [HDX-47361]

« Whenyou add the custom portal site to Citrix Workspace app for Mac, a blank page might appear.
[RFMAC-12857]

2211.1
What’s new

This release addresses a few issues that help to improve overall performance and stability.

Fixed issues
+ You might face issues when you add or authenticate a store, or start a resource (apps or desk-
tops) using the native Citrix Workspace app. [CVADHELP-22372]

« Theincomingvideo and screen sharing might not work during Microsoft Teams optimized video
calls. [HDX-50059]

2211
What’s new

Workspace apps appear in the Dock with native app icons when opened [Technical Preview]
Starting with the 2211 version, this feature is disabled by default.

This feature is a request-only preview. To get it enabled in your environment, fill out the Podio form.

Improved Mission Control and App Expose experience [Technical preview] Starting with the
2211 version, this feature is disabled by default.

This feature is a request-only preview. To get it enabled in your environment, fill out the Podio form.
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Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 105.2.1.40, based
on Chromium version 105. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Fixed issues

This release also addresses several issues that help to improve overall performance and stability.

2210
What’s new

macOS 13 Ventura Support Citrix Workspace app for Mac is supported on macOS 13 Ventura
(13.0).

Improved automatic update experience on Mac with Apple Silicon (M1 Series) Starting with this
version, when you download the Universal Architecture build, you can choose between the Apple
Silicon and Intel builds to support both the Apple Silicon and Intel based Mac machines.

Advanced

Updates  Citrix Casting  Logging

v Automatically keep Workspace app up to date

Select Intel or Apple Silicon build: = Apple Silicon

Select the update channel: = Release

On Apple Silicon machines, the users have the option to automatically update the Intel build even
after having downloaded the Apple Silicon build. The option is provided in the Preferences tab.

Advanced configuration for automatic updates You can configure Citrix Workspace automatic up-
dates on Mac with Apple silicon (M1 Series) using the following methods:
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Graphical user interface
Global App Configuration service (GACS)
Mobile Device Management (MDM)

.

StoreFront

For more information, see Advanced configuration for automatic updates.

Workspace apps appear in the Dock with native app icons when opened [Technical Preview]
Previously, clicking virtual apps in the Citrix Workspace app triggered the Citrix Viewer where these
apps would be available. If you open many apps, the apps or its instances opened in the Citrix Viewer.
You can view the open apps by right-clicking the Citrix Viewer icon.

Presentationl - PowerPoint
Presentation2 - PowerPoint

Sign in to your account - Google Chrome
Documant] - Ward

Dptlans

Show All Windows
Hide

Quit

Starting with this version, when you open virtual apps, they appear in the Dock with their respective
icons and are easily identifiable. You can then access the virtual app from the dock itself. If you open
multiple instances of an app, these instances aren’t duplicatesin the Dock but are grouped within one
instance in the Dock.
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Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Improved Mission Control and App Expose experience [Technical preview] Previously, usingthe
Mission Control or App Expose feature in a virtual app session resulted in the overlapping of many
windows that were opened.
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Starting with this version, when you use the Mission Control or App Expose feature in a virtual app
session and open many windows, the windows do not overlap, and you can easily choose from among
them.
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Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrix does not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Improved graphics performance [Technical preview] With this version, the performance of
graphics is improved for desktop sessions.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrix does not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Support for high DPI  Citrix Workspace app for Mac is now compatible with one high DPI monitor
with 4K or 5K resolution. With this feature, the text, images, and other graphical elements on virtual
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desktop or app sessions appear in a size that can be viewed comfortably on these high-resolution
monitors. For more information, see Support for high DPI.

To enable this feature, navigate to Preferences > General > High DPI.

W )
@ General ] ke =2 ”»

General File Access Devices Mic & Webcam
App access across devices: Reconnect apps when | sign in to Workspace
Reconnect apps when | start or refresh apps
Menu bar: Show Workspace in menu bar

High DPI: Enable and match client DPI scale settings

File download location: = [& Downloads (]

Note:

The number of external monitors you can use with your mac is always limited by the Mac model,
as well as the resolution and refresh rate of each display. Refer to the technical specifications
of your Mac to find out the supported number of external monitors. For more information, see
Connect one or more external displays with your Mac in the Apple support article.

Support for admin configuration of user devices through MDM tool Admins can now configure
the following settings while deploying Citrix Workspace app through any MDM deployment tool such
as Citrix Endpoint Management:

+ StoreURLs —Configure store details so it’s automatically added when the user opens the Citrix
Workspace app, simplifying the sign-on experience.
To add a store, provide the details for the StoreURLSs setting. For example, <string>https
://myorg.com/?storename</string>.

+ BlockStoreAddition —Prevent the user from adding stores.

To block the user from adding a store, set the value of the BlockStoreAddition setting to True.

For more information, see Support for store configuration of user devices through MDM tool.

Support for certificate-based authentication [Technical Preview] You can now authenticate to
Citrix Workspace app (cloud stores) by using a client certificate.

Previously, Certificate based authentication was supported on on-premises setups and customers on
cloud setups were unable to sign in to Citrix Workspace app. This feature is disabled by default and
admins must contact the Citrix help desk to enable this feature by filling this request form.
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If your organization has configured Conditional Access with Azure Active Directory, then the user is
prompted to select a Client Certificate for authentication while signing in. Certificate-based authenti-
cation adds another layer of security, ensuring that your device is compliant.

Once you add a store and enter valid credentials for that store, Citrix Workspace app displays a list of
valid certificates available in your keychain for Client Authentication. If there’s only one valid certifi-
cate in your keychain, it’s selected by default.

Choose a certificate to continue

Site https://device.login.microsoftonline.com:443 requires your credentials

@

E d7eEb1fe-0933-44c2-af74-3a9¢cfEbebB0b (MS-Organization-Access)
E MDM Configuration

Show Certificate Skip Choose

Once you choose a certificate, the identity provider validates it and the Workspace app store appears
on successful validation.

Note:

« If there are no valid certificates in your keychain, the Citrix Workspace app performs the
default handling for the certificate authentication request from the server.
This might prevent the user from logging in.

+ Ifyourorganization has configured Conditional Access with Azure Active Directory and valid
certificates aren’t found in your keychain, you can’t log in to Citrix Workspace app.

If a previously selected certificate is no longer valid, an error message appears, prompting you to se-
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lect a valid certificate or to contact your admin in the absence of one.

Certificate invalid

Previously used certificate is not valid
anymore either select a new one or
contact your admin.

(0] ¢

This feature is a request-only preview. To get it enabled in your environment, fill out the Podio form.
Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrix does not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Rebranding Citrix Workspace Browser Citrix Workspace Browser is now Citrix Enterprise Browser.
The custom scheme is now changed from citrixworkspace:// to citrixbrowser://.

Implementing this transition in our products and their documentation is an ongoing process. Your
patience during this transition is appreciated.

+ The product U, in-product content, and the images and instructions in product documentation
will be updated in the coming weeks.

+ It’s possible that some items (such as commands and MSIs) might continue to retain their for-
mer names to prevent breaking existing customer scripts.

+ Related product documentation

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 105.1.1.19, based
on Chromium version 105. For more information about the Citrix Enterprise Browser, see Citrix Enter-
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prise Browser documentation. and other resources (such as videos and blog posts) that are linked
from this product documentation might still contain former names.

Make Citrix Enterprise Browser the work browser [Technical Preview] You can now configure
Citrix Enterprise Browser to open all work or enterprise links and apps configured by your administra-
tor in the Citrix Workspace app. This feature provides a way for you to open only work links or web
and SaaS apps in the Citrix Enterprise Browser.

You can select an alternate browser to open any other non-work links or apps.

Open all web and Saa$ apps through the Citrix Enterprise Browser From this version, all inter-
nal web apps and external SaaS apps available in the Citrix Workspace app open in Citrix Enterprise
Browser.

Support for browser extensions [Technical Preview] You can add extensions that are provided
by your administrator to the Citrix Enterprise Browser in a secure way. An administrator can
deploy, manage, and control the extensions. End users can view and use the extension under
citrixbrowser://extensions as required. For more settings, see Global App Configuration service.

Note:

This feature is a request-only preview. To get it enabled in your environment, fill out the Podio
form.

For information on how to configure, see the Citrix Enterprise Browser documentation.

Use Global App Configuration service to manage Citrix Enterprise Browser [Technical Preview]
The administrator can use the Global App Configuration service for Citrix Workspace to deliver Citrix
Enterprise Browser settings through a centrally managed service.

The Global App Configuration service is designed for administrators to easily configure Citrix Work-
space and manage the Citrix Workspace app settings. This feature allows admins to use the Global
App Configuration service to apply various settings or system policies to the Citrix Enterprise Browser
on a particular store. The administrator can now configure and manage the following Citrix Enterprise
Browser settings using the Global App Configuration service:

+ “Enable CEB for all apps”- Makes the Citrix Enterprise Browser the default browser for opening
web and Saa$S apps from the Citrix Workspace app.

+ “Enable save passwords”- Allow or deny end users the ability to save passwords.

+ “Enable incognito mode”- Enable or disable incognito mode.

+ “Managed Bookmarks”- Allow the administrator to push bookmarks to the Citrix Enterprise
Browser.
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« “Enable developer tools”- Enable or disable developer tools within the Enterprise Browser.

+ “Delete browsing data on exit”- Allow the administrator to configure what data the Citrix Enter-
prise Browser deletes on exit.

« “Extension Install Force list”- Allow the administrator to install extensions in the Citrix Enterprise
Browser.

+ “Extension Install Allow list”- Allow the administrator to configure an allowed list of extensions
that users can add to the Citrix Enterprise Browser. This list uses the Chrome Web Store.

Notes:

« This feature is a request-only preview. To get it enabled in your environment, fill out the
Podio form.

« Technical previews are available for customers to test in their non-production or limited
production environments, and to give customers an opportunity to share feedback. Citrix
does not accept support cases for feature previews but welcomes feedback for improving
them. Citrix might or might not act on feedback based on its severity, criticality, and impor-
tance. It’s advised that Beta builds aren’t deployed in production environments.

« The name and value pair are case-sensitive.

« All the browser settings in Global App Configuration service are under the following cate-

gory:

"category": "browser",
"userOverride": false,
"assignedTo": [
"AllUsersNoAuthentication"

]
b

« The administrator can apply the settings to unmanaged devices as well. For more informa-
tion, see Global App Configuration service documentation.

Technical Preview

+ Upgraded version of WebRTC for the optimized Microsoft Teams

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

« Citrix Workspace app might interrupt the restart or shutdown power action of a Mac device.
[RFMAC-12530]
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« The shift key might not work as expected in Citrix Workspace app for Mac version 2206.
[CVADHELP-20674]

2209
What’s new

Sign out of the custom web store when you close Citrix Workspace app When the signoutCus-
tomWebstoreOnExit setting is set to True, closing the Citrix Workspace app window signs you out of
the custom web store. When you reopen the Citrix Workspace app, the web store URL is loaded again.
You can configure the signoutCustomWebstoreOnExit setting in the Global App Configuration ser-
vice. For more information, see Sign out of the custom web store when you close Citrix Workspace

app

Citrix Enterprise Browser This release includes Citrix Enterprise Browser (formerly Citrix Work-
space Browser) version 103.2.1.10, based on Chromium version 103. For more information about the
Citrix Enterprise Browser, see Citrix Enterprise Browser documentation.

Fixed issues

« Citrix Workspace app for Mac might start automatically when you restart Citrix Workspace app
for Mac or install Citrix Workspace app. [RFMAC-12392]

« The screen sharing feature in Optimized Microsoft Teams for certain third-party apps might fail
on Citrix Workspace app for Mac. The issue occurs when the Thinwire codec policy is set to For
entire screen. As a result, the app sharing feature is disabled and no options are available in
the sharing panel. [CVADHELP-20853]

2208.1
What’s new

View apps, desktops, and Citrix Enterprise Browser from the menu bar through a quick access
menu You can now view your most recently used or favorite apps and desktops or open a Citrix En-
terprise Browser window by clicking the Citrix Workspace icon in the menu bar. This feature provides
easy access to some of your resources without having to open the Citrix Workspace app.

Note:

This feature isn’t available on on-premises setups.
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©@ @ v

Recents Favorites
Apps

B Access 2016

Concur
Excel 2016

Bitbucket -code
¢ Chrome

View all applications
Desktops

B8 Managed Win10 SIN Desktop

View all desktops

Version: 22.06.0.0 (2206)
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If you’ve not configured any accounts, a sign-in prompt appears.

@ © ©)

7/

A maximum of 5 of your recently used or favorite apps or desktops appear in the options under the
Recent and Favorites tabs respectively. To view the other apps in the Citrix Workspace app, click View
all applications. To view the other desktops in the Citrix Workspace app, click View all desktops.
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Recents Favorites
Apps
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¢ Chrome
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View all desktops

Version: 22.06.0.0 (2206)
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You can open the Citrix Workspace Ul by clicking the Citrix Workspace app icon.

| © v

Recents Favorites

You can open the Citrix Enterprise Browser, without opening a web or Saa$ app by clicking the Citrix

Enterprise Browser icon.

¢ [o] ©

Note:

The Citrix Enterprise Browser isn’t available if the configured store doesn’t have any web or Saa$S
apps. Further, it’s available only if your admin has configured Citrix Secure Private Access.
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©@ ©
Signin
Preferences

Check for updates

About

Quit

You can view the following options when you click the Account icon in the top-right corner:

« Preferences

« Check for updates
» About

o Quit
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For more information, see View apps, desktops, and Citrix Enterprise Browser from the menu bar
through a quick access menu.

Support for authentication using FIDO2 [Technical Preview] With this version, users can authen-
ticate within an HDX session using password-less FIDO2 security keys. FIDO2 security keys provide a
seamless way for enterprise employees to authenticate to apps or desktops that support FIDO2 with-
out entering a user name or password. For more information about FIDO2 see FIDO2 Authentication.
This feature currently supports roaming authenticators (USB only) with PIN code and touch capabili-
ties. You can configure FIDO2 Security Keys based authentication. For information about the prereg-
uisites and using this feature, see Local authorization and virtual authentication using FIDO2.

When you access an app or a website that supports FIDO2, a prompt appears, requesting access to
the security key. If you’ve previously registered your security key with a PIN (a minimum of 4 and a
maximum of 64 characters), then you must enter the PIN while signing in.

If you’ve registered your security key previously without a PIN, simply touch the security key to sign
in.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Battery status indicator The battery status of the device now appears in the notification area of a
Citrix Desktop session. To view the battery status within the desktop session, click the Show hidden
icons arrow in the taskbar.

Charging: 100% g

AN 3=I0
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Note:

The battery status indicator does not appear for server VDAs.

For more information, see Battery status indicator.

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 103.1.1.14, based
on Chromium version 103. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Citrix Enterprise Browser Profiles Profiles help you keep personal information such as history,
bookmarks, passwords, and other settings separate for each of your Citrix Workspace accounts. Based
your Workspace store, a profile is created, allowing you to have a unique and personalized browsing
experience.

Note:

After you upgrade to version 103.1.1.14 and sign in to the device for the first time, only your pre-
viously saved passwords are removed. When you sign in to the device using a different store for
the first time, all your previously saved data is lost.

Open all web and Saa$S apps through the Citrix Enterprise Browser [Technical Preview] From
this version, all internal web apps and external SaaS apps available in the Citrix Workspace app open
in Citrix Enterprise Browser. You can register for this technical preview by using this Podio form.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and to give customers an opportunity to share feedback. Citrix does not ac-
cept support cases for feature previews but welcomes feedback forimproving them. Citrix might
or might not act on feedback based on its severity, criticality, and importance. It’s advised that
Beta builds aren’t deployed in production environments.

Fixed issues

+ When the Citrix Workspace login prompt appears, clicking the Cancel button doesn’t close the
popup and it appears repeatedly. [CVADHELP-19919]

+ If you’re using Direct Workload Connection in Citrix Cloud to connect to VDAs directly, a black
screen appears and you’re disconnected from the VDA. This issue occurs when Network Loca-
tion Service (NLS) is enabled. [HDX-40588]
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« When you use a multi-touch gesture to swipe between full-screen apps, the Citrix Workspace
desktop session window turns black for a moment. This issue occurs on Macs with a notch

display. [HDX-42314]

2206.1
What’s new

Uninstall the app by dragging the Citrix Workspace app icon to the bin You can now simply drag
or move the Citrix Workspace app icon into the bin to completely uninstall the app.

Previously, dragging the Workspace app icon into the bin would remove the app but leave behind
certain system files on your Mac. With this version, the Citrix Workspace app and all its associated
files are removed from your device when you drag the icon to the bin.

To uninstall the Citrix Workspace app by dragging it to the bin, do the following:

1. Close the Citrix Workspace app, if it’s running.
2. Drag the Citrix Workspace app to the bin.
Alternatively, you can right-click on the Citrix Workspace app and select Options > Move to Bin.
3. Provide your system credentials when prompted.
4. Close all running apps (Citrix Workspace) and click Continue to confirm.
The Citrix Workspace app and all its system files are deleted from your device.

For more information, see Uninstall

Support for service continuity in the Safari browser The Citrix Workspace service continuity fea-
ture is now supported for the Safari browser. Users must install Citrix Workspace app for Mac and the
Citrix Workspace web extension. Service continuity removes (or minimizes) the dependency on the
availability of the components involved in the connection process. It allows you to connect to your
virtual apps and desktops regardless of the cloud services’health status. For more information about
the service continuity feature, see section Service continuity.

Improved audio echo cancellation support [Technical Preview] Citrix Workspace app now sup-
ports echo cancellation in adaptive audio and legacy audio codecs. This feature is designed for real-
time audio use cases, and it improves the user experience.

Citrix recommends using adaptive audio.

Note:

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrixdoes not accept support cases for feature previews
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but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Enhancements to Optimized Microsoft Teams In optimized Microsoft Teams, you can now use the
video function when more than one virtual desktop or app sessionisin use. For more information, see
Enhancements to Optimized Microsoft Teams

Battery status indicator [Technical Preview] The battery status of the device now appears in the
notification area of a Citrix Desktop session.

Charging: 100% @

Note:
The battery status indicator does not appear for server VDAs.

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and share feedback. Citrix does not accept support cases for feature previews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It is advised that Beta builds are not deployed in produc-
tion environments.

Citrix Enterprise Browser Thisreleaseincludes Citrix Enterprise Browser version 101.1.1.14, based
on Chromium version 101. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Fixed issues

« The mouse pointer is misaligned on Macs with a notch display. [CVADHELP-19337]
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« You’re not signed out of the Workspace app when the inactivity timeout value lapses. Thisissue
occurs intermittently. [CVADHELP-19812]

+ You might get an error when you try to uninstall Citrix Workspace app. [CVADHELP-19121]

« In optimized Microsoft Teams, the video function might not work if you start another virtual
desktop or app session. [HDX-40451]

+ While sharing the screen or an app during the Microsoft Teams call, your peers might see visual
artifacts. Thisissue occurs due to unstable frame rates, such as incorrect video playback (frozen
or transient black frames). This release includes improved frame rates or sampling rates that
help to reduce visual artifacts. [HDX-38032]

2204
What’s new

Global App Configuration service settings for allowedWebStoreURLs Admins can now use
Global App Configuration service to configure settings of Custom Web Stores. Admins can config-
ure the Custom Web Stores by using the allowedWebStoreURLs property. For more information
about the Global App Configuration service, see Getting Started.

Support to open Citrix Workspace app in maximized mode Adminscan configurethemaximise

workspace window property in the Global App Configuration service to enable the Citrix Work-
space app to open in the maximized mode by default. For more information about the Global App
Configuration service, see Getting Started.

Support for high DPI monitors [Technical preview] Citrix Workspace app for Mac is now compati-
ble with one high DPI monitor with 4K or 5K resolution. With this feature, the text, images, and graph-
ical elements on virtual desktop or app sessions appear in a size that can be viewed comfortably on
these high-resolution monitors.

To enable this feature, navigate to Preferences > General > High DPI.

- -

[ ] General ’l\ k' _Q ”

General File Access Devices Mic & Webcam

App access across devices: Reconnect apps when | sign in to Workspace
Reconnect apps when | start or refresh apps

Menu bar: Show Workspace in menu bar

High DPI: Enable and match client DPI scale settings

File download location: = [& Downloads
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Administrators can edit the Display memory limit policy, which specifies the maximum video buffer
size in kilobytes for a desktop session, to suit the display resolution. The default value for the Display
memory Limit policy is 65536 KB and is sufficient for one high DPI monitor with 4K resolution.

For virtual app sessions, the default value of Display memory Limit is sufficient as the app session
doesn’t support more than one display.

Forvirtual desktop sessions, administrators must navigate to Citrix Studio > Policies > Display mem-
ory limit and use a higher value, for example 393216 KB to use High DPI features for more than one
external monitor or 5K resolution monitor.

For more information about the Display memory limit policy, see Display memory limit.

Admins can edit the Display memory limit policy, which specifies the maximum video buffer size
in kilobytes for a desktop session, to suit the display resolution. The default value for the Display
memory Limit policy is 65536 KB and is sufficient for up to 2x4K monitors (2x32400KB). Admins must
edit this value by navigating to Citrix Studio > Policies > Display memory limit and use a value of
393216 KB to use this feature.

For more information about the Display memory limit policy, see Display memory limit.
Note:
This feature works with a maximum of two connected monitors.

Technical previews are available for customers to test in their non-production or limited produc-
tion environments, and to give customers an opportunity to share feedback. Citrix does not ac-
cept support cases for feature previews but welcomes feedback for improving them. Citrix might
or might not act on feedback based on its severity, criticality, and importance. It’s advised that
Beta builds aren’t deployed in production environments.

Enhancement to Permanent Client Access License (CAL) for Remote Desktop Sessions With this
version, if you’re running CAL in your environment to access remote desktops, when the client ID is
greater than 15 characters, you can launch the remote desktop session with a permanent license.

To enable this feature, admins must configure the defau'lt. i ca file by doing the following:

1. In the StoreFront server, navigate to C:\inetpub\wwwroot\Citrix<StoreName>\App_Data and
open the defau'lt. ica file with any editor.
2. Add the following lines in the [WFClient] section:

isRDSLicensingEnabled=0n

Restore default keyboard settings You can now restore the default keyboard settings if you have
modified the settings in the keyboard preferences of Citrix Workspace app. To restore the keyboard
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settings to its default values, open the Citrix Workspace app, navigate to Preferences > Keyboard and
click Restore Defaults. Click Yes to confirm.

App Protection compatibility with HDX optimization for Microsoft Teams With this version, full
monitor or desktop sharing is disabled when App Protection is enabled for the delivery group. When
you click Share content in Microsoft Teams, the screen picker removes the Desktop option. You can
only select the Window option to share any open app, if the VDA is 2109 or higher. If you’re connected
to VDA older than 2019, no content is selectable.

Citrix Enterprise Browser This release includes Citrix Enterprise Browser version 99.1.1.8, based
on Chromium version 99. For more information about the Citrix Enterprise Browser, see Citrix Enter-
prise Browser documentation.

Make Citrix Enterprise Browser your default browser You can now make Citrix Enterprise
Browser your default browser. Once you have made the Citrix Enterprise Browser your default
browser, all links and Web and SaaS apps open in the Citrix Enterprise Browser by default.

To make Citrix Enterprise Browser your default browser on macOS, do the following:

1. Open the Citrix Enterprise Browser and click the ellipsis icon and open the Settings menu.
2. Click the Default Browser option on the left pane.

3. In the Default browser page, click Make default. When prompted, click Use Citrix Enterprise
Browser to confirm your choice and apply the changes.

Fixed issues

The mouse pointer is misaligned on Macs with a notch display. [CVADHELP-19337]

+ You’re not signed out of the Workspace app when the inactivity timeout value lapses. Thisissue
occurs intermittently. [CVADHELP-19812]

+ You might get an error when you try to uninstall Citrix Workspace app. [CVADHELP-19121]

+ In optimized Microsoft Teams, the video function might not work if you start another virtual
desktop or app session. [HDX-40451]

+ While sharing the screen or an app during the Microsoft Teams call, your peers might see visual
artifacts. Thisissue occurs due to unstable frame rates, such as incorrect video playback (frozen
or transient black frames). This release includes improved frame rates or sampling rates that
help to reduce visual artifacts. [HDX-38032]
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Known issues
Known issues in 2411

You might encounter the Citrix Workspace app for Mac stops responding on the loading, authentica-
tion screen or closing unexpectedly after an admin updates the Workspace configuration (such as
Identity Provider or Device Posture) in the Citrix Cloud Console. [RFMAC-17028]

To resolve the issue, users can reconfigure the store by following one of these methods:

Remove and re-add the store:

1. Open the Workspace app.

2. Navigate to Preferences > Accounts.
3. Select the store and click Remove.
4. Add the store again.

Reset Citrix Workspace app(for versions 2409 or later):

1. Open the Workspace app.

2. Gotothe Help menu.

3. Click Reset Citrix Workspace.
4. Add the store again.

Note:

Resetting Citrix Workspace app removes all configured stores.

Known issues in 2409.10

There are no new known issues.

Known issues in 2409

There are no new known issues.

Known issues in 2405

+ You might have noticed that the newly added apps are not visible to the end user on the auto-
matic refresh of Citrix Workspace app. As a workaround, refresh Citrix Workspace app to view
the newly added apps. [CVADHELP-25189]

+ When you open the Citrix Workspace app for Mac through the custom web portal, you might
notice that the links on the landing page direct you to blank pages. As a workaround, refresh
the page to load the content. [CVADHELP-25665]
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Known issues in 2311

» The HTML5 Video redirection feature is disabled by default in Citrix Workspace app for Mac from
version 2311. [HDX-53015]

Known issues in 2402.10

« If the Force Ephemeral Profiles setting is enabled through the Global App Configuration service
for Citrix Enterprise Browser, and the user closes the browser window(s) without quitting the
browser, it goes into a state where creating new tabs and typing into the omnibox might not
function as expected. As a workaround, the user should quit the browser completely and then
reopen it. [CTXBR-8738]

Known issues in 2402

+ You might notice that the application screen is hidden at the notch when you enter full screen
in the virtual sessions for some Macs. As a workaround, adjust the app window to make it fit
below the screen notch. [HDX-63035]

Known issues in 2308

« After upgrading Citrix Workspace app for Mac to version 2308, the preferences window might be
unresponsive for any user actions. As a workaround, force quit Citrix Workspace app and restart
it. For more information about forcing an app to close on a Mac, see Force an app to close in the
Apple support article. [RFMAC-14596]

Known issue in 2307

No new issues have been observed in this release.

Known issue in 2306

No new issues have been observed in this release.

Known issues in 2305

« After upgrading Citrix Workspace app for Mac to version 2305, certain third-party virtual apps
that have pop-up dialogs for entering user name and password might become unresponsive
upon opening. [CVADHELP-23032]
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Known issues in 2304

« Auserwith multiple accounts might see the Citrix Workspace app loading screen for a long time.
As a workaround, you must quit Citrix Workspace app and restart it. [RFMAC-13432]

Known issues in 2301.1

+ You can’t update to Citrix Workspace app for Mac version 2301.1 using the auto-update service.
As a workaround, you must manually install the Citrix Workspace app for Mac version 2301.1 by
downloading the .dmg file available on the Downloads page.

Known issues in 2301

+ On macOS Ventura devices, progressive web apps (PWA) fail to open. The following error mes-
sage appears:

App Name is damaged and can’t be opened. You should move it to the Bin.

As a workaround, right-click on the app and select Open. If you’re using the keyboard, press the
Ctrl key and click the app. Select Open. [CTXBR-3885]

+ Aninfinite loading spinner might appear when users sign in to Citrix Workspace associated with
Global App Configuration service. This issue doesn’t impact StoreFront and custom web stores.
[RFMAC-13086]

Known issue in 2211.1

No new issues have been observed in this release.

Known issuesin 2211

« When using Citrix Workspace app for Mac 2209 and later versions, the user sign-in page might
not be displayed while using the custom web portal. As a workaround, quit Citrix Workspace
app by using the Quit option from Citrix Workspace icon in the menu bar. [CVADHELP-21377]

Known issues in 2210

« OnmacOS 13 Ventura, the seamless app interaction might run into issues when you change the
All at Once default option to the One at a Time option in the Stage Manager preference under
the Stage Manager feature. [HDX-44567]
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Attempts to start a desktop session in offline mode might fail. As a workaround, resize the ses-
sion window. [HDX-45081]

+ When resizing a session to full-screen mode on a MacBook, the focal point of a cursor might
appear slightly above the actual cursor position. As a workaround, navigate to System Prefer-
ences > Dock & Menu Bar and enable the Automatically hide and show the menu bar in full
screen option. [HDX-45585]

« With the 2210 version, using Mission Control or App Expose features in an app session might
cause Citrix Workspace app to close unexpectedly. [HDX-46130]

+ When launching certain third-party apps such as Epic or Kronos, the sign-in window of the apps
might covered by another window. As a result, the entire session freezes. As a workaround,
perform one of the following actions:

- Dragthe window that is blocking the sign-in window away from it.
- Locate the sign-in window using the Mission Control feature.
- Use the keyboard shortcut Command+~ to switch windows.

[HDX-46140]

Known issues in 2209

No new issues have been observed in this release.

Known issue in 2208.1

No new issues have been observed in this release.

Known issue in 2206.1

No new issues have been observed in this release.

Known issue in 2204

+ When traffic is tunneled through NGS, Citrix Workspace app might fail to upload or download
files that are greater than 64 MB. [CTXBR-3354]

Known issues in 2203.1

« You can’t click the Create button in the Jira app if the browser window is minimized. [CTXBR-
1976]
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Web socket connections aren’t tunneled through Citrix Secure Private Access. [CTXBR-2439]

« After upgrading the Citrix Workspace app to version 2203, a question mark icon appears on the
Citrix Enterprise Browser icon. This issue occurs if the Citrix Enterprise Browser was pinned to
the dock before the upgrade. [CTXBR-2864]

« When you click the Reset settings option on the Advanced settings section of the Citrix En-
terprise Browser, the log settings do not reset to default. As a workaround, click the Reset to
default log settings option available on the Logs page. [CTXBR-2929]

« After upgrading Citrix Enterprise Browser from version 2201 to version 2203, you are unable to
save new passwords and already saved passwords are lost. [CTXBR-3063]

« Full screen mode isn’t available on Macs with a notch. [CVADHELP-19337]

« When you launch a desktop or app session using the browser, the session window launches in
the background, behind the browser window. [RFMAC-11362]

Known issues in 2201

« The client name appears with random characters in the Citrix Broker Service and the Citrix Di-
rector if you’re using the Citrix Workspace app in the offline (intranet) mode. [RFMAC-10842]

Known issues in 2112
+ In Citrix Workspace app, you might experience intermittent failures when answering or making

a Microsoft Teams call. The following error message appears:
“Call could not be established.”[HDX-38819]

Known issuesin 2111

No new issues have been observed in this release.

Known issues in 2109.1

No new issues have been observed in this release.

Known issues in 2109

« If you’ve configured the Citrix Workspace app using the . cr file, and signed in with your cre-
dentials, the home page appears after a delay. [RFMAC-9990]
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« IfaProgressive Web App (PWA) thatis protected is opened on macOS, the App Protection policies
aren’t enforced. [RFMAC-10128]

« After you add stores in the Citrix Workspace app and change the Current Reauthentication Pe-
riod in Reauthentication Period for Workspace App and switch from on-premises to the cloud
store after a few minutes, you’re signed out of the cloud store and an authentication prompt ap-
pears. Once you sign in to the Citrix Workspace app, the spinner appears indefinitely and you’
re unable to sign in. [RFMAC-10140]

Known issues in 2108.1

No new issues have been observed in this release.

Known issues in 2108

« When you start a subscribed Saa$S app after changing the authentication domain in the server
console, the session does not start and the following error message appears:

“AuthDomain has changed. Please sign in again after some time”
[RFMAC-9616]

Known issues in 2107

+ Whenyou change the authentication domain in the server console and sign in with your creden-
tials, the following error message appears:

Cannot connect to the server
You can access the store once you click OK.
[RFMAC-9494]

Known issues in 2106

+ Ablack window appears when you share your screen. [HDX-30083]

Known issues in 2104

No new issues have been observed in this release.
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Known issues in 2102

No new issues have been observed in this release.

Known issues in 2101

+ Attempts to access files under Network Shares from within Citrix Workspace app for Mac might
fail even when the option is enabled. [RFMAC-7272]

+ On macOS Big Sur, attempts to launch the web SAML single sign-on app on Citrix Workspace
app for Mac might fail, displaying the following error message.

Page could not load. Please try again later or contact your
administrator for assistance. Incident ID:-202

[RFMAC-7282]
Known issues in 2012

+ Whenyou start a video call, Microsoft Teams might become unresponsive, displayinga Citrix
HDX not connected error. As a workaround, restart Microsoft Teams or the VDA. [RFMAC-
6727]
+ Video calls on Microsoft Skype for Business aren’t supported on macOS Big Sur (11.0.1).
« On macOS Big Sur (11.0.1), attempts to connect USB devices might fail, causing the session to
exit unexpectedly. As a workaround, reconnect the USB device. [RFMAC-7079]

Deprecation

For information about deprecated items, see the Deprecation page.

Legacy documentation

For product releases that have reached End of Life (EOL), see Legacy documentation.

Third-party notices

Citrix Workspace app might include third-party software licensed under the terms defined in the fol-
lowing document:

Citrix Workspace app for Mac Third-Party Notices
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Features in Technical Preview

February 24,2025

Features in Technical Preview are available to use in non-production or limited production environ-
ments, and to give customers an opportunity to share feedback. Citrix does not accept support cases
for features in technical preview but welcomes feedback for improving them. Citrix might act on feed-
back based on its severity, criticality, and importance.

List of features in Technical Preview

The following table lists the features in technical preview. These features are request-only preview
features. To enable and provide feedback for any of these features, fill out the respective forms.

Enablement form Feedback form (Click
Title Available from version  (Click the icon) theicon)
Enhanced display 2411

control with
Multi-Monitor selector

[
[

USB Redirection of 2411
mass storage devices

)
)

HDX Direct for 2411
non-shield scenario

(0
(0

Enable Audio Quality 2411
Enhancer to improve
audio performance

(0
(0

Support for multiple 2409
webcam resolutions

[
[

Support for Mac 2405
VoiceOver on the

virtual desktop and

seamless app sessions
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Enablement form Feedback form (Click
Title Available from version  (Click the icon) theicon)

Support for HTML 2405

format on the Citrix

Workspace app for Mac
clipboard

()
()

Support for sharing 2405
system audio on
Microsoft teams

()
()

Support for YUV444 2405
color format

[
[

Support for single 2402
sign-on to Citrix

Secure Access

automatically through

Citrix Workspace app
Enhanced Desktop 2402

Viewer toolbar

[
[

Customize the Desktop 2402
Viewer toolbar

()
()

Sustainability initiative 2402
from Citrix Workspace

app
Support for Citrix 2309

Secure Private Access
for on-premises
deployments

[
[

Enhanced the High DPI 2308

option
Store-based 2308

configuration of file
access
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Enablement form Feedback form (Click
Title Available from version  (Click the icon) theicon)

Keyboard accessibility 2307

support for the toolbar
on the Virtual Desktop

Note:

« Technical previews are available for customers to test in their non-production or limited
production environments, and to give customers an opportunity to share feedback. Citrix
does not accept support cases for feature previews but welcomes feedback for improving
them. Citrix might or might not act on feedback based on its severity, criticality, and impor-
tance. Itis advised that Beta builds aren’t deployed in production environments.

+ You can provide feedback for this feature using this Feedback Form.

Enhanced display control with Multi-Monitor selector

Technical Preview from 2411 Enablement form Feedback form
version

Starting with version 2411, the Multi-Monitor Selector (MMS) allows users to choose which displays to
use in full-screen mode for desktop sessions only, not for seamless sessions. A new Multi-Monitor
button has been added to the toolbar, which appears only when more than one screen is connected.
This feature enhances the flexibility and usability of multi-monitor setups in desktop sessions, provid-
ing a more tailored and efficient user experience.

¥ B ~ mE  — v X
Multi-

Pin toolbar Ctrl+Alt+Del Shortcuts Devices Preferences :
Monitor

Minimize Fullscreen Disconnect

Extend to all displays

Custom Layout

e Fullscreen

Prerequisites:

If the new toolbar is OFF, the Multi-Monitor Selector feature is also turned OFF.

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 106


https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/whats-new/features-in-technical-preview.html#keyboard-accessibility-support-for-the-toolbar-on-the-virtual-desktop
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/whats-new/features-in-technical-preview.html#keyboard-accessibility-support-for-the-toolbar-on-the-virtual-desktop
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/whats-new/features-in-technical-preview.html#keyboard-accessibility-support-for-the-toolbar-on-the-virtual-desktop
https://docs.google.com/forms/d/e/1FAIpQLSfbAFGHrbAm0YQFS79McMBdQ_Fg7oj3x_v3oZjqXkf7JqfdOw/viewform?usp=sf_link
https://docs.google.com/forms/d/13nowpAah102EF3xhjMd80E2v-RZwBPp5bTRJU-uKs3s/edit
https://forms.gle/gD5aoX9LKohhFn4D6
https://docs.google.com/forms/d/e/1FAIpQLSfbAFGHrbAm0YQFS79McMBdQ_Fg7oj3x_v3oZjqXkf7JqfdOw/viewform?usp=sf_link
https://docs.google.com/forms/d/13nowpAah102EF3xhjMd80E2v-RZwBPp5bTRJU-uKs3s/edit

Citrix Workspace app for Mac

To manage the Multi-Monitor selector feature, use the following commands:

Action Command

Enable the feature defaults write com.citrix.
receiver.nomas
EnableNewCustomMonitorSelector
YES

Disable the feature defaults delete com.citrix.
receiver.nomas

EnableNewCustomMonitorSelector

The toolbar button includes three drop-down menu options for desktop sessions in full-screen
mode:

« Extend to All Displays: The session switches to full-screen mode on all connected screens. The
previous checkbox Use All Displays In Fullscreen mode in the menu bar is removed if this fea-
ture is enabled.

@ Citrix Viewer View Devices

N EON ) Enter Full Screen

. v Use All Displays In Full Screen |
v @uo | &4 i __

+ Custom Layout: This option opens a custom monitor selector displaying the layout of the ma-

cOS system. Users can click the rectangles in the selector to choose which screens to use and
then click Apply. The session then uses the selected screens in full-screen mode.
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a3 & -

Carle A+ Dol Shorteuti

Custom layout

Configure how your session is displayed across multiple displays. Choose

one or more displays to extend you

+ Fullscreen: The session switches to full-screen mode on the current single display where the
toolbar is located or where the button is clicked.
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External display detected

Would you like to go full screen on all displays or setup a custom layout for
this Desktop?

B Femember my preference

Extend to all dieplays R ) it )

When a new monitor is plugged in, a notification appears for the user to make a selection. Users can
check Remember my preference to mute this notification.

USB Redirection of mass storage devices

Technical Preview from 2411 Enablement form Feedback form
version

Starting with version 2411, USB redirection enables you to access USB mass storage devices con-
nected to a local computer from your virtual apps and desktops, allowing you to use USB drives seam-
lessly within virtual sessions. This feature is enabled by default.

Note:

The system triggers a Disk Not Ejected Properly message for users. Thisis a controlled behavior,
designed to gain control of the device when existing drivers do not respond to seize requests.

Prerequisites:

+ USB mass storage devices must be connected to the local device.
« The USB redirection policy must be enable in store.

Limitations:

Users cannot redirect two USB mass storage devices that share the same Product ID and Vendor ID
simultaneously.
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HDX Direct for non-shield scenario

Technical Preview from 2411 Enablement form Feedback form
version

Starting with version 2411, HDX Direct allows direct connections from external client devices to Virtual
Delivery Agent (VDA), bypassing the Citrix Gateway service. This feature improves performance and
reduces latency for both internal and external users through a direct path to the session host, resulting
in fewer network hops and improved in-session performance. Also, the decreased load on the Citrix
Gateway service enhances the overall system efficiency.

Prerequisites:

« Access to the internal network or configuration for direct connections.

« Network infrastructure that supports direct VDA connections.

+ Configuration of Session Traversal Utilities for NAT (STUN) and Traversal Using Relay around
NAT (TURN) servers.

To manage the HDX Direct feature, use the following commands:

Action Command

Enable the feature defaults write com.citrix.
receiver.nomas EnableHDXDirectV2
YES

Disable the feature defaults delete com.citrix.
receiver.nomas EnableHDXDirectV2

Limitation:
Requires ownership of STUN and TURN servers.

For more information, see HDX Direct.

Enable Audio Quality Enhancer to improve audio performance

Technical Preview from 2411 Enablement form Feedback form
version

Starting with the 2411 version, Audio Quality Enhancer (v2) is added for Adaptive Audio.
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Audio Quality Enhancer effectively manages short periods of packet loss and disruptions by intelli-

gently reconstructing audio from previous samples, thus preventing noticeable degradation in qual-

ity. Furthermore, it intelligently and adaptively recovers lost audio packets, if and only when needed.

It enables and disables itself adaptively when packet loss increases and decreases for a sustained pe-

riod. Audio Quality Enhancer optimizes audio playback and recording quality in both good and bad

network conditions.

To enable Audio Quality Enhancer, complete the following steps on the client:

1. Enable Adaptive Audio.

2. Enable Loss Tolerant Mode for Audio.

3.

Enable the feature:

« defaults write com.citrix.receiver.nomas PacketLossConcealmentEnabled
-bool YES
o« defaults write com.citrix.receiver.nomas EnableNetStat -bool
YES

Enable Audio Quality Enhancer on the Virtual Delivery Agent as well, which is required to fully
enable the feature. That is, Audio Quality Enhancer needs to be enabled on both the Virtual
Delivery Agent and Citrix Workspace app sides to function end-to-end for audio playback and
recording.

To disable Audio Quality Enhancer, complete the following steps on the client:

1. Disable the feature:

« defaults write com.citrix.receiver.nomas PacketLossConcealmentEnabled
-bool NO

« defaults write com.citrix.receiver.nomas EnableNetStat -bool
NO

2. Disable Audio Quality Enhancer on the Virtual Delivery Agent as well, which is required to fully

disable the feature.

Support for multiple webcam resolutions

Technical Preview from 2409 Enablement form Feedback form

version

Previously, only the VGA resolution (640 x 480 pixels) was supported for webcam redirection. Start-

ing with the 2409 version, high-definition webcam streaming supports all webcam resolutions up to
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720p are available on the client side. If media type negotiation fails, HDX now defaults back to VGA
resolution. For more information, see High-definition webcam streaming.

Support for Mac VoiceOver on the virtual desktop and seamless app sessions

Technical Preview from 2405 Enablement form Feedback form
version

Starting with the 2405 version, Citrix Workspace app for Mac supports the Mac VoiceOver feature
within a virtual desktop and seamless app sessions. This feature allows users to receive verbal de-
scriptions of Ul elements and content within the sessions. These features enhance accessibility and
ensure compliance with WCAG requirements.

Support for HTML format on the Citrix Workspace app for Mac clipboard

Technical Preview from 2405 Enablement form Feedback form
version

Starting with version 2405, Citrix Workspace app for Mac supports the seamless copying and pasting
of HTML-formatted text between a Mac local app and a virtual app or desktop session running through
Citrix Workspace app for Mac. Whether you’re working locally or in a virtual session, this functionality
ensures that HTML contentis accurately retained during the copy-and-paste process. With this feature,
you can copy and paste large HTML text between local and virtual sessions without any restrictions.

This feature is disabled by default in the clipboard redirection policy.

To enable the HTML format for clipboard, you need to add an entry for CF_HTML (and any other in
“Client clipboard write allowed formats”and “Session clipboard write allowed formats™) in the ICA
policy settings. For more information, see Client clipboard redirection.

Note:

« Client clipboard write allowed formats does not apply if the Client clipboard redirection
policy is set to Prohibited or Restrict client clipboard write policy is disabled.

« Session clipboard write allowed formats does not apply if the Client clipboard redirection
policy is set to Prohibited or Restrict session clipboard write policy is disabled.
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Support for sharing system audio on Microsoft teams

Technical Preview from 2405 Enablement form Feedback form
version

Starting with the 2405 version, Citrix Workspace app for Mac supports sharing the system audio during
the Microsoft Teams meeting. With this feature, you can now share the audio playing on your VDA with
the participantsin a meeting. Select the Include computer sound option to allow sharing the system
audio to the meeting.

¢ © B8 - | & ¢ @

Chat Raise React View More Camera Mic Share

Share content Include computer sound

Presenter mode

Ce @3 P Add background

Limitations This feature is supported only on published desktops.

Support for YUV444 color format

Technical Preview from 2405 Enablement form Feedback form
version

Starting with the 2405 version, Citrix Workspace app for Mac introduces support for the YUV444 color
format. YUV444 is a color format that provides better color accuracy and image clarity compared to
the default YUV420 format. It ensures more vibrant and accurate colors, especially when working with
multimedia content. This enhancement improves video playback quality and image fidelity.

Support YUV444 (hardware)

Mac CPU type Video codec decode
Intel H.264 No
Intel H.265 Yes
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Support YUV444 (hardware)

Mac CPU type Video codec decode

AppleSilicon H.264 Yes

AppleSilicon H.265 Yes
Note:

« Macs with Apple silicon support YUV444 using both H.264 and H.265 with hardware accel-

eration.
+ Macs with Intel architecture do not support H.264 YUV444 decoding with hardware acceler-

ation. In this case, Citrix Workspace app fall back to the supported color format automati-

cally.

Enabling YUV444 For full-screen H.264:

To enable YUV444 for full-screen H.264 video, configure the following policies on the Delivery Con-
troller (DDC):

« Visual Quality: Always lossless / Build to lossless
« Allow visually lossless compression: Enabled
+ Additional Requirements for full-screen H.265:

If you’re using full-screen H.265 video with YUV444, ensure the following:

« Citrix Virtual Apps and Desktops version 2209 or newer
+ Graphics hardware that meets the requirements:

+ NVIDIA Pascal GPU or newer

+ Intel 6th generation GPU or later

« AMD Generation GCN3 or later

Recommended Policies

« Use video codec: “Use when Preferred”or “For the Entire Screen”
« Optimize for 3D Graphics: Enabled
» Hardware Encoding: Enabled

Support for single sign-on to Citrix Secure Access automatically through Citrix Workspace app
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Technical Preview from 2402 Enablement form Feedback form
version

Citrix Workspace app for Mac now automatically supports single sign-on (SSO) to Citrix Secure Access
once your login to Citrix Workspace app. If you have both the Citrix Secure Access agent and the Cit-
rix Workspace app installed on your device, this feature allows you to automatically sign in to Citrix
Secure Access through SSO when you login to Citrix Workspace app. For more information, see Au-
tomatic single sign-on (SSO) to Citrix Secure Access through Citrix Workspace app - Preview in the
NetScaler documentation.

To enable this feature through MDM, the administrator must use the following settings:
<key>EnableSecureAccessAutoLogin</key><true/>

Note:

» You need to use Citrix Secure Access version 24.03.1 or later to enable this feature.
« This feature is supported only on cloud stores and not for on-premises stores.

Enhanced Desktop Viewer toolbar

Technical Preview from 2402 Enablement form Feedback form
version

Starting with the 2402 version, the virtual desktop viewer toolbar is enhanced to be more intuitive,

modern, and user-friendly.

g % v zz ><

Hide toolbar Shortcuts Preferences Minimize Fullscreen Disconnect

The new toolbar provides the following options:

« Show or hide toolbar - Click this button to show or hide the Desktop Viewer toolbar. A notch
appears when the toolbar is hidden. Click on the notch to expand the toolbar, and then you can
click to pin the toolbar.

« Shortcuts - Click this button to access the shortcuts.

« Devices - Click this button to access the options in the Devices section.

+ Preferences - Click this button to access the options in the Preferences section.

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 115


https://docs.google.com/forms/d/e/1FAIpQLSfbAFGHrbAm0YQFS79McMBdQ_Fg7oj3x_v3oZjqXkf7JqfdOw/viewform?usp=sf_link
https://docs.google.com/forms/d/13nowpAah102EF3xhjMd80E2v-RZwBPp5bTRJU-uKs3s/edit
https://docs.netscaler.com/en-us/netscaler-gateway/citrix-gateway-clients/integration-with-citrix-workspace-app
https://docs.netscaler.com/en-us/netscaler-gateway/citrix-gateway-clients/integration-with-citrix-workspace-app
https://docs.google.com/forms/d/e/1FAIpQLSfbAFGHrbAm0YQFS79McMBdQ_Fg7oj3x_v3oZjqXkf7JqfdOw/viewform?usp=sf_link
https://docs.google.com/forms/d/13nowpAah102EF3xhjMd80E2v-RZwBPp5bTRJU-uKs3s/edit

Citrix Workspace app for Mac

+ Minimize - Click this button to minimize the virtual session. This option is hidden in the full-
screen mode.

+ Fullscreen - Click this button to access the virtual session in full screen.

+ Restore —Click this button to restore the virtual session from the full-screen mode.

+ Disconnect - Click this button to sign out or to disconnect from a virtual session.

You can drag the toolbar or notch across all screens in the virtual session. When you drag the toolbar
or notch, it can rotate automatically based on its placement on the screen. Once you release the drag,
it gets positioned to the nearest edge of the screen.

Customize the Desktop Viewer toolbar

Technical Preview from 2402 Enablement form Feedback form
version

Previously, you can completely disable the Desktop Viewer toolbar. However, you can’t enable or
disable a few options on the toolbar. With this release, you can customize the Citrix Workspace app
for Mac toolbar by adding and removing options on the toolbar. For more information, see Hide or
show the desktop tool bar in the virtual desktop session.

You can configure the toolbar through the Mobile Device Management (MDM) settings. The following

settings can hide the Device, Preferences, Minimize, and Full screen button:

<key>HiddenToolbarButtons</key>

<array>
<string>device</string>
<string>preferences</string>
<string>minimize</string>
<string>fullscreen</string>

</array>

Note:

You cannot hide the Pin button from the toolbar.

Enable Packet Loss Concealment to improve audio performance

Technical Preview from 2402 Enablement form Feedback form
version

Starting with the 2402 version, the jitter buffer mechanism is improved, and the Packet Loss Conceal-
ment (PLC) is added for the Adaptive audio codec. PLC helps to reconstruct the lost data packets. This
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enhancement helps to improve the packet loss tolerance and jitter tolerance and thus improves audio
performance for loss tolerant mode (EDT lossy) for audio.

To enable this feature, you also need to enable the Loss tolerant mode for the audio feature.

Sustainability initiative from Citrix Workspace app

Technical Preview from 2402 Enablement form Feedback form

version

Starting with the 2402 version, Citrix Workspace app for Mac supports the Sign out option for the
virtual desktop session. This feature might help conserve energy if you sign out from virtual machines

when not in use.

When the user clicks Disconnect or Log out, or closes a virtual desktop, then the following prompt is
displayed, recommending the user to use the Log out option to save energy.

To enable this feature on Terminal Server Virtual Delivery Agent (TSVDA), follow these steps:

Navigate to Citrix Studio.

Click Delivery Groups in the left navigation pane.

Select the required VDA from the Delivery Group section.

Click the Edit icon to open the Edit Delivery Group page.

Click Desktops from the left navigation pane.

Choose the VDA where the keyword must be added and click Edit.

In the Edit Desktop page, setthe ICA-LogOffOnClose keyword to true in the Description
field.

8. Click OK to save the changes.

No ok w R

To enable this feature on Windows Desktop Virtual Delivery Agent (WVDA), follow these steps:

Navigate to Citrix Studio.

Click Delivery Groups in the left navigation pane.

Select the required VDA from the Delivery Group section.

Click the Edit icon to open the Edit Delivery Group page.

Click User Settings from the left navigation pane.

Setthe ICA-LogOffOnClose keyword to true in the Description field.
Click OK to save the changes.

Nk~ e

The following dialog box appears when you close the virtual desktop.
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2 Log out or disconnect? X

Logging out consumes less energy, but any unsaved changes will be lost.
Save your work before logging out.

Customizing the text in the Save Energy screen To use the sustainability feature with a custom
message, modify the Delivery Group on the DDC with the following configuration example:

Follow the steps in the preceding section.

Setthe ICA-PromptMessage keyword to the required text in the Description field.
Set the ICA-T1tle keyword to the required text in the Description field.

Set the ICA-Icon keyword to true or false.

Click OK.

ok wph

Default behavior:

+ ICA-LogOffOnClose: Defaultis false, showing the standard disconnect experience.

+ ICA-Title: Defaultis Log out or disconnect?.

« ICA-PromptMessage: Default is Logging out consumes less energy, but
any unsaved changes will be lost. Save your work before logging
out.

« ICA-Icon: Defaultis true, displaying the green leaf icon when sustainability is enabled.

Customization rules:

+ Default Behavior with ICA-Log0ffOnClose=true: If no additional keywords are speci-
fied, the sustainability feature is enabled with the default title, body text, and green leaf icon.

« Customization with Keywords: When ICA-LogOffOnClose=true and specific keywords
are provided, the sustainability feature is enabled with the specified customizations:

- ICA-PromptMessage: Custom body text (limited to 200 characters).
- ICA-Title: Custom title (limited to 30 characters).
- ICA-Icon=false: Hides the green leaf icon.
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Example - Custom configuration:

ICA-LogOffOnClose=true

ICA-PromptMessage="This is a sample custom message.’
ICA-Title="Custom Logout"

ICA-Icon=false

The custom message and title is displayed, and the green leaf icon is hidden.

Support for Citrix Secure Private Access for on-premises deployments

Technical Preview from 2309 Enablement form Feedback form
version

Starting with the 2309 version, Citrix Workspace app for Mac supports Citrix Secure Private Access for
on-premises deployments. For more information, see Secure Private Access for on-premises - Pre-

view.

Enhanced the High DPI option

Technical Preview from 2308 Enablement form Feedback form

version

Previously, Citrix Workspace app supported the High DPI option for virtual desktop sessions only.

Starting with the 2308 release, enabling the High DPI option can also support for seamless app ses-
sions. Also, you can now enable the High DPl option on three 4k monitors. These features are disabled
by default.

To enable the High DPI option, you must select Preferences > General. On the General tab, select
Enable and match the client DPI scale settings. Restart the application for the changes to take
effect.

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 119


https://docs.google.com/forms/d/e/1FAIpQLSfbAFGHrbAm0YQFS79McMBdQ_Fg7oj3x_v3oZjqXkf7JqfdOw/viewform?usp=sf_link
https://docs.google.com/forms/d/13nowpAah102EF3xhjMd80E2v-RZwBPp5bTRJU-uKs3s/edit
https://docs.citrix.com/en-us/citrix-secure-private-access/service/get-started-with-citrix-secure-private-access
https://docs.citrix.com/en-us/citrix-secure-private-access/service/get-started-with-citrix-secure-private-access
https://docs.google.com/forms/d/e/1FAIpQLSfbAFGHrbAm0YQFS79McMBdQ_Fg7oj3x_v3oZjqXkf7JqfdOw/viewform?usp=sf_link
https://docs.google.com/forms/d/13nowpAah102EF3xhjMd80E2v-RZwBPp5bTRJU-uKs3s/edit

Citrix Workspace app for Mac

. »

o General == 1
General Accounts File Access Devices

App access across devices: Reconnect apps when | sign in to Workspace

Reconnect apps when | start or refresh apps

Menu bar: Show Workspace in menu bar

Auto Start: Start Workspace on system startup

High DPI: Enable and match client DPI scale settings

Changes will take effect once you reconnect to this application.

Passwords: Delete Passwords...

File download location:

Support for Activity Manager on cloud stores

Technical Preview from 2308 Enablement form Feedback form
version

Citrix Workspace app for Mac supports the Activity Manager feature. This feature lets end users view
and interact with all their active apps and desktop sessions at one place. You can disconnect or ter-
minate the active sessions directly from the Activity Manager.

To view active sessions in the Activity Manager, select the Citrix Workspace app icon from the menu
bar and then click Activity Manager. To disconnect active desktop sessions, select the respective
ellipsis (...) menu and click Disconnect. Click the “X”button to terminate the active app session. For
more information, see Activity manager.
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Store-based configuration of file access

Technical Preview from 2308 Enablement form Feedback form
version

Starting with the 2308 release, the per-store file access is included as part of the client-selective trust
feature. This enhancement allows you to provide access to files on a per store basis.

To enable file access for a store, you must select Preferences > File Access. On the File Access tab,
select the store and the type of access required for that store. You can choose any of the following
types of access for files and drives on your computer:

« Read and write: Provides read and write access to files and drives for the selected store.

« Read only: Provides read only access to files and drives for the selected store.

+ No access: Restrict access to files and drives for the selected store.

» Ask me each time: Request permission to access files and drives each time when read or write
access is required for the selected store.
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File Access . % D ) E

General Accounts D

Choose how to access files and drives on your computer for a particular store:

(Primary) Store
Read and write

® Read only
No access

Store 1
Store 2

| .g. net:44 .
global.g.nssvc.net:443 Ask me each time

Keyboard accessibility support for the toolbar on the Virtual Desktop

Technical Preview from 2307 Enablement form Feedback form
version

With the 2307 release, you can use the keyboard shortcut to access the Virtual Desktop Infrastructure
(VDI) toolbar. From the Citrix Viewer, go to View in the menu bar and select Use Toolbar shortcut to
use the keyboard shortcut. By default, the Use Toolbar shortcut option is enabled.

You can use the following keyboard shortcuts to access the VDI toolbar using the keyboard:

+ Shift + Command + T: To activate the VDI toolbar.

+ Tab: To navigate across the VDI Toolbar in the clockwise direction.

+ Shift + Tab: To navigate across the VDI toolbar in the anti-clockwise direction.
« Space: To select an option on the VDI Toolbar.

« Escape: To close a modal in focus.

The toolbar and CWA preference window now support Keyboard navigation, which helps to navigate
between the Ul elements and highlights the element that is in focus.
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Single sign-on to Citrix Secure Access using Citrix Workspace app

You can single sign-on to Citrix Secure Access if you have already signed in to Citrix Workspace app.
When you sign in to Citrix Workspace app and open Citrix Secure Access, you are not asked to authen-
ticate by entering the credentials. It automatically proceeds with the authentication. This feature
provides users with a seamless experience by allowing single sign-on to different Citrix applications.
This feature is available only for customers on cloud stores. Along with the latest version of Citrix Work-
space app, you must have a compatible version of Citrix Secure Access (22.12.2 and later versions).
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Technical Preview to General Availability (GA)

Service or feature General availability version
Support for browser content redirection 2411.10
HDX Direct 2411

Support for Plug and play webcam redirection 2411

Client App Management 2409
Support for Rapid Scan client drive mapping 2409
Enhanced Desktop Viewer toolbar 2409
Enhancements to the smart card reader 2409

authentication
Support for managing composite USB device 2409
redirection using DDC policies

Connection strength indicator 2409

Support for Activity Manager on the quick access 2405
menu for cloud stores

Support for extending the desktop session to 2405
external monitors automatically

Enable Packet Loss Concealment to improve 2405
audio performance

Upgraded HDX Reducer to Version 4 2402
Loss tolerant mode for audio 2402
Support for Audio volume synchronization 2402
Support for background blur for webcam 2402

Support for screen sharing when App protection 2402

is enabled
Support for authentication using FIDO2 when 2311

connecting to on-premises store

Enhanced virtual apps and desktops launch 2311
experience for Workspace (Cloud users only)

Improved graphics performance 2308
Increase in the number of supported virtual 2308
channels

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 124



Citrix Workspace app for Mac

Citrix Workspace app for Mac 2503 - Preview

March 7, 2025
You can download Citrix Workspace app for Mac 2503 preview version from the Downloads page.
For information on installation, see Install page.

Note:

Thisisan Early Access Build shared for the purpose of testing or validation with the intent to make
organizations ready for the upcoming release and is NOT advised to be deployed in production
environments.

You can give the EAR feedback using the Early Access Release Feedback form.

What’s new

+ Support for automatic installation of deviceTRUST plug-in with Citrix Workspace app
+ Quit background processes with Quick Access menu

+ Managing display of app shortcuts on Mac Launchpad

« Enhanced desktop launch experience

« Enhanced structure for Help menu

+ Hybrid launch support for GACS

« Improved session timeout experience

+ Enhanced keyboard settings for VDA OS and session type

+ Optimized graphics performance for Selective Thinwire

+ UCSDK devicelD enhancement

+ Clipboard support for copying files and folders

+ Enhanced Multi-Monitor Management for desktop sessions

+ Loss tolerant mode for graphics

« USB Redirection of mass storage devices

« HDX direct support

« Enable Audio Quality Enhancer to improve audio performance
+ Deprecation announcement of macOS Monterey 12

Support for automatic installation of deviceTRUST plug-in with Citrix Workspace app

Starting with version 2503, Citrix Workspace app for Mac includes deviceTRUST, enhancing security
through continuous device posture checks within the session. deviceTRUST is packaged with Citrix
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Workspace app for unified deployment, ensuring seamless integration and management. For more
information, see deviceTRUST.

Quit background processes with Quick Access menu

Starting with version 2503, Citrix Workspace app for Mac ensures that all background processes, in-
cluding the Citrix Workspace Helper, quit when user exits the main application through the Quick
Access menu. This enhancement addresses common concerns where certain apps, like Citrix Work-
space Helper, remained active after users closed the main workspace application. To provide a better
user experience, this functionality ensures that:

« When users select the Quit option from the Quick Access menu of the Citrix Workspace app, all
associated background processes are closed.

« If the Citrix Workspace app is exited through other methods, such as Command+Q or quitting
from the dock, the background processes remain running. This behavior ensures that necessary
background functionalities remain operational unless explicitly exited.

Managing display of app shortcuts on Mac Launchpad
Starting with version 2503, admins now have greater control over the visibility of favorite app short-
cuts on the Mac Launchpad.

Key enhancements:

« Admins can prevent subscribed applications from appearing on the Launchpad of Mac end
users.

+ Greater flexibility for admins to manage the visibility of app shortcuts on Mac devices.

You can configure this feature using Global App Configuration service (GACS) and Mobile Device Man-
agement (MDM):

Using MDM:
<key>AddShortcutsToLaunchPad</key>

Using GACS:

1. Navigate to Workspace Configuration > App Configuration > Configure in Citrix Cloud.
2. In Citrix Workspace app page, click App Experience > Desktop Shortcuts.
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3. Click Shortcuts In Startup Menu and select the Mac checkbox to enable the shortcut.

A -
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@ citrix Workspace App (@ Citrix Enterprise Browser

@ Viewconfigured changes | Clone Settings
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App Experience » Dosktop Shortcuts.
Updates and Plug-ins.
Add Shertcuts To Launchpad
* App Experience
Allws 3ars 10 530 shercut of the 890 10 the Favorites,

> Security snd Authentication
> Session Experience

Mac Enatled @ )

* HDX and

» Accessories

Reset all to defoult

Enhanced desktop launch experience

Starting with version 2503, Citrix Workspace app for Mac enhances the desktop launch experience by
removing the retry timeout setting and improving status messaging. This enhancementis enabled by
default.

This update ensures that:

+ Users no longer experience premature failures during the launch process, even if it takes a
longer time to complete.

+ Retry messages, such as Powering On and Waiting for registration, are now displayed, making
it more intuitive for end users to check the status of the Virtual Delivery Agent.

_ EDaaS-BLR3-W10-P

o
i Powering on...

Enhanced structure for Help menu

Starting with version 2503, Citrix Workspace app for Mac introduces a restructured Help menu to im-
prove usability. Troubleshooting options, such as Open Log Settings and Reset Citrix Workspace,
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have been moved to a dedicated Troubleshoot submenu. This change makes the Help menu cleaner
and easier for users to navigate.

® Citrix Workspace  Edit Window

Citrix Workspace Help

Troubleshooting Open Log Settings
Email Log Files
Reset Citrix Workspace
Send Feedback

Check For Updates

Hybrid launch support for GACS (Technical Preview)

Starting with version 2503, Citrix Workspace app for Mac supports Global App Configuration Service
(GACS) in Hybrid mode for both Cloud stores and StoreFront, using the Protocol Handler. Thisincludes
support for a single hybrid store, applying GACS app configuration policies to hybrid launches. Ad-
ministrators can configure GACS settings through stores added using the browser, streamlining the
management of client experiences.

If a user has a store added in both native and hybrid modes, native settings take precedence. In such
cases, the hybrid store does not fetch any GACS policies. The hybrid store fetches app configuration
policies only if the native settings are unavailable.

If an admin updates settings after they’ve been fetched, the new settings are not applied until 6 hours
have passed. After 6 hours, when the user launches a Citrix Virtual Apps and Desktops application, the
app fetches the updated settings and applies them.

For example:

If a user initially launches a session from the first store, the app fetches GACS policies for that store
and applies its settings. Later, if the user switches to another store and launches a session, the app
fetches and applies GACS policies for the newly used store.

At any given time, the most recently used store in a hybrid environment determines the settings being
applied.

Improved session timeout experience (Technical Preview)

Starting with version 2503, this initiative improves the end-user experience during session timeouts
caused by inactivity or network interruptions. The solution provides users with an option to reconnect
directly from the timeout screen, eliminating the need to relaunch sessions from the client Ul.

Prerequisites:
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« For hybrid launch, StoreFront requires version 2411 or higher.
« For Citrix Workspace app launch, the desktop must be added to favorites first.

Key features include:

+ Displaying specific reasons for session timeouts, such as Device went to sleep, or Network
disruption.

« Allowing seamless reconnection to the session, whether it’s a new or persisting session, based
on the administrator’s configuration.

+ Supporting scenarios where auto reconnect might fail, such as network switches (for example
Wi-Fi to LAN).

Your session was disconnected

Network issue detected. Reconnecting to your session. You can
reconnect your session from your browser or relaunch the
session again. Would you like to reconnect?

Reconnect from browser Cancel
¢

(- i

To enable this feature, use the following command:

defaults write com.citrix.receiver.nomas EnableReconnectionExperience
YES

Optimized graphics performance for selective Thinwire

Starting with version 2503, these enhancements optimize text display performance, providing a
smoother and more efficient user experience. Graphic performance improvements for Thinwire with
Selective H.264, or H.265, significantly reduce CPU and Graphics Processing Unit (GPU) usage in
scenarios such as rapidly scrolling through text scenes. Users also benefit from improved frame rates
and reduced memory usage. This feature is enabled by default.

Use the following command to disable the feature:

defaults write com.citrix.receiver.nomas EnableBitBltOptimization NO

Limitation:
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The performance enhancement only works when Selective Thinwire is used as the graphic profile.

UCSDK devicelD enhancement

The Unified Communications SDK (UCSDK) extends support to WebRTC-based applications, enabling
Contact Center and Unified Communications providers to optimize real-time voice and video calls in
Citrix Virtual Desktop Infrastructure (VDI) environments by offloading media processing to the user’s
device. This feature is enabled by default.

With this feature, you can:

+ Control calls using Web Human Interface Device (HID) support, allowing mute, unmute, hold,
and pickup directly from headsets, with real-time status updates in the application.

+ Enable screen recording beyond VDI by configuring policies to record endpoint screens, allow-
ing retrieval and playback of recorded sessions.

« Use UCSDK in browser applications to achieve full feature parity with desktop applications for
a seamless experience.

Audio and video device identification and grouping are enhanced, providing more precise control over
built-in and peripheral devices. UCSDK partners receive clear, user-friendly information about user
devices.

For more information, see Support for WebHID APl in UCSDK.

Clipboard support for copying files and folders

Starting with version 2503, this enhancement enables clipboard support for seamless copying of files
and folders between HDX sessions. Users can copy files and folders as permitted by their Citrix admin-
istrators, enhancing flexibility and productivity.

With this feature, you can do the following:

« Copy files and folders between the HDX sessions seamlessly.

+ Ensurefiles, folders, and content remain intact with no corruption during transfer.

+ Admins can define and enforce policies to regulate and secure copy-paste operations, tailoring
functionality to organizational needs.

This feature is enabled by default through the clipboard redirection policy, allowing seamless copy
and paste of files and folders. For more information, see Client clipboard redirection.
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Loss tolerant mode for graphics

Starting with Version 2503, this feature enables Citrix Workspace app for Mac to use the loss tolerant
mode for graphics in Citrix sessions, improving the video experience, particularly in poor network
conditions.

Loss Tolerant Mode for graphics improves performance by allowing Citrix applications to handle video
and graphics better, even when the network connection isn’t strong. For users who work remotely
or in areas with unreliable networks, this feature ensures that graphics-heavy applications remain
usable without major performance issues like lag or pixelation. This feature is enabled by default.

With this feature, you can do the following:

+ Access and use applications seamlessly, even in unstable network conditions, without major
interruptions.

+ Enjoy smoother visuals and quicker response times, leading to a more productive and less frus-
trating work environment.

« Work from anywhere without sacrificing application quality, regardless of network conditions.

Use the following command to disable the feature:

defaults write com.citrix.receiver.nomas EnableThinwireLossy NO

HDX direct support

Starting with version 2503, HDX Direct allows direct connections from external client devices to Virtual
Delivery Agent (VDA), bypassing the Citrix Gateway service. This feature improves performance and
reduces latency for both internal and external users through a direct path to the session host, resulting
in fewer network hops and improved in-session performance. Also, the decreased load on the Citrix
Gateway service enhances the overall system efficiency. This feature is enabled by default.

Prerequisites:

« Access to the internal network or configuration for direct connections.

« Network infrastructure that supports direct VDA connections.

«+ Configuration of Session Traversal Utilities for NAT (STUN) and Traversal Using Relay around
NAT (TURN) servers.

To disable the feature, use the following commands:

defaults write com.citrix.receiver.nomas EnableHDXDirectV2 NO
Limitation:

« Requires ownership of STUN and TURN servers.
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« This feature does not support service continuity. It only functions without service continuity.

For more information, see HDX Direct.

USB Redirection of mass storage devices

Starting with version 2503, USB redirection enables you to access USB mass storage devices con-
nected to a local computer from your virtual apps and desktops, allowing you to use USB drives seam-
lessly within virtual sessions. This feature is enabled by default.

Prerequisites:

+ USB mass storage devices must be connected to the local device.
« The USB redirection policy must be enable in store.

Note:

The system triggers a Disk Not Ejected Properly message for users. Thisis a controlled behavior,
designed to gain control of the device when existing drivers do not respond to seize requests.

Use the following command to disable the feature:

defaults write com.citrix.receiver.nomas EnableUSBMassStorage NO

Limitations:

Users cannot redirect two USB mass storage devices that share the same Product ID and Vendor ID
simultaneously.

Enhanced Multi-Monitor Management for desktop sessions

Starting with version 2503, the Multi-Monitor Selector (MMS) enables users to select which displays
to use in full-screen mode for desktop sessions exclusively, not for seamless sessions. A new Multi-
Monitor button appears in the toolbar only when multiple screens are connected, offering a more
customized and efficient user experience. This feature is enabled by default.

If the new toolbar is OFF, the Multi-Monitor Selector feature is also turned OFF.

The toolbar button includes three drop-down menu options for desktop sessions in full-screen

mode:

« Extend to All Displays: The session switches to full-screen mode on all connected screens.
The previous checkbox Use All Displays In Fullscreen Mode in the menu bar is removed if this
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feature is enabled.

74 50 & ~ P = all — v’ X

Pin toolbar Ctrl+Alt+Del Shortcuts Devices Preferences  Connection Minimize Fullscreen Disconnect

Extend to All Displays

Custom layout

, * Fullscreen

+ Custom Layout: This option opens a custom monitor selector displaying the layout of the ma-
cOS system. Users can click on the rectangles in the selector to choose which screens to use
and then click Apply. The session then uses the selected screens in full-screen mode.

+ Fullscreen: The session enters full screen following the legacy behavior, using screens that
intersect with the session window.

Custom layout

Configure h our

Use the following command to disable the feature:

defaults write com.citrix.receiver.nomas EnableNewCustomMonitorSelector
NO

When a new monitor is plugged in, a notification appears for the user to make a selection. Users can
check Remember my preference to mute this notification for the current session.

Enhanced keyboard settings for VDA OS and session type

Starting with version 2503, Citrix Workspace app for Mac provides default keyboard settings tailored
to the Virtual Desktop Agent (VDA) OS, ensuring an optimal input experience and simplifying configu-
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ration for end users. This feature is enabled by default.

Key features and updates:

« Dynamic sync enhancements:

- Application sessions: The default setting is now Dynamic Sync, allowing seamless input
synchronization and simplifying the configuration process.

- Desktop sessions: The default is also set to Dynamic Sync to ensure consistency and bal-
ance flexibility with stability.

« Automatic Keyboard Input Mode: A new option Automatic is added as the default for the Key-
board Input Mode. This feature ensures:

- Scancode is automatically selected for Mac VDAs.

- Unicode is automatically selected for Windows and Linux VDAs.

- Users can manually select either Scancode or Unicode for all sessions, depending on their
needs.

Limitation:

When upgrading from earlier versions of Citrix Workspace app for Mac with pre-defined local config-
uration files for the preceding settings, your previous configurations are retained. To use different
options, you must manually select them.

Enable Audio Quality Enhancer to improve audio performance

Starting with the 2503 version, Audio Quality Enhancer (v2) is added for Adaptive Audio.

Audio Quality Enhancer effectively manages short periods of packet loss and disruptions by intelli-
gently reconstructing audio from previous samples in real-time, thus preventing noticeable degrada-
tion in quality. Furthermore, it intelligently and adaptively recovers lost audio packets, if and only
when needed. It enables and disables itself adaptively when packet loss increases and decreases for
a sustained period. Audio Quality Enhancer optimizes audio playback and recording quality in both
good and poor network conditions.

To enable Audio Quality Enhancer, complete the following steps on the client:
1. Enable Adaptive Audio.
2. Enable Loss Tolerant Mode for Audio.

3. Enable the feature:

« defaults write com.citrix.receiver.nomas PacketLossConcealmentEnabled
-bool YES

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 134


https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/devices/audio-microphone.html#adaptive-audio
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/whats-new#loss-tolerant-mode-for-audio

Citrix Workspace app for Mac

« defaults write com.citrix.receiver.nomas EnableNetStat -bool
YES

4. Enable Audio Quality Enhancer on the Virtual Delivery Agent as well, which is required to fully
enablethefeature. Thatis, Audio Quality Enhancer must be enabled on both the Virtual Delivery
Agent and Citrix Workspace app sides to function end-to-end for audio playback and recording.

To disable Audio Quality Enhancer, complete the following steps on the client:

1. Disable the feature:

« defaults write com.citrix.receiver.nomas PacketLossConcealmentEnabled
-bool NO

« defaults write com.citrix.receiver.nomas EnableNetStat -bool
NO

2. Disable Audio Quality Enhancer on the Virtual Delivery Agent as well, which is required to fully
disable the feature.

Deprecation announcement of macOS Monterey 12

Starting with the 2503 version, support for macOS Monterey 12 is deprecated. As an alternative, you
can upgrade to the latest available version of Mac. For more information, see Deprecation.

Citrix Enterprise Browser

This release includes Citrix Enterprise Browser version 133.1.1.8, based on Chromium version 133. For
more information, see Citrix Enterprise Browser documentation.

Fixed issues

There are no new fixed issues in the release.

Known issues

There are no new known issues in the release.

System requirements and compatibility

February 5, 2025
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Supported operating systems

Citrix Workspace app for Mac supports the following operating systems:

» macOS Sequoia 15 (up to 15.3)
« macOS Sonoma 14

« macOS Ventura 13

« macOS Monterey 12

At any point in time, Citrix supports only the latest and the previous two macOS operating systems (N,
N-1, and N-2) only.

Compatible Citrix products

Citrix Workspace app is compatible with all the currently supported versions of Citrix Virtual Apps and
Desktops, Citrix DaaS (formerly Citrix Virtual Apps and Desktops service), and Citrix Gateway as listed
in the Citrix Product Lifecycle Matrix.

Compatible browsers

Citrix Workspace app for Mac is compatible with the following browsers:

+ Google Chrome
+ Microsoft Edge
+ Safari

Hardware requirements

+ 2 GB of free disk space
« Aworking network or Internet connection to connect to servers

Connections, Certificates, and Authentication
Connections

Citrix Workspace app for Mac supports the following connections to Citrix Virtual Apps and Desktops
and Citrix Daa$ (formerly Citrix Virtual Apps and Desktops service):

« HTTPS
o |[CA-over-TLS
o |CA-over-DTLS
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Citrix Workspace app for Mac supports the following configurations:

For LAN connections For secure remote or local connections

StoreFront using StoreFront services or Citrix Citrix Gateway 12.x-13.x, including VPX
Receiver for website;

Certificates

Important:

If you’re running macOS 10.15, ensure that your system is compliant with Apple’s requirements
for trusted certificates in macOS 10.15. Perform this check before you upgrade to Citrix Work-
space app for Mac version 2106.

Private (Self-signed) certificates |If a private certificate is installed on the remote gateway, you
must install the root certificate for the organization’s certificate authority on the user device. Then,
you can successfully access Citrix resources using Citrix Workspace app for Mac.

Note:

When the remote gateway’s certificate can’t be verified upon connection, an untrusted certifi-
cate warning appears, as the root certificate isn’t included in the local keystore. When a user
continues to add a store, the store addition fails. However, on the web browser, the user might
be able to authenticate to the store but connections to sessions fail.

Importing root certificates for devices

Obtain the certificate issuer’s root certificate and email it to an account configured on your device.
When clicking the attachment, you’re asked to import the root certificate.

Wildcard certificates Wildcard certificates are used in place of individual server certificates for any
server within the same domain. Citrix Workspace app for Mac supports wildcard certificates.

Intermediate certificates with Citrix Gateway If your certificate chain includes an intermediate
certificate, the intermediate certificate must be mapped to the Citrix Gateway server certificate. For
information on this task, see Citrix Gateway documentation. For more information about installing,
linking, and updating certificates, see How to Install and Link Intermediate Certificate with Primary
CA on Citrix Gateway.
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Server Certificate Validation Policy Citrix Workspace app for Mac has a stricter validation policy
for server certificates.

Important

Before installing this version of Citrix Workspace app for Mac, confirm that the server or gateway
certificates are correctly configured as described here. Connections can fail if:

« the server or gateway configuration includes a wrong root certificate

+ the server or gateway configuration does not include all intermediate certificates

« the server or gateway configuration includes an expired or otherwise invalid intermediate
certificate

+ the server or gateway configuration includes a cross-signed intermediate certificate

When validating a server certificate, Citrix Workspace app for Mac uses all the certificates supplied by
the server (or gateway). Citrix Workspace app for Mac then checks whether the certificates are trusted.
If none of the certificates are trusted, the connection fails.

This policy is stricter than the certificate policy in web browsers. Many web browsers include a large
set of root certificates that they trust.

The server (or gateway) must be configured with the correct set of certificates. An incorrect set of
certificates might cause Citrix Workspace app for Mac’s connection to fail.

Suppose that a gateway is configured with these valid certificates. This configuration isrecommended
for customers who require stricter validation, by determining exactly which root certificate is used by
Citrix Workspace app for Mac.

Then, Citrix Workspace app for Mac checks that all these certificates are valid. Citrix Workspace app
for Mac also checks that it already trusts the “Root Certificate™. If Citrix Workspace app for Mac does
not trust the “Root Certificate”, the connection fails.

Important

Some certificate authorities have more than one root certificate. If you require this stricter vali-
dation, ensure that your configuration uses the appropriate root certificate. For example, there
are currently two certificates (“DigiCert/GTE CyberTrust Global Root”, and “DigiCert Baltimore
Root/Baltimore CyberTrust Root”) that can validate the same server certificates. On some user
devices, both root certificates are available. On other devices, only one is available (“DigiCert
Baltimore Root/Baltimore CyberTrust Root”). If you configure “GTE CyberTrust Global Root”at
the gateway, Citrix Workspace app for Mac connections on those user devices fail. Consult the
certificate authority’s documentation to determine which root certificate must be used. Root
certificates eventually expire, as do all certificates.

Note:
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Some servers and gateways never send the root certificate, even if configured. Stricter validation
is then not possible.

Now suppose that a gateway is configured with these valid certificates. This configuration, omitting
the root certificate, is normally recommended:

+ “Example Server Certificate”
« “Example Intermediate Certificate”

Then, Citrix Workspace app for Mac uses these two certificates. It then searches for a root certificate
on the user device. If it finds a trusted certificate that validates correctly, such as “Example Root Cer-
tificate”, the connection succeeds. Otherwise, the connection fails. This configuration supplies the
intermediate certificate that Citrix Workspace app for Mac needs, but also allows Citrix Workspace app
for Mac to choose any valid, trusted, root certificate.

Now suppose that a gateway is configured with these certificates:

» “Example Server Certificate”
« “Example Intermediate Certificate”
+ “Wrong Root Certificate”

A web browser might ignore the wrong root certificate. However, Citrix Workspace app for Mac does
not ignore the wrong root certificate, and the connection fails.

Some certificate authorities use more than one intermediate certificate. In this case, the gateway is
normally configured with all the intermediate certificates (but not the root certificate) such as:

+ “Example Server Certificate”
« “Example Intermediate Certificate 1
« “Example Intermediate Certificate 2”

Important

Some certificate authorities use a cross-signed intermediate certificate, intended for situations
when there’s more than one root certificate. An earlier root certificate is still in use at the same
time as a later root certificate. In this case, there are at least two intermediate certificates. For
example, the earlier root certificate “Class 3 Public Primary Certification Authority”’has the cor-
responding cross-signed intermediate certificate “Verisign Class 3 Public Primary Certification
Authority - G5.”However, a corresponding later root certificate “Verisign Class 3 Public Primary
Certification Authority - G5”is also available, which replaces “Class 3 Public Primary Certification
Authority.”The later root certificate does not use a cross-signed intermediate certificate.

Note

The cross-signed intermediate certificate and the root certificate have the same Subject name
(Issued To), but the cross-signed intermediate certificate has a different Issuer name (Issued By).
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This difference in name distinguishes the cross-signed intermediate certificate from an ordinary
intermediate certificate (such “Example Intermediate Certificate 2”).

This configuration, omitting the root certificate and the cross-signed intermediate certificate, is nor-
mally recommended:

+ “Example Server Certificate”
+ “Example Intermediate Certificate”

Avoid configuring the gateway to use the cross-signed intermediate certificate, as it selects the earlier
root certificate:

» “Example Server Certificate”
« “Example Intermediate Certificate”
+ “Example Cross-signed Intermediate Certificate”[not recommended]

Itisn’t recommended to configure the gateway with only the server certificate:
» “Example Server Certificate”

In this case, if Citrix Workspace app for Mac can’t locate all the intermediate certificates, the connec-
tion fails.

Authentication

For connections to StoreFront, Citrix Workspace app for Mac supports the following authentication

methods:
Citrix Gateway Citrix Gateway
Workspace for ~ StoreFront to Workspace  to StoreFront
Authentication Web using Services site for Web Services site
method browsers (native) (browser) (native)
Anonymous Yes Yes
Domain Yes Yes Yes* Yes*
Domain
pass-through
Security token Yes* Yes*
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Citrix Gateway Citrix Gateway

Workspace for ~ StoreFront to Workspace  to StoreFront
Authentication Web using Services site for Web Services site
method browsers (native) (browser) (native)
Two-factor au- Yes* Yes*
thentication
(domain with
security
token)
SMS Yes* Yes*
Smart card Yes Yes Yes* Yes
User Yes Yes (Citrix
certificate Gateway

Plug-in)

*Available only for deployments that include Citrix Gateway, with or without installing the associated
plug-in on the device.

Connectivity requirements
Feature flag management

Feature flags are used to enable or disable features dynamically. If an issue occurs with Citrix Work-
space app in production, the affected feature can be disabled dynamically, even after the feature is
shipped.

No configurations are needed to enable traffic for feature management, except when a firewall or
proxy is blocking outbound traffic. In such cases, you need to enable traffic using specific URLs or
IP addresses, depending on your policy requirements.

Enable traffic for feature flag management

From Citrix Workspace app version 2409 onwards:

To ensure optimal functionality and access to preview features, you need to enable traffic to the URL
features.netscalergateway.net.
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Note:

Adding the preceding URL to the allow list is essential for optimal use of Citrix feature flags and
is supported starting with version 2409 of the Citrix Workspace app for Mac.

Provision to disable feature flag management service through MDMtool You candisablethefea-
ture flag management service on Citrix Workspace app, irrespective of whether their users are inside
or outside the organization’s firewall. To disable, set the value for the DisableFeatureFlag setting to
True.

This service is available for admins who manage Mac devices using the MDM tool.
Note:

Disabling the FeatureFlag requires the admin to restart the device for this setting to take effect.

For more information on how to use MDM, see Mobile Device Management.

Install, uninstall, and upgrade

July 9,2024

Citrix Workspace app for Mac contains a single installation package and supports remote access
through Citrix Gateway, and Secure Web Gateway.

You can install Citrix Workspace app for Mac in any of the following ways:

« From the Citrix website
+ Automatically from Workspace for Web

« Using an Electronic Software Distribution (ESD) tool.

By default, the Citrix Workspace app is installed in the Applications directory. The installation paths
are as follows:

o Fullinstall-"/Applications/Citrix\ Workspace.app/"
« Citrix Workspace app for Mac executable- " /Applications/Citrix\ Workspace.app
/Contents/Mac0S/Citrix\ Workspace"
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Manual install
By a user from Citrix.com

As a first-time user, you can download Citrix Workspace app for Mac from Citrix.com or your own down-
load site. You can then set up an account by entering an email address instead of a server URL. Citrix
Workspace app for Mac determines the Citrix Gateway or StoreFront server associated with the email
address. Then it prompts the user to log on and continue the installation. This feature is referred to
as email-based account discovery.

Note:

Afirst-time user is a user who does not have Citrix Workspace app for Mac installed on their user

device.

Email-based account discovery for a first-time user does not apply if you have downloaded from a
location other than Citrix.com (such as a Citrix Receiver for website).

If your site requires the configuration of Citrix Workspace app for Mac, use an alternate deployment
method.

Using an Electronic Software Distribution (ESD) tool

A first-time Citrix Workspace app for Mac user must enter a server URL to set up an account.

From Citrix Downloads page

You can install Citrix Workspace app for Mac from a network share, or directly on to the user device.
You can install the app by downloading the file from the Citrix website at Downloads.

To install Citrix Workspace app for Mac:

1. Download the . dmg file for the version of Citrix Workspace app for Mac that you want to install
from the Citrix website.

Open the downloaded file.

On the Introduction page, click Continue.

On the License page, click Continue.

Click Agree to accept the terms of the License Agreement.

On the Installation Type page, click Install.

On the Add Account page, select Add Account and then click Continue.

Enter the user name and password of an administrator on the local device.

© N ok wN
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Using the terminal command

You can install Citrix Workspace app for Mac using the terminal commands.
To install Citrix Workspace app for Mac:

1. Download the . dmg file for the version of Citrix Workspace app for Mac that you want to install
from the Downloads page.

2. Openthe downloaded CitrixWorkspaceApp.dmgfile.

3. DragtheInstall Citrix Workspace.pkgfileinto the folder.
4. Open the terminal app.

5. Run the following command in the terminal:

sudo installer -pkg <path_to_package>/<package_name>.pkg -target /

6. Enter the Administrator password, if prompted.

7. After running the command, Citrix Workspace app is successfully installed.

Uninstall
Using the bin
You can now simply drag or move the Citrix Workspace app icon into the bin to completely uninstall

the Citrix Workspace app for Mac.

To uninstall the Citrix Workspace app, do the following:

1. Close the Citrix Workspace app, if it’s running.
To close the Citrix Workspace app, use one of the following methods:

« From the menu bar, click Citrix Workspace and then Quit Citrix Workspace,

+ From the dock, right click on the Citrix Workspace app and select Quit from the options,
+ Press the Command-Q keys, or

« From the Quick Access menu, click the Account icon and then Quit.

Note:

If you don’t close the Citrix Workspace app as per the preceding steps, you might get the
following error message after performing the next step:

The item “Citrix Workspace "can’t be moved to the Trash because it’s open.

2. Drag the Citrix Workspace app from the Application folder to the bin.
Alternatively, you can right-click the Citrix Workspace app and select Options > Move to Bin.
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3. Provide your system credentials when prompted.

4. Close all running apps (Citrix Workspace) and click Continue to confirm.
The Citrix Workspace app and all its system files are deleted from your device.

Enhancements on quit menu of Citrix Workspace app Starting with the 2402.10 version, Citrix
Workspace app improves quit functionality and matches with Apple’s Quit menu behavior. When you
exit the Citrix Workspace app using the quit option, the app no longer runs in the background. With
this feature, you can conserve battery life and optimize system performance.

You can quit Citrix Workspace app by using any of the following methods:

+ Quit from the menu bar,

+ Quit from the dock,

o Quit from the Quick Access menu, or
+ Press the Command-Q keys.

Using the .dmg file

You can also uninstall Citrix Workspace app for Mac manually by opening the .dmg file. Select Unin-
stall Citrix Workspace App and follow the on-screen instructions. The .dmg file is the file that is
downloaded from Citrix when installing Citrix Workspace app for Mac for the first time. If the file is
no longer on your computer, download the file again from Citrix Downloads to uninstall the applica-

tion.

Using the terminal command

You can uninstall Citrix Workspace app for Mac using the terminal commands.

To uninstall Citrix Workspace app for Mac:

1. Open the terminal app.
2. Run the following command in the terminal:

sudo /Library/Application\ Support/Citrix\ Receiver/Uninstall\
Citrix\ Workspace.app/Contents/MacOS/Uninstall\ Citrix\
Workspace --nogui

3. After running the command, Citrix Workspace app and all its system files are deleted from your

device.

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 145


https://www.citrix.com/downloads/workspace-app/mac/workspace-app-for-mac-latest.html

Citrix Workspace app for Mac

Upgrade

Citrix Workspace app for Mac sends you notifications when there is an update available for an exist-
ing version or an upgrade to a newer version. For more information about automatic updates, see
Automatic update.

You can upgrade Citrix Workspace app for Mac from any of the previous versions of Citrix Workspace
app for Mac. For more information about updating the app manually, see Manual update.

When you upgrade to a newer version of Citrix Workspace app for Mac, the previous version is unin-
stalled automatically. You don’t need to restart your machine.

Support for automatic installation of the End-Point Analysis (EPA) plug-in with Citrix
Workspace app

Previously, users were required to manually download and install the End-Point Analysis (EPA) plug-in
during the Citrix Workspace app login.

Starting from version 2405, Citrix Workspace app supports the automatic installation of the EPA plug-
in during installation or updates. When you install or update Citrix Workspace app, the EPA plug-in is
included by default. This enhancement eliminates the need for separately installing the EPA plug-in,
resulting in a smoother experience during Citrix Workspace app setup.

Support for optionally installing Citrix Enterprise Browser

Starting with version 2405, you have the flexibility to choose whether to install Citrix Enterprise
Browser during the installation of the Citrix Workspace app for Mac. Additionally, if you’ve already
installed Citrix Enterprise Browser with Citrix Workspace app, you can uninstall Citrix Enterprise
Browser using the Global App Configuration service and Mobile Device Management (MDM). This
feature allows administrators to maintain compliance by controlling whether Citrix Enterprise
Browser is allowed for use on their managed devices.

Configuration

You can opt toinstall the Citrix Enterprise Browser using the Installer GUl and Command Line interface.
If Citrix Enterprise Browser is already installed, then you can uninstall by pushing settings through the
Global App Configuration service and MDM.

Install using the command line

« Install Citrix Workspace app with Citrix Enterprise Browser
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To install Citrix Enterprise Browser during the Citrix Workspace app installation using the command
line, run the following command:

sudo installer -pkg path_to_pkg -target / -verboseR

For example:

sudo installer -pkg /Volumes/Citrix\ Workspace/Install\ Citrix\
Workspace.pkg -target / -verboseR

« Install only Citrix Workspace app

To opt out from installing Citrix Enterprise Browser during the Citrix Workspace installation using the
command line, run the following command with the attached citrix_enterprise_browser_optedoutchoices.xml
file:

sudo installer -applyChoiceChangesXML path_to_ChoiceChangesXML -pkg
path_to_pkg -target /

For example:
sudo installer -applyChoiceChangesXML ./

citrix_enterprise_browser_optedoutchoices.xml -pkg /Volumes/Citrix\
Workspace/Install\ Citrix\ Workspace.pkg —-target /

Install using the installer GUI (Graphical User Interface)

1. Duringtheinstallation of Install Citrix Workspace.pkg through the installer GUI, the Custom In-
stall page allows you to choose whether to install Citrix Enterprise Browser or not.
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¥ Install Citrix Workspace

Custom Install on "Macintosh HD"

Package Name Action Size
Introduction

Install 228.5 MB
Licence ¥ Citrix Enterprise Browser Install 617.5 MB

A

Destination Select

Installation Type

Space Required: 846 MB Remaining: 391.77 GB

Citrix Enterprise Browser

Go Back Continue

2. In the Custom Install page, do one of the following:

« Select Citrix Enterprise Browser checkbox - In this case, both Citrix Workspace app and
Citrix Enterprise Browser are installed.

+ Deselect Citrix Enterprise Browser checkbox - In this case, only Citrix Workspace app is
installed.

3. If you deselect it, only Citrix Workspace app is installed.
4. If you select it, both Citrix Workspace app and Citrix Enterprise Browser are installed.
For more information about the installation, see Manual install.

Uninstall using the Global App Configuration service

To uninstall the Citrix Enterprise Browser, do the following steps:

1. Go to Citrix Cloud and sign in with your Citrix Cloud credentials.

2. Navigate to Workspace Configuration > App Configuration.

3. From the list of configured store URLs, select the store for which you want to uninstall the Citrix
Enterprise Browser and then click Configure.

4. Navigate to App Experience > App Preferences, select the Mac checkbox and toggle the button
to Enabled. If enabled, then the Citrix Workspace Browser is uninstalled from the end user’s
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device.

Workspace URL https:/shreyauitest2.cloudburrito.com  Production v

R% Manage configuration profiles Preview (@ View configured changes @ Clone Settings

remove citrix X‘ () Android () chromeos () HTMLS

App Experience > App Preferences
Updates and Plug-ins
Uninstall Citrix Enterprise Browser

> App Experience
When enabled, Citrix Enterprise Browser is uninstalled from the end user's device.

> Security and Authentication

> Session Experience
Mac Disabled Unsaved

> HDX and Multimedia
> Enterprise Browser

> Accessories

Reset all to default

5. Click Publish Drafts to save the settings.

Uninstall Citrix Enterprise Browser using the Mobile Device Management

To uninstall the Citrix Enterprise Browser, run the following command:

<key>RemoveCitrixEnterpriseBrowser</key> <true/>

Updates and plugins management

September 12,2024

This section describes the following:

» Updates
+ Plugins management

Update

December 17, 2024
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Support for auto-update scheduling

Starting with version 2411, admins can schedule auto-updates for the Citrix Workspace app during
convenient hours. This capability allows them to determine the rollout period, minimizing disruption
to end-users and improving adoption of the auto-update service, which was previously controlled by
Citrix.

End-users receive auto-updates for the Citrix Workspace app at a time scheduled by their admins, en-
suring updates happen in a planned manner. Admins can control updates on macOS in the following
ways:

« Admins can set the dates and time range for updates of the Citrix Workspace app for macOS.
+ Scheduled updates set by customer admins take precedence over any rollout periods defined
in the Citrix Catalog.

You can configure this feature using Mobile Device Management (MDM) and Global App Configuration
service (GACS).

Using MDM:
<array>
<dict>
<key>AutoUpdateSchedulerSettings</key>
<string>
{
"startTime":"20:30",
"endTime":"23:30",
"deferCount":"4"
}
</string>

<key>PayloadDisplayName</key>
<string>Citrix Workspace #1</string>
<key>PayloadIdentifier</key>
<string>com.citrix.receiver.nomas</string>
<key>PayloadType</key>
<string>com.citrix.receiver.nomas</string>
<key>PayloadUUID</key>
<string>3BE38AD3-7D95-423F-BD7B-8A4D1F5208EF</string>
<key>PayloadVersion</key>
<integer>1</integer>

</dict>

</array>

Using GACS:

1. Navigate to Workspace Configuration > App Configuration > URL Configuration.
2. Click Citrix Workspace app version and configure the desired settings.
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Manage settings for Macos
Citrix Workspace app version

Current configured version
24.1.0.46

O Automatically update to the latest version
Latest version: 2411046

Update type

Current Release (CR) ~ ‘

Maximum allowed version

| 24.11.046 - ]

Scheduling

Latest version: 24.11.0.46 release date
Neovember 28, 2024

Roll out start date

| December 3, 2024 ]
Delivery period
| 30 days ~ l

3. Next, click Automatic Update Timeframe > Edit to define the time window within which
auto-update trigger occurs.

Manage settings for Macos

Up<date between

(o} ) ) romse

Defer day count @

[~]

4. Entertherequired values. Defer day count specifies the number of times the end user can defer
the auto-update.

For more information, see Automatic update timeframe.
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Auto-update enhancement for active users

Starting with version 2411 of Citrix Workspace app for Mac, the auto-update feature has been en-
hanced to trigger only for active users. This change aims to provide better control by ensuring that
auto-update is available only for users with Global App Configuration service (GACS) or Mobile Device
Management (MDM) policies, or who are actively using the app.

A user is considered active if any of the following criteria is met:

+ The useris a managed user, with system and profile controlled and maintained by an IT admin-
istrator.

+ The user has added a store with Global Application Configuration service (GACS) settings.

« The user has launched at least one session (Desktop, Citrix Virtual app, or Saa$S app).

If none of these conditions are met, the user is considered inactive, and the auto-update feature is
not available. When a user transitions from inactive to active status, the application triggers the auto-
update feature, if applicable, ensuring the application is up-to-date.

Auto-update support for user groups

Starting with version 2411, customers can configure different app versions for different user groups
through Configuration Profile in Global App Configuration Service (GACS). For more information, see
Automatic update management settings supports configuration profiles.

Manual update

To manually update the Citrix Workspace app for Mac, download and install the latest version of the
app from the Citrix Downloads page.

Automatic update

When a new version of the Citrix Workspace app releases, Citrix pushes the update on the system that
has the Citrix Workspace app installed. You’re notified of the available update.

Note:

« If you’ve configured an SSL intercepting outbound proxy, add an exception to the Work-
space auto-update serverhttps://downloadplugins.citrix.com/ toreceive up-
dates from Citrix.

+ Auto-update isn’t available for Citrix Workspace app versions earlier than 2301.1. For more
information, see Knowledge Center article CTX491310.
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+ Your system must have an internet connection to receive updates.

« Workspace for web users can’t download the StoreFront policy automatically.

« Citrix HDX RTME for macOS is included in Citrix Workspace Updates. You’re notified of the
available HDX RTME update on the Citrix Workspace app.

« Starting with Version 2111, Citrix Workspace updates log paths are modified. The Work-
space updates logs are present at /Library/Logs/Citrix Workspace Updater.
For information about collecting logs, see the Log collection section.

Support for restricting users to modify the update channel

Previously, users can modify the update channel to release or beta using the Select the update chan-
nel option available on the Advanced setting.

Starting with the 2409 version, the Citrix workspace app for Mac allows the admin to manage the
Select the update channel option. With this feature, you have control over the update channel pref-
erence, ensuring that end users cannot modify it. This ensures that the update channel remains con-

sistent and secure, as per your administrative settings.

Advanced . % : B

Updates  Citrix Casting  Logging

+ Automatically keep Workspace app up to date

Select the update channel:

You can configure this feature through the Global App Configuration service (GACS), Mobile Device
Management (MDM), and the web.config file.

Using MDM

To push the auto-update for release or beta channels, administrators must use the following
settings:

<key>AutoUpdateChannel</key><string>release</string>

or

<key>AutoUpdateChannel</key><string>beta</string>
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Using the web.config file

To push the auto-update for release or beta channels, do the following steps:

1. Use atext editor to open the web.configfile, whichistypicallyinthe C: \inetpub\ wwwroot
\Citrix\Roaming directory.

2. Locate the user account element in the file (Store is the account name of your deployment).
For example: <account 1id=... name="Store">

3. Navigate to the properties of that user account and add the following properties before the </ac-
count> tag,:

<property name=“autoUpdateChannel” value=“release” />
<property name=“autoUpdateChannel” value=“beta” />

Installing Citrix Workspace app Beta program

You receive an update notification when the Citrix Workspace app is configured for automatic updates.
To install the Beta build on your system, perform the following steps:

1. Open Citrix Workspace app.
2. Right-click on Citrix Workspace in the toolbar and click Preferences > Advanced.

3. Select Beta from the drop-down list, when the Beta build is available.

Advanced ) L E

File #

Updates  Citrix Casting Logging

» Automatically keep Workspace app up to date

Select the update channel: = Beta

To switch from a Beta build to a Release build, perform the following steps:
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1. Open Citrix Workspace app.
2. Right-click on Citrix Workspace in the toolbar and click Preferences > Advanced.

3. Select Release from the Select the update channel drop-down list.

Advanced

Updates  Citrix Casting Logging

¥ Automatically keep Workspace app up to date

Select the update channel: = Release

Note:

Beta builds are available for customers to test in their non-production or limited production en-
vironments, and to share feedback. Citrix does not accept support cases for beta builds but wel-
comes feedback forimproving them. Citrix might or might not act on feedback based on its sever-
ity, criticality, and importance. It’s advised that you do not deploy Beta builds in production
environments.

Auto-update version control

Administrators can now manage the auto-updated version of Citrix Workspace app for the devices in
the organization.

Administrators can control the version by setting the range for maximumAllowedVersion and minimu-
mAllowedVersion properties in the Global App Configuration service.

Example JSON file in Global App Configuration service:
{

"serviceURL": {

"url": "https://serviceURL:443"
}

)

"settings": {
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"name": "Version Control for Citrix Workspace",

"description": "Provides admin ability to Version Control for
Citrix Workspace",

"useForAppConfig": true,

"appSettings": {

"macos": [

{

"category": "AutoUpdate",

"userOverride": false,

"assignedTo": [
"AllUsersNoAuthentication"

1,
"settings": [
{
"name": "Auto update plugins settings",
"value": [
{
"pluginName": "Citrix Workspace",
"pluginId": "D99C3E77-FBF5-4B97-8EDA-4E381A1E0826",
"pluginSettings": {
"deploymentMode": "Update",
"upgradeTolLatest": false,
"minimumAllowedVersion": "23.07.0.63",
"maximumAllowedVersion": "23.07.0.63",
"delayGroup": "Medium",
"detectRule": ""
}
}
]
}
]
}
]
}

When the range is set, Citrix Workspace app on the user’s device is automatically updated to the high-
est available version that falls between the mentioned range.

If you want to auto-update Citrix Workspace app to a specific version, enter the same version in the
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maximumAllowedVersion and minimumAllowedVersion properties in the Global App Configuration
service.

Note:

+ To enable auto-update version control, set the upgradeToLatest setting to false in the
Global App Configuration service. If the upgradeToLatest setting is true, maximumaAl-
lowedVersion and minimumAllowedVersion is ignored.

+ Do not modify the pluginld. The pluginID is mapped to Citrix Workspace app.

« If the administrator hasn’t configured the version in the Global App Configuration service,
Citrix Workspace app is updated to the latest available version by default.

+ You can only use the version ranges that are set to update Citrix Workspace app. However,
a downgrade isn’t supported.

« This feature is supported from release 2307 onwards.

Improved auto-update experience

The auto-update feature automatically updates the Citrix Workspace app to the latest version without
the need for any user intervention.

Citrix Workspace app periodically checks and downloads the latest available version of the app. Cit-
rix Workspace app determines the best time to install based on user activity not to cause any disrup-
tions.

Advanced configuration for automatic updates (Citrix Workspace Updates)

You can configure Citrix Workspace updates using the following methods:

« Graphical user interface (GUI)

+ Global App Configuration service (GACS)
+ Mobile Device Management (MDM)

« StoreFront

Configure Citrix Workspace automatic updates using the graphical user interface

Individual users can override the Citrix Workspace updates setting using the Advanced preferences
dialog box, which is a per-user configuration and the settings apply only to the current user. To con-
figure the update using the GUI, perform the following steps:

1. Select the Citrix Workspace app helpericon on your Mac.
2. Fromthe drop-down list, select Preferences > Advanced > Updates.
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3. Select the build for which you want to install the automatic updates. It can be either the Apple
Silicon or Intel build (only applicable for users on Mac with Apple silicon (M1 Series).

Advanced . ‘

Updates  Citrix Casting  Logging

v Automatically keep Workspace app up to date

Select Intel or Apple Silicon build: = Apple Silicon

Select the update channel: = Release

Configure Citrix Workspace automatic updates using StoreFront
1. Use a text editor to open the web.conf1ig file, which is typically in the C:\inetpub\
wwwroot\Citrix\Roaming directory.
2. Locate the user account element in the file (Store is the account name of your deployment).
For example: <account id=... name="Store">
Before the </account> tag, navigate to the properties of that user account:
<properties>

<clear/>
</properties>

3. Add the auto-update tag after the <clear /> tag.
<account>
<clear />

<account id="d1197d2c-ac82-4f13-9346-2ee14d4b0202" name="
F84Store"

description="" published="true" updaterType="Citrix"
remoteAccessType="None">

<annotatedServices>

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 158



Citrix Workspace app for Mac

<clear />

<annotatedServiceRecord serviceRef="1__Citrix_F84Store'">

<metadata>
<plugins>
<clear />
</plugins>
<trustSettings>
<clear />
</trustSettings>

<properties>

<property name="Auto-Update-Check" value="Disabled"

/>

<property name="Auto-Update-DeferUpdate-Count" value

="in />

<property name="Auto-Update-Rollout-Priority" value=

"fast" />

<property name="Auto-Update-Architecture" value="
Universal" or "Intel" />

</properties>
</metadata>
</annotatedServiceRecord>
</annotatedServices>
<metadata>
<plugins>
<clear />
</plugins>
<trustSettings>

<clear />
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</trustSettings>
<properties>
<clear />
</properties>
</metadata>

</account>

The meaning of the properties and their possible values are detailed as follows:

« Auto-Update-Check: Indicates that Citrix Workspace app detects an update automatically
when available.

- Auto (default) —Checks and performs updates automatically

- Manual —updates are only fetched when the user makes a check request from the Citrix
Workspace app system tray menu,

- Disabled —Updates checks aren’t performed.

« Auto-Update-Rollout-Priority: Indicates the delivery period in which you can receive the up-
date.

- Fast —updates are rolled-out to the users towards the beginning of the delivery period.
- Medium —updates are rolled-out towards the middle of the delivery period.
- Slow-updates are rolled-out towards the end of the delivery period.

+ Auto-Update-DeferUpdate-Count: Indicates the number of counts that you can defer the no-
tifications for the updates.

Note:
This configuration is applicable only for interactive updates and not when the silent auto-

update feature is enabled, as the user doesn’t get any option to defer the updates.

- -1: The user can defer the auto-update any number of times.
- 0: The user can’t view the remind me later option.
- number: The user can view remind later options with the given count.

Configure Citrix Workspace automatic updates using the GACS

Administrators can use GACS to configure the automatic updates to either Apple Silicon or Intel builds
by using the following settings:

“name”:“autoUpdateArchitecture”
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“value”:“Universal”or “Intel”

Configure Citrix Workspace automatic updates using the MDM

Administrators can use MDM to configure the automatic updates to either Apple Silicon or Intel builds
by using the following settings:

<key>AutoUpdateArchitecture</key>
<string>Universal</string> or <string>Intel</string>
<key>AutoUpdateState</key>

<string>Auto</string> or <string>Manual</string> or <string>Disabled
</string>

For more information on how to use MDM, see Mobile Device Management.

Log collection

Log collection simplifies the process of collecting logs for Citrix Workspace app. The logs help Citrix
to troubleshoot, and, in cases of complicated issues, provide support.

You can collect logs using the GUI.

Collecting logs:
1. Open Citrix Workspace app.
2. Right-click on Citrix Workspace in the toolbar and click Preferences > Advanced.
3. Select Logging.

=

Advanced .

Updates  Citrix Casting = Logging
Session logging: | Full

Store logging: | Verbose
Log files: 20 log files

Email Log Files

4. Select one of the following session log levels:
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+ Disabled (Default): Minimum logs are collected for basic troubleshooting.

+ Connection Diagnostics: Identifies errors while connecting. All logging is enabled up un-
til the point when the session is deemed successful.

+ Full: Captures everything including the connection diagnostics. Once enabled, the Citrix
Workspace app will store up to 10 session logs after which they’re deleted starting with the
oldest to maintain 10 logs.

Note:

Selecting the Full logging option can impact performance and must be used only while
troubleshooting an issue because of the amount of data. Do not enable full logging during
normal use. Enabling this level of logging triggers a warning dialog that must be acknow!-

edged for you to continue.

5. Select one of the following store log levels:

+ Disabled (Default): Minimum logs are collected for basic troubleshooting.
« Normal: Only store communication logs are collected.
+ Verbose: Detailed authentication and store communication logs are collected.

6. Click Email Log Files to collect and share logs as a .zip file.

Enhanced Universal Architecture builds for virtual apps and desktops session

From the 2311 version, the Universal Architecture build can now automatically choose to run the vir-
tual sessions in the native Apple Silicon mode or Intel mode. It uses the Rosetta emulation to launch
the virtual session in Intel mode. The virtual session launches in the native Apple Silicon mode, if the
virtual channel SDK is built based on the native Apple Silicon architecture or there’s no virtual chan-
nel SDK. However, the virtual session launches in the Intel mode using the Rosetta emulation, if the
virtual channel SDK is built based on the x86_64 Intel-based architecture.

This enhancement to the Universal Architecture build improves the launch experience on Macs with
the Apple Silicon chipset. For users on Macs with the Intel-based chipset, there is no change, and the
Universal Architecture build continues to run the virtual sessions natively.

Plug-ins management

December 17, 2024
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Version control using MDM and GACS

Starting with version 2411, administrators can configure Citrix Workspace version control and Client
App Management using Mobile Device Management (MDM). This capability enables administrators
to manage the automatic updates of the Citrix Workspace app on devices within their organization.
Administrators can control the version by setting the range for maximumAllowedVersion and
minimumAllowedVersion properties in the Global App Configuration service.

For more information, see Auto-update version control.

To enable authentication through MDM, use the following settings:

<dict>
<key>AutoUpdatePluginsSettings</key>
<string>
[
{
"pluginName": "Citrix Workspace",
"pluginId": "D99C3E77-FBF5-4B97-8EDA-4E381A1E0826",
"pluginSettings": {
"deploymentMode": "InstallAndUpdate",
"upgradeTolLatest": false,
"minimumAllowedVersion": "24.02.10.24",
"maximumAllowedVersion": "24.02.10.24",
"delayGroup": "Medium"
}
+
1
</string>
</dict>

To enable this feature through GACS, admins must follow these steps:

1. Navigate to Workspace Configuration > App Configuration > Configure in Citrix Cloud.
2. In Citrix Workspace app page, click Citrix Workspace app version and configure the desired

settings.
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Manage settings for Macos

Citrix Workspace app version

Current configured version

Mone

() Automatically update to the latest version
Latest version: 24.11.0.46

Update type

Current Release (CR) W

Maximum allowed version

24.11.0.46 “

Scheduling

Latest version: 24.11.0.46 release date
Novemnber 28, 2024

Roll out start date

December 5, 2024 B3

Delivery period

15 days v

For more information, see Citrix Workspace app version.

Client App Management using MDM

Client App Management allows administrators to install and manage agents like Citrix EndPoint Analy-
sis (EPA) and Zoom VDI plug-ins from a single console.

Client App Management for Zoom VDI auto-update plug-in Administrators can control auto-
update settings for Zoom VDI plug-ins on organization devices, ensuring seamless updates and
enhanced security.
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To configure Zoom VDI auto-update plug-in management through MDM, use the following settings:

<dict>
<key>AutoUpdatePluginsSettings</key>
<string>
[
{
"pluginName": "Zoom VDI AutoUpgrade Plugin",
"pluginId": "1A4BB471-022C-4C87-BDCD-0B64FB42869C",
"pluginSettings": {
"deploymentMode": "InstallAndUpdate",
"upgradeTolLatest": true,
"ftu": true
}
}
]
</string>
</dict>

For more information, see Client App Management for Zoom VDI plug-in.

Client App Management

Starting with version 2409, Citrix Workspace app for Mac offers Client App Management capability that
makes the Citrix Workspace app a single client app required on the end point to install and manage
agents such as Citrix EndPoint Analysis (EPA) and Zoom VDI plug-ins. With this feature, administrators
can easily deploy and manage required agents from a single management console. You can configure
this feature using the Global App Configuration service (GACS).

To configure Client App Management, do the following:

1. Administrators must specify the agents required on end users’devices in GACS.

2. Citrix Workspace app fetches the list of agents from GACS.

3. Based on the list fetched from GACS, Citrix Workspace app downloads the agent packages
through the auto-update service. If the agent isn’t previously installed on the end point, Citrix
Workspace app triggers the installation of the agent. If the agent is already installed, Citrix
Workspace app triggers an update to the agent (if the version of the downloaded agent is
higher than the installed version.)

Citrix Workspace app ensures to automatically update the agents whenever an update is available in
the future.

For more information about configuration, see Manage plug-ins using Global App Configuration ser-

vice.
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Client App Management for Zoom VDI plug-in

Starting with version 2409, you can now manage the Zoom VDI plug-in using the Client App Manage-
ment capability. With this feature, you can download, install, and auto-update the Zoom VDI plug-in
from Citrix Workspace app. For more information about configuration, see Zoom VDI Plug-in Manage-
ment in the GACS documentation.

Configure Citrix Workspace app

December 16, 2024

You can configure Citrix Workspace app for Mac using Global App Configuration service User Interface
(Ul) and Mobile Device Management. Settings can be configured for both cloud (Citrix Workspace) and
on-premises (Citrix StoreFront) environments.

For more information, see the following:
+ Global App Configuration service

- Configure settings for cloud stores
- Configure settings for on-premises stores

+ Mobile Device Management

USB redirection

HDX USB device redirection enables redirection of USB devices to and from a user device. A user can
connect a flash drive to a local computer and access it remotely from a virtual desktop or a desktop
hosted application. For more information, see USB.

Keyboard layout synchronization

Keyboard layout synchronization enables you to switch between the preferred keyboard layouts on
the client device. This feature is disabled by default. After you enable this feature, the client keyboard
layout automatically synchronizes to the virtual apps and desktops. For more information, see Key-
board layout synchronization.
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Channel support for Global App Configuration service

The Global App Configuration service for Citrix Workspace allows a Citrix administrator to deliver Work-
space service URLs and Workspace App settings through a centrally managed service. Global App Con-
figuration service now allows administrators to test the settings before rolling it out to all users. This
feature allows to resolve any issues before applying the global app configurations to the entire user
base.

You can achieve the channel support by mapping the settings that you want to test to a channel and
then add the channel in the payload. For more information, see Global App Configuration service
documentation.

Citrix Virtual Channel SDK

The Citrix Virtual Channel software development kit (VCSDK) supports writing server-side applications
and client-side drivers for more virtual channels using the ICA protocol. The server-side virtual chan-
nel applications are on Citrix Virtual Apps and Desktops servers. If you want to write virtual drivers for
other client platforms, contact Citrix Technical support.

The Virtual Channel SDK provides:

+ The Citrix Virtual Driver Application Programming Interface (VDAPI) is used with the virtual chan-
nelfunctionsin the Citrix Server API SDK (WFAPI SDK) to create new virtual channels. Thevirtual
channel support provided by VDAPI makes it easy to write your own virtual channels.

+ The Windows Monitoring API, which enhances the visual experience and support for third-party
applications integrated with ICA.

« Working source code for virtual channel sample programs to demonstrate programming tech-
niques.

The Virtual Channel SDK requires the WFAPI SDK to write the server side of the virtual channel.

Load Custom Virtual Channels on Macs with Apple Silicon

As an end-user, you can load the Custom Virtual Channel SDK (VCSDK) successfully on a Mac with the
M1 and M2 chipset. With universal architecture, you must load the VCSDK by recompiling your Custom
Virtual Channels using the latest VCSDK on the M1 and M2 chipset device. You can download the uni-
versal architecture build from the Virtual Channel SDK 2204 for macOS (Apple silicon) - Universal
Architecture section at Downloads.

To load the VCSDK, do the following:

1. Download Virtual Channel SDK 2204 for macOS from Downloads.
2. Open your Custom Virtual Channel project in Xcode.
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3. Change your code.
4. Compile your Custom Virtual Channel to generate the virtual channel bundle.

Test your Virtual Channel Software Development Kit (VCSDK)

If you’re using the Citrix Virtual Channel Software Development Kit (VCSDK), you must customize so
your customized virtual channels run correctly. To test your VCSDKs, do the following:

1. Ensure that all the linked libraries of your customized virtual channels are compiled for Univer-
sal Binary.

2. Change the Project file to support Universal Binary:

« Open Project > Build Settings.
+ Set Architectures to Standard Architectures.

Eneral Signing & Capabilities Resource Tags Info Build Settings Build Phases Build Rules

Basic Customized [ Levels + Q-

v Architectures
Setting @ Vvirtual Channel Plugin

Additional SDKs

Architectures Standard Architectures (Apple Silicon, Intel) - $(A... <
Base SDK macOS ¢
Build Active Architecture Only No &

Excluded Architectures
> Supported Platforms mac0Ss ¢

Examples for the VCSDK can be found inside VCSDK.dmg. These examples support Apple’s Universal
macOS Binary that runs natively on both Apple silicon and Intel-based Mac computers. Because it
contains executable code for both architectures. You can use these examples as a reference.

C N ] | virtual Channel SDK
3 of 7 selected
—_— —_— — e —_—
Build Settings Documentation Includes Libraries Mix Plugin Example
—_— ——

Over Plugin Example Ping Plugin Example
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Modernized Citrix Virtual Channel SDK for Citrix Workspace app for Mac

Starting with the 2311 version, the Citrix Virtual Channel Software Development Kit (VCSDK) supports
writing server-side applications and client-side drivers for more virtual channels using the ICA proto-
col. The server-side virtual channel applications are on Citrix Virtual Apps and Desktops servers. This
version of the SDK supports writing new virtual channels and screen sharing for Citrix Workspace app
for Mac.

For more information, see Citrix Virtual Channel SDK for Citrix Workspace app for Mac in the Developer
documentation.

Increase in the number of supported virtual channels

Previously, Citrix Workspace app for Mac supported up to 32 virtual channels. Starting with the 2308
version, you can use up to 64 virtual channels in a session.

Modernized Citrix Virtual Channel SDK for Citrix Workspace app for Mac
Starting with the 2405 version, the Citrix Virtual Channel Software Development Kit (VCSDK) supports
the desktop and screen sharing VCSDK APl and gbuffer sharing.

For more information, see Virtual driver screen sharing and app-sharing functions.

Mobile Device Management

December 8, 2024

Citrix Workspace app now supports Mobile Device Management (MDM) that allows the administrators
to configure, secure, and support Citrix Workspace app for Mac by enforcing policies through any MDM
tool.

Install and uninstall Citrix Workspace app through the MDM

You can use terminal commands to install and uninstall the Citrix Workspace app through the MDM.
For more information about using the terminal commands to install and uninstall, see the Manual
install and Uninstall section.

To install Citrix Workspace app for Mac:
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1. Download the . dmg file for the version of Citrix Workspace app for Mac that you want to install

from the Downloads page.

2. Openthe downloaded CitrixWorkspaceApp.dmgfile.

3. Dragthe Install Citrix Workspace.pkgfileinto the folder.

4. Use the following terminal command to install the package through MDM:

To uninstall Citrix Workspace app:

Workspace.pkg -target /

sudo installer -pkg /Volumes/Citrix\ Workspace/Install\ Citrix\

You can use the following terminal command to uninstall the Citrix Workspace app through MDM:

sudo /Library/Application\ Support/Citrix\ Receiver/Uninstall\ Citrix

Settings supported on MDM

Setting

Set pre-
populated
username

Lock pre-
populated
username

Description

Sets the
username
that will be
pre-
populated
in the
authentica-
tion
prompt.
Locks the
pre-
populated
username
field, used
with
CitrixUser-
Name to
prevent
edits.

Key

Value

Value type

CitrixUserNam#&serNameValustring

LockUserNamdJserNameValuBoolean

Default
Value

NA

NA

\ Workspace.app/Contents/MacOS/Uninstall\ Citrix\ Workspace --
nogui

Supported
version

2411

2411
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Default Supported

Setting Description Value Valuetype  Value version
Auto Allows AutoUpdateScHedulerSettingString NA 2411
update - administra- startTime
AutoUp- tors to ":"20:30
dateSched- manage the "y
uler Select the endTime"

update :"23:30"

channel , "

option, deferCount

preventing ""4n}

end users

from

modifying

it.
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Default Supported
Setting Description  Key Value Valuetype  Value version
Version Allows AutoUpdatePluginisSettings String NA 2411
Control administra- pluginName
torsto e "
manage Citrix
version Workspace
control and "tyn
auto- pluginId
updates for "tyon
Citrix D99C3E7T
Workspace -FBF5-4
plugins. B97-8EDA
-4
E381A1E0826
n n
)
pluginSettings
n . { n
deploymentMode
n : n
InstallAndUpdate
n n
)
upgradeTolLatest
": false
"
J
minimumAllowedVersion
n : n
24.02.10.24
n n
J
maximumAllowedVersion
n : n
24.02.10.24
n n
J
delayGroup
n : n
Medium"}
}
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Default Supported
Setting Description Value Valuetype  Value version
Auto Settings for  AutoUpdatePlulg{nsSettings String NA 2411
update - managing pluginName
Zoom auto- ": "Zoom
AutoUp- updates of VDI
datePlug- pluginsin AutoUpgrade
insSettings  Citrix Plugin"
Workspace. , "

pluginId

"r "1

A4BB4T71

-022C-4

C87-BDCD

-0

B64FB42869C

noom

pluginSettings

n : { n

deploymentMode

ne o

InstallAndUpdate

noow

upgradeTolLatest

": true,

"ftu'":

true } }

]
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Default Supported

Setting Description  Key Value Valuetype  Value version
Auto Allows AutoUpdateCheslrabe/beta String release 2409
update - administra-
AutoUpdat-  torsto
eChannel manage the

Select the

update

channel

option,

preventing

end users

from

modifying

it.
Enable/disableAllows RemoveCitrixEtrieeffekeBrowwolean False 2405
to install administra-
Citrix tors to
Enterprise enable or
Browser disable the
during installation
Citrix of Citrix
Workspace  Enterprise
app Browser
installation  during

Citrix

Workspace

app

installation.
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Default Supported

Setting Description  Key Value Valuetype  Value version
Enable/disableAllows EdtUnreliableAltoe/éalse Boolean True 2402
loss administra-
tolerant tors to
mode for enable or
audio disable the
redirection  loss-

tolerant

mode (EDT

lossy) for

audio

redirection.
Enable/disableAllows EnableVolumeS$yuey/false Boolean True 2402
audio administra-
volume tors to
synchro- enable or
nization disable the

synchro-

nization of

audio

volume

between

the VDA

and your

audio

devices.
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Default Supported
Setting Description  Key Value Valuetype  Value version

Enable/Disabléllows EnableXdecodértieffalss Boolean True 2402

H.265video administra-

decoding tors to
enable or
disable the
H.265 video
codec
(HEVC) for
hardware
accelera-
tion of
remote
graphics
and videos.
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Default Supported

Setting Description  Key Value Valuetype  Value version
Select Allows WebBrowserFoshstdrarsirste ofiltittgP rivateSeEsbretae Hed d2BiEatb8dskdilVithPriva
browser for  administra-
FIDO2 web  torsto
Authentica-  select the
tion type of

browser

used for

Enable/disableAllows

FIDO2
authentica-
tion for HDX

session

authenticat-
ing an end
user into
Citrix
Workspace
app. For
more
information
about the
description
of values,
see FIDO2
based
authentica-
tion when
connecting
to cloud
and on-
premises
store
Fido2Enabled true/false
administra-
tors to
enable or
disable
FIDO2
authentica-
tion within
an HDX
session.

Boolean

true

2307
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Setting

Quick
access
menu for
StoreFront

Auto
update —
AutoUpdat-
eState

Enable
Azure
Active
Directory

Description

Allows
administra-
tors to
enable or
disable the
Quick
access
menu for
On-prem
stores.
Updates
Citrix
Workspace
app to the
latest
version
without any
user inter-
vention
automati-
cally.
Allows
administra-
tors to
configure
and enforce
Azure
Active
Directory
conditional
access
policies for
users

authenticat-

ing to Citrix
Workspace
app.

Key

Value

Value type

ShowQuickAccasstfattereFrdddolean

AutoUpdateStatato/Manual/C8$ebied

enableAAD

true/false

Boolean

Default
Value

false

Auto

False

Supported
version

2307

2305

2305
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Setting

Auto start
of Citrix
Workspace

app

Pre-
configuration
of Store

URL

Block new
Store
addition by
end-user

Description

Controls
Citrix
Workspace
app for Mac
to start au-
tomatically
whenever a
computeris
turned on
by an end
user.
Allows
administra-
tors to
preconfig-
ure and add
the store
details to
the
Workspace
app so that
the end
users don’t
have to do
it.

Prevents
the end
user from
adding a
store in the
Workspace
appon
their
endpoint
devices.

Key Value

AutoLaunchAptQeKekiart

StoreURLs <Store

URL>

BlockStoreAdditiomfalse

Value type

Boolean

String

Boolean

Default
Value

True

False

Supported
version

2304

2210

2210
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Setting Description  Key Value Value type

Default
Value

Supported

version

Show/Hide  Shows or ShowHelperintreryifaise Boolean
menu bar hides the

Citrix

Workspace

menu on

the Mac

menu bar.

True

2208.1

Schema for reference

<array>
<dict>

<key>ShowHelperInMenuBar</key>
<true/>

<key>AutoLaunchAppOnRestart</key>
<true/>

<key>StoreURLs</key>
<array>

<string>PROVIDE STORE URL HERE</string>

</array>
<key>BlockStoreAddition</key>
<false/>
<key>CEIPEnabled</key>
<true/>
<key>AutoUpdateState</key>
<string>Auto</string>
<key>AutoUpdateChannel</key>
<string>release</string>
<key>WebBrowserForAuthentication</key>
<string>Embedded</string>
<key>Fido2Enabled</key>
<false/>
<key>ShowQuickAccessForStoreFront</key>
<true/>
<key>EnableXdecoderForH265</key>
<false/>
<key>EnableVolumeSync</key>
<false/>
<key>EdtUnreliableAllowed</key>
<false/>
<key>PayloadDisplayName</key>
<string>Citrix Workspace</string>
<key>PayloadIdentifier</key>

<string>com.citrix.receiver.nomas</string>

<key>PayloadType</key>

<string>com.citrix.receiver.nomas</string>
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<key>PayloadUUID</key>
<string>3BE38AD3-7D95-423F-BD7B-8A4D1F5208EF</string>
<key>PayloadVersion</key>
<integer>1</integer>
</dict>
</array>

Store configuration

December 16, 2024

Enhanced Desktop Viewer toolbar

Starting with the 2409 version, the virtual Desktop Viewer toolbar is enhanced to be more intuitive,
modern, and user-friendly. With this feature, you can now customize the Citrix Workspace app toolbar
by adding and removing options on the toolbar.

B &

Hide toolbar Shortcuts Preferences Minimize Fullscreen Disconnect

The new toolbar provides the following options:

Show or hide toolbar Click this button to show or hide the Desktop
Viewer toolbar. A notch appears when the

toolbaris hidden.
Shortcuts Click this button to access the shortcuts.

Devices Click this button to access the options in the
Devices section.

Preferences Click this button to access the options in the
Preferences section.

Minimize Click this button to minimize the virtual session.

This option is hidden in the full-screen mode.

Fullscreen Click this button to access the virtual session in
full screen.
Restore Click this button to restore the virtual session

from the full-screen mode.
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Disconnect Click this button to sign out or to disconnect
from a virtual session.

You can click and drag the toolbar across all screens in the virtual session. When you drag the toolbar,
it can rotate automatically based on its placement on the screen. Once you release the drag, it gets
positioned to the nearest edge of the screen.

You can configure this feature using the Global App configuration service (GACS) and Mobile Device
Management (MDM).

Using GACS

1. Signin to your Citrix Cloud account and navigate to Workspace Configuration > App Configu-
ration.

2. From the list of configured URLs, select the one for which you want to map settings, and click
Configure.

nnnnnnnnnn

3. Under the Toolbar section, navigate to the required option in the toolbar and click the expand
icon.

4. Select the Mac checkbox and then click Edit.

5. You can now customize the toolbar option to hide or show.

6. Click Publish Drafts to save the settings.

Using MDM

To hide the toolbar, administrators must use the following setting:

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 182



Citrix Workspace app for Mac

<key>EnableInSessionToolbar</key>
<false/>
To hide specific buttons in the toolbar, administrators must use the following setting:
<key>HiddenToolbarButtons</key>
<array>
‘<string>preferences</string>"
‘<string>minimize</string>’

“<string>fullscreen</string>"

</array>

The supported values include ctrlAltDel, connectionStrength, device, shortcuts,
preferences,minimize, fullscreen,and close.

Note:

If no configuration is made, the session toolbar is displayed by default with all buttons.

Support for store configuration of user devices through MDM tool

Admins can now configure the following settings while deploying Citrix Workspace app through any
MDM deployment tool such as Citrix Endpoint Management:

+ StoreURLs —Configure store details so it’s automatically added when the user opens the Citrix
Workspace app, simplifying the sign-on experience.
To add a store, provide the details for the StoreURLs setting. For example:

<array>
<string>https://myorg.com/?storename</string>
</array>

You can also add multiple stores as follows:

<array>
<string>https://myorg.com/?storenamel</string>
<string>https://myorg.com/?storename2</string>
</array>

To add the StoreURLs to Citrix Workspace app, the user must quit and relaunch Citrix Workspace
app.
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+ BlockStoreAddition —Prevent the user from adding stores.

To block the user from adding a store, set the value of the BlockStoreAddition setting to True.

For more information, see Mobile Device Management.

StoreFront to Workspace migration

As your organization transitions from on-premises StoreFront to Workspace, users are required to
manually add the new Workspace URL to the Citrix Workspace app. This feature enables admins
to seamlessly migrate users from a StoreFront store to a Workspace store with minimal user inter-
action.

Consider, all your end users have a StoreFront store storefront.com added to their Workspace
app. As an administrator, you can configure a StoreFront URL to Workspace URL Mapping {‘store-
front.com’:’xyz.cloud.com’} in the Global App Configuration service. The Global App Configuration
service pushes the setting to all Citrix Workspace app instances, on both managed and unmanaged
devices that have the StoreFront URL storefront.comadded.

Once the setting is detected, Citrix Workspace app adds the mapped Workspace URL xyz.cloud.
com as another store. When the end user launches the Citrix Workspace app, the Citrix Workspace
store opens. The previously added StoreFront store storefront.comremains added to the Citrix
Workspace app. Users can always switch back to the StoreFront store storefront.comusing the
Switch Accounts option in the Citrix Workspace app. Admins can control the removal of the Store-
Front store storefront.com from the Citrix Workspace app at the users’end points. The removal
can be done through the global app config service.

To enable the feature, do the following steps:

1. Configure StoreFront to Workspace mapping using the Global App Configuration service. For
more information on the Global App config service, see Global App Configuration service.

2. Edit the payload in the app config service:

{
"serviceURL": Unknown macro: \{
Ilur-'Lll }

)

"settings":{

"name":"Productivity Apps'", [New Store Name]
"description":"Provides access StoreFront to Workspace Migration",
"useForAppConfig":true,

"appSettings":

{

"macos":[ Unknown macro: \{
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"category" }

]
}

X
}

Note:

If you’re configuring the payload for the first time, use POST.
If you’re editing the existing payload configuration, use PUT and check that you have the
payload that consists of all the supported settings.

3. Specify the StoreFront URL storefront. comasthe value for URL in the serviceURL section.
4. Configure the Workspace URL xyz.cloud. cominside the section migrationUrl.

5. Use storeFrontValidUntil to set the timeline for the removal of the StoreFront store from the
Citrix Workspace app. This field is optional. You can set the following value based on your re-
quirement:

« Valid date in the format (YYYY-MM-DD)
Note:

If you’ve provided a past date, then the StoreFront store is removed immediately
upon URL migration. If you’ve provided a future date, then the StoreFront store is
removed on the set date.

Once the app config service settings are pushed, the following screen appears:
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Introducing the new Citrix Workspace

Access everything you need to do your best work. You can complete most of your workflows
within Citrix Workspace.

Switch to Citrix Workspace now

Skip (3)

When the user clicks Switch to Citrix Workspace now, the Workspace URL is added to Citrix Work-
space app and the authentication prompt appears. Users have a limited option to delay the transition
up to three times.

Custom web store
Support for custom web stores

Starting with the 2112 version, you can access your organization’s custom web store from the Citrix
Workspace app for Mac. Previously, you accessed all customized stores through the browser only.
To use this feature, the admin must add the custom web store to the list of allowed URLs in the
allowedWebStoreURLs property in the Global App Configuration service.

Citrix Workspace app for Mac loads the custom web stores with a browser-like experience and extends
App Protection capabilities to custom web stores. Making the custom portal accessible from the native
Citrix Workspace App provides comprehensive capabilities and user experience for this feature. For
more information about Global App Configuration service, see Getting Started.

To add a custom web store URL, perform the following steps:

1. Open the Citrix Workspace app and navigate to Accounts.
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2. Inthe Accounts window, click the + icon and type the URL.
To delete a custom web store URL, perform the following steps:

1. Open the Citrix Workspace app and navigate to Accounts.

2. Inthe Accounts window, select the account you want to delete and click the - icon.

Support for customized URLs through 301 redirects

Starting with the 2106 version, you can add URLs that redirect to Citrix Workspace from StoreFront or
Citrix Gateway through HTTP 301 redirects.

If you’re migrating from StoreFront to Citrix Workspace, you can redirect the StoreFront URL to a Citrix
Workspace URL through an HTTP 301 redirect. As a result, when adding an old StoreFront URL, you’
re automatically redirected to Citrix Workspace.

Example of a redirect:

The StoreFrontURLhttps://< Citrix Storefront url>/Citrix/Roaming/Accounts
can be redirected to a Citrix Workspace URL: https://<Citrix Workspace url>/Citrix/
Roaming/Accounts.

Note:

« Citrix Workspace app for Mac does not support Dual Tone Multi Frequency (DTMF) with Mi-
crosoft Teams due to pending changes from Microsoft.

« Fromthe 2106 release onward, the Citrix Viewer’s version number and the Citrix Workspace
app’s version number might not match. This change does not affect your experience.

Email-based auto-discovery of store

Starting with the 2109 version, You can provide your email address in Citrix Workspace app for Mac
to automatically discover the store associated with the email address. If there are multiple stores
associated with a domain, by default the first store returned by the Global App Configuration service
is added as the store of choice. Users can always switch to another store if necessary.

Sign out of the custom web store when you close Citrix Workspace app

When the signoutCustomWebstoreOnExit setting is set to True, closing the Citrix Workspace app
window signs you out of the custom web store. When you reopen the Citrix Workspace app, the
web store URL is loaded again. You can configure the signoutCustomWebstoreOnExit setting in the
Global App Configuration service.
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Support for administrator to restrict the user from changing the store name

Previously, users were able to change the store name by using the Edit Account option.

Starting with the 2402 version, Citrix Workspace app for Mac provides administrators an option to
restrict the user from changing the store name. With this feature, administrators can easily identify
and maintain consistency in the store names.

To allow the end-users to change the store name, do the following steps:

1. Signin to Citrix Cloud with your credentials.

2. Navigate to Workspace Configuration >Access. Under Workspace URL, you can find a list of

existing store URLs.

Workspace Configuration

Access  Authentication  Customize  Servceltegrations  Sites  Aop Configuration

‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘

3. Click the ellipsis menu for the store that you want to allow end-users to change the store name.

4, Select Edit.

Default ' 1theme ) @ Enabled [zl

eeeeee @ Enabled

5. On the Edit Workspace URL dialog box, select Allow end-users to change this store name in
Workspace (not allowed by default).

Edit Workspace URL p ¢

Store name

| Allow end-users to change this store name in Workspace (not allowed by default).

6. Click Save.

For more information, see Restrict end users to change the store name in the Citrix Workspace docu-
mentation.
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Security and Authentication

July 9,2024

This section describes about the security features and authentication details for Citrix Workspace app
for Mac.

« Authentication
« Security
« Secure communications

Authenticate

December 16, 2024

Enhancing Citrix security with pre-populated user name

Starting with version 2411, administrators can use Mobile Device Management (MDM) to push the user
name in a specific format to manage devices. Citrix Workspace app reads this configuration, retrieves
the user name, and pre-populates it within the authentication prompt, making it read-only. This en-
sures that only end users to whom a Mac is registered can authenticate to the Citrix Workspace app on
that specific machine. This feature enhances sign-in security and gives administrators greater control
over authentication.

You can configure this feature through MDM using the following settings:

<array>
<dict>
<key>LockUserName</key>
<true/>
<key>CitrixUserName</key>
<string>UserNameValue</string>
</dict>
</array>
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User name:

Password:

Sign In

S'E'l: ure connection

Limitations:

+ This solution works only with on-premises stores that use basic authentication.
« Itis not compatible with SAML (WebView) authentication.
« The scopeis limited to the Citrix Workspace app and browser-based logins are not managed.

For more information on how to use MDM, see Mobile Device Management.

Mandate end users to authenticate and access apps and desktops through native app

Starting with version 2411, admins can mandate users on Mac devices to access Citrix Workspace app
exclusively through the native app. When this feature is enabled, users attempting to access the store
URL and third-party browsers are automatically redirected to the Citrix Workspace app. This ensures
they can take advantage of all the native app’s capabilities and enjoy a seamless user experience.
Also, users connecting through a browser while invoking the HDX engine are prompted to add the
store to the native client for future access. This feature also gives admins greater control over the
user environment and enhances security by keeping the authentication process within the native app,
eliminating the need to download ICA files.

Admins can enable this feature using their Citrix Cloud account. This feature is currently supported
for Cloud stores only. For more information, see Mandate end users to authenticate and access apps
and desktops through native app.

Enhancements to the smart card reader authentication

Starting with the version 2409, Citrix Workspace app supports the plug and play functionality for the
smart card readers. With this feature, users can conveniently use their smart cards without needing
to manually connect the reader before launching an ICA session. The system automatically detects
and initializes the reader once the smart card is inserted.
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Also, Citrix Workspace app handles concurrent smart card command requests more efficiently. When
multiple processes on the Virtual Delivery Agent (VDA) read the smart card simultaneously, the redi-
rection speed is improved.

These enhancements ensure a smoother user experience while using the smart card reader for au-
thentication.

Support for fast smart card

Starting with the version 2409, Citrix Workspace app supports the Fast smart card feature. Fast Smart
card is an improvement over the existing HDX PC/SC-based smart card redirection. It improves per-
formance significantly when smart cards are used in high-latency WAN environments.

Enabling the fast smart card logon on Citrix Workspace app

To enable this feature, you need to specify the location of the PKCS#11 library file on the Smart card
settingsin Citrix Workspace app preferences. For more information, see Specifyinga PKCS#11 module
for smart card authentication.

Disabling the fast smart card logon on Citrix Workspace app

To disable fast smart card logon on Citrix Workspace app, set the “PKCS#11 module”in Citrix Work-
space app Preferences to “None Selected”.

Note:
« Fast smart card logon is enabled by default on the VDA and disabled by default on Citrix
Workspace app.
« Earlier versions of Citrix Workspace app for Mac employed the PKCS#11 module to estab-
lish SSL connections, rather than relying on smart card redirection and authentication.
Presently, fast smart cards on Citrix Workspace app for Mac exclusively support cards that

use the RSA algorithm. Attempting to configure an incompatible PKCS#11 module can

lead to authentication failure.

Smart card

Citrix Workspace app for Mac supports smart card authentication in the following configurations:

« Smart card authentication to Workspace for Web or StoreFront 3.12 and later.

« Citrix Virtual Apps and Desktops 7 2203 and later.
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+ XenApp and XenDesktop 7.15 and later.

« Smart card-enabled applications, such as Microsoft Outlook and Microsoft Office that allow
users to digitally sign or encrypt documents available in virtual desktop or application sessions.

« Citrix Workspace app for Mac supports using multiple certificates with a single smart card or
with multiple smart cards. When your user inserts a smart card into a card reader, the certifi-
cates are available to all applications running on the device, including Citrix Workspace app for
Mac.

« For double-hop sessions, a further connection is established between Citrix Workspace app for
Mac and your user’s virtual desktop.

About smart card authentication to Citrix Gateway

There are multiple usable certificates when you use a smart card to authenticate a connection. Citrix
Workspace app for Mac prompts you to select a certificate. After you select a certificate, Citrix Work-
space app for Mac prompts you to enter the smart card password. Once authenticated, the session
launches.

If there’s only one suitable certificate on the smart card, Citrix Workspace app for Mac uses that cer-
tificate and does not prompt you to select it. However, you must still enter the password associated
with the smart card to authenticate the connection and to start the session.

Specifying a PKCS#11 module for smart card authentication
Note:

Installing the PKCS#11 module isn’t mandatory. This section only applies to ICA sessions. It
does not apply to Citrix Workspace access to Citrix Gateway or StoreFront where a smart card is
required.

To specify the PKCS#11 module for smart card authentication:

In Citrix Workspace app for Mac, select Preferences.
Click Security & Privacy.
In the Security & Privacy section, click Smart Card.

W

In the PKCS#11 field, select the appropriate module. Click Other to browse to the location of
the PKCS#11 module if the module you wanted isn’t listed.
5. After selecting the appropriate module, click Add.
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Supported readers, middleware, and smart card profiles

Citrix Workspace app for Mac supports most macOS-compatible smart card readers and cryptographic
middleware. Citrix has validated the operation with the following.

Supported readers:
« Common USB connect smart card readers
Supported middleware:

« Clarify
« Activldentity client version
+ Charismathics client version

Supported smart cards:

« PIV cards
« Common Access Card (CAC)
« Gemalto .NET cards

Follow the instructions provided by your vendor’s macOS-compatible smart card reader and crypto-
graphic middleware for configuring user devices.

Restrictions

« Certificates must be stored on a smart card, not on the user device.

« Citrix Workspace app for Mac does not save the user certificate choice.

« Citrix Workspace app for Mac does not store or save the user’s smart card PIN. OS handles the
PIN acquisitions, which might have its own caching mechanism.

« Citrix Workspace app for Mac does not reconnect sessions when a smart card is inserted.

+ To use VPN tunnels with smart card authentication, you must install the Citrix Gateway Plug-in
and log on through a webpage. Use your smart cards and PINs to authenticate at each step.
Pass-through authentication to StoreFront with the Citrix Gateway Plug-in isn’t available for
smart card users.

Conditional Access with Azure Active Directory

This authentication method is currently not supported on Citrix Workspace app for Mac.
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User-Agent

Citrix Workspace app sends a user agent in network requests that can be used to configure authenti-

cation policies including redirection of authentication to other Identity Providers (IdPs).

Note:

Don’t mention the version numbers while configuring the policies.

Scenario

Regular HTTP Requests

Cloud Store

OnPrem Store with Gateway
Advanced Auth

Custom Web Store

Description

In general, a network request
made by Citrix Workspace app
contains a general User-Agent.

For example, the following
network requests contain a

eneral User-Agent

hen users add a_cloud store to

GET. /C|tr|x/Roam|ng/A%counts
Citrix Workspace app, the
GET / AGServices/discover
network requests made by

Citrix Workspace app contains

Whescisesseddgant.

on-premises store with
Rdransathielthaovdiguesliests
watieyyathto Citrix Workspace
prpelbermedetpslitiegtiests
coardginy & ¥padifierkspagaepp.
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FIDO2 for password-less authentication

User-Agent

CitrixReceiver
/23.05.0.36 MacOSX
/13.4.0 com.citrix.
receiver.nomas
X1Class CWACapable

Mozilla/5.0 (
Macintosh; Intel Mac
0S X 10_15_7)
AppleWebKit/605.1.15
NerTML3/%iRe (Gecko)
Maernkowbskipsed Mac
?33X03001367NMac0SX
#pBlaWebKom/685r1x15
CKHENLe r libmaGecko) ,
KWAWEBYIEWAR3p8bH1E.36

Mozilla/5.0 (
Macintosh; Intel Mac
0S X 10_15_7)
AppleWebKit/605.1.15
(KHTML, like Gecko)
Safari CWA/23.05.0.18
Mac0SX/13.4.0

Citrix Workspace app for Mac supports password-less authentication using FIDO2 security keys when
connecting to a cloud store or within an HDX session. FIDO2 security keys provide a seamless way for

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 194



Citrix Workspace app for Mac

enterprise employees to authenticate to apps or desktops that support FIDO2 without entering a user
name or password. This feature currently supports roaming authenticators (USB only) with PIN code
and touchlD. This feature is supported on macOS 12 and later versions.

For more information about FIDO2 see FIDO2 Authentication.

For information about the prerequisites and using this feature, see Local authorization and virtual
authentication using FIDO2.

FIDO2-based authentication when connecting to cloud and on-premises store

Citrix Workspace app uses the user’s default browser for FIDO2 authentication (Web Authentication),
when connecting to the cloud and on-premises stores. Administrators can configure the type of
browser to authenticate to Citrix Workspace app. For more information on the web browser settings,
see Global App Configuration service documentation.

The following settings allow you to select the type of browser that is used for authenticating an end
user into Citrix Workspace app:

Settings Description

System Allows you to use the user’s default browser for
authentication (for example, Safari or Chrome).
Authentication occurs outside Citrix Workspace
app. Use this setting to support passwordless
authentication. This setting tries to use the
existing user session from the user’s browser.

SystemWithPrivateSession This setting is similar to the System setting.
Citrix Workspace app uses a private session in
the browser for authentication. The browser
doesn’t save authentication cookies or data.
Single sign-on isn’t supported in this option.

Embedded Allows you to authenticate within Citrix
Workspace app. Citrix Workspace app saves the
session data or cookies for single sign-on (for
example, SaaS apps) when the enhanced single
sign-on feature is enabled. This authentication
method does not support passwordless
authentications such as FIDO2.

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 195


https://fidoalliance.org/fido2/
https://docs.citrix.com/en-us/citrix-virtual-apps-desktops/secure/fido2.html
https://docs.citrix.com/en-us/citrix-virtual-apps-desktops/secure/fido2.html
https://developer-docs.citrix.com/en-us/server-integration/global-app-configuration-service/getting-started#supported-settings-and-their-values-per-platform
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/whats-new/features-in-technical-preview#support-for-an-enhanced-single-sign-on-sso-experience-for-web-and-saas-apps
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/whats-new/features-in-technical-preview#support-for-an-enhanced-single-sign-on-sso-experience-for-web-and-saas-apps

Citrix Workspace app for Mac

Settings

Description

EmbeddedWithPrivateSession This setting is similar to the Embedded setting.

Single sign-on isn’t supported as session data or
cookies aren’t present in Citrix Workspace app.

To push the configured settings, run the following commands using the Mobile Device Management

(MDM), Global App Configuration service (GACS), or the command line interface methods:

+ Enable FIDO2 using MDM: To enable authentication through MDM, administrators must use

the following setting:

<key>WebBrowserForAuthentication</key><string>System</string>

For more information on how to use MDM, see Mobile Device Management.

+ Enable FIDO2 using GACS: To enable authentication through GACS, administrators must use

the following setting:
{
"serviceURL": {

"url": "https://serviceURL:443"
}

"settings": {

"name": "Web browser for Authenticating into Citrix Workspace",

"description": "Allows admin to select the type of browser used

for authenticating an end user into Citrix Workspace app",

"useForAppConfig": true,
"appSettings": {

"macos": [

{

"assignedTo": [
"AllUsersNoAuthentication"

1,
"category": "authentication",
"settings": [
{
"name": "web browser for authentication",
"value": "SystemWithPrivateSession"
}

1,
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"userOverride": false

}

+ Enable FIDO2 using the command-line interface: To enable authentication using the
command-line interface, administrators must run the following command:

defaults write com.citrix.receiver.nomas WebBrowserForAuthentication

System

FIDO2-based authentication within an HDX session

You can configure FIDO2 Security Keys to authenticate within an HDX session. This feature currently
supports roaming authenticators (USB only) with PIN code.

When you access an app or a website that supports FIDO2, a prompt appears, requesting access to
the security key. If you’ve previously registered your security key with a PIN (a minimum of 4 and a
maximum of 64 characters), then you must enter the PIN while signing in.

If you’ve registered your security key previously without a PIN, simply touch the security key to sign
in.

This feature is enabled by default for Citrix Workspace app for 2307 and future releases. You can dis-
able FIDO2 authentication using the Mobile Device Management (MDM) or command-line interface
methods by running the following commands:

+ Disable FIDO2 based authentication using MDM: To disable this feature through MDM, admin-
istrators must use the following setting:

<key>Fido2Enabled</key><false/>
For more information on how to use MDM, see Mobile Device Management.

+ Disable FIDO2 based authentication using the command-line interface: To disable this fea-
ture, run the following command in command-line interface methods:

defaults write com.citrix.receiver.nomas Fido2Enabled -bool NO
Support for device touch ID for FIDO2 password-less authentication

Previously, Citrix Workspace app supported FIDO2 password-less authentication through the roaming
authenticators (USB only) with PIN code and touch.
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Starting with the version 2405, Citrix Workspace app now supports device touch ID for FIDO2
password-less authentication, enhancing the sign-in experience for users. With this feature, users
can securely sign in to the store configured on the Citrix Workspace app using the device touch ID,
eliminating the need for passcodes or passwords. This feature enhances both the usability and
security of Citrix Workspace app for macOS users. This feature is enabled by default.

Support for Certificate-based authentication
Starting with the 2305 version, Workspace administrators can configure and enforce Azure Active Di-
rectory conditional access policies for users authenticating to Citrix Workspace app.

The following methods can be used to enable the authentication using conditional access:

+ Mobile Device Management (MDM)
+ Global App Configuration service (GACS)

The flag values read by Citrix Workspace app take precedence in the following order:

+ Mobile Device Management (MDM)
+ Global App Configuration service (GACS)

Enabling authentication using conditional access through MDM

To enable authentication using conditional access with Azure AD through MDM, admins must use the
following setting:

<key>enableAAD</key>
<true/>

This setting supports Boolean values. The value is set to false by default. The default value is consid-
ered if the key value isn’t available.

For more information on how to use MDM, see Mobile Device Management.

Enabling authentication using conditional access through GACS

To enable authentication using conditional access with Azure AD through GACS, admins must use the
following setting:

enable conditional AAD

For more information, see Supported settings and their values per platform for macOS in the GACS
documentation.
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Security

July 8,2024

App Protection

App Protection feature is an add-on feature that provides enhanced security when using Citrix Virtual
Apps and Desktops and Citrix DaaS (formerly Citrix Virtual Apps and Desktops service). The feature
restricts the ability of clients to compromise with keylogging and screen capturing malware. App Pro-
tection prevents exfiltration of confidential information such as user credentials and sensitive infor-
mation on the screen. For more information, see App Protection documentation.

Disclaimer

App Protection policies filter the access to required functions of the underlying operating sys-
tem (specific API calls required to capture screens or keyboard presses). App Protection policies
provide protection even against custom and purpose-built hacker tools. However, as operating
systems evolve, new ways of capturing screens and logging keys might emerge. While we con-
tinue to identify and address them, we can’t guarantee full protection in specific configurations
and deployments.

To configure App Protection on Citrix Workspace app for Mac, see the Citrix Workspace app for Mac
section in the Configuration article.

Note:

« App Protection is supported only from Citrix Workspace app 2001 for Mac or later.

App Protection enhancement

Starting with the 2301 version, App Protection is enhanced to protect the Citrix Workspace app. This
enhancement includes protecting the authentication screen and the screen that you see after signing
into the Workspace app.

Support for screen sharing when App Protection is enabled

Starting with the 2402 version, you can share content through Microsoft Teams with HDX optimiza-
tion, even when App Protection is enabled. With this feature, you can share a screen in the virtual
desktop session to its full potential. For more information, see Compatibility with HDX optimization
for Microsoft Teams.
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Force login prompt for Federated identity provider

Citrix Workspace app now honors the Federated Identity Provider Sessions setting. For more informa-
tion, see Citrix Knowledge Center article CTX253779.

You no longer need to use the Store authentication tokens policy to force the login prompt.

Inactivity timeout for Citrix Workspace app

Theinactivity timeout feature logs you out of the Citrix Workspace app based on avalue that the admin
sets. Admins can specify the amount of idle time that is allowed before a user is automatically signed
out of the Citrix Workspace app. You’re automatically signed out when no activity from the mouse,
keyboard, or touch occurs for the specified interval of time, within the Citrix Workspace app window.
The inactivity timeout does not affect the already running Citrix Virtual Apps and Desktops and Citrix
DaaS sessions or the Citrix StoreFront stores.

The inactivity timeout value can be set starting from 1 minute to 1440 minutes. By default, the inactiv-
ity timeout isn’t configured. Admins can configure the inactivityTimeoutinMinutes property by using
a PowerShell module. Click here to download the PowerShell modules for Citrix Workspace Configu-

ration.

The end-user experience is as follows:

+ Anotification appears three minutes before you’re signed out, with an option to stay signed in,
or sign out. The notification appears if you’ve enabled Citrix Workspace app notifications in the
system preferences of your Mac.

+ Thenotification appears only if the configured inactivity timeout value is greater than 5 minutes.
For example, if the configured value is 6 minutes, a notification appears when 3 minutes of in-
activity is detected. If the configured inactivity timeout value is less than or equal to 5 minutes,
the user is signed out without a notification.

+ Users can click Stay signed in to dismiss the notification and continue using the app, in which
case the inactivity timer is reset to its configured value. You can also click Sign-out to end the
session for the current store.

Secure communications

July 9,2024

To secure the communication between your Site and Citrix Workspace app for Mac, you can integrate
your connections with a range of security technologies, including Citrix Gateway. For information
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about configuring Citrix Gateway with Citrix StoreFront, see
StoreFront documentation.

Note:

Citrix recommends using Citrix Gateway to secure communications between StoreFront servers
and users’devices.

« A SOCKS proxy server or secure proxy server (also known as security proxy server, HTTPS proxy
server). You can use proxy servers to limit access to and from your network and to handle con-
nections between Citrix Workspace and servers. Citrix Workspace app for Mac supports SOCKS
and secure proxy protocols.

« Citrix Secure Web Gateway. You can use Citrix Secure Web Gateway to provide a single, secure,
encrypted point of access through the internet to servers on internal corporate networks.

« SSL Relay solutions with Transport Layer Security (TLS) protocols

« Afirewall. Network firewalls can allow or block packets based on the destination address and
port. If you use a firewall that maps the server’s internal IP address to an external internet ad-
dress such as network address translation (NAT), configure the external address.

Note:

Starting with macOS Catalina, Apple has enforced extra requirements for root CA certificates and
intermediate certificates which administrators must configure. For more information, see Apple
Support article HT210176.

Citrix Gateway

To enable remote users to connect to your XenMobile deployment through Citrix Gateway, you can
configure Citrix Gateway to support StoreFront. The method for enabling access depends on the edi-
tion of XenMobile in your deployment.

If you deploy XenMobile in your network, allow connections from internal or remote users to Store-
Front through Citrix Gateway, by integrating Citrix Gateway with StoreFront. This deployment allows
users to connect to StoreFront to access published applications from XenApp and virtual desktops
from XenDesktop. Users connect through Citrix Workspace app for Mac.

Connecting with the Citrix Secure Web Gateway

If the Citrix Secure Web Gateway Proxy is installed on a server in the secure network, you can use the
Citrix Secure Web Gateway Proxy in Relay mode. For more information about Relay mode, see XenApp
and Citrix Secure Web Gateway documentation.

If you’re using Relay mode, the Citrix Secure Web Gateway server functions as a proxy and you must
configure Citrix Workspace app for Mac to use:
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+ The fully qualified domain name (FQDN) of the Citrix Secure Web Gateway server.
» The port number of the Citrix Secure Web Gateway server. Citrix Secure Web Gateway Version
2.0 does not support Relay mode.

The FQDN must list, in sequence, the following three components:

« Host name
 Intermediate domain
» Top-level domain

For example, my_computer.example.com is an FQDN, because it lists, in sequence, a host name
(my_computer), an intermediate domain (example), and a top-level domain (com). The combination
of intermediate and top-level domain (example. com) is referred to as the domain name.

Connecting through a proxy server

Proxy servers are used to limit access to and from your network, and to handle connections between
Citrix Workspace app for Mac and servers. Citrix Workspace app for Mac supports both SOCKS and
secure proxy protocols.

When the Citrix Workspace app for Mac communicates with the Web server, it uses the proxy server
settings configured for the default web browser on the user device. Configure the proxy server settings
for the default Web browser on the user device accordingly.

Provision to manage multiple proxy servers using PAC files

Starting with the version 2405, you can use multiple proxy servers that allow the HDX sessions to select
appropriate proxy servers for accessing specific resources. This selection is based on the proxy rules
configured in the Proxy Auto-Configuration (PAC) file. Using this file, you can manage the network by
mentioning which network traffic must be sent through a proxy server and which must be sent directly.
Additionally, the PAC URL supports both http:// and file:// protocols.

Connecting through a firewall

Network firewalls can allow or block packets based on the destination address and port. Citrix Work-
space app for Mac must be able to communicate through the firewall with both the Web server and
Citrix server. The firewall must permit HTTP traffic (often over the standard HTTP port 80 or 443 for a
secure Web server) for user device to Web server communication. For Citrix Workspace to Citrix server
communication, the firewall must permit inbound ICA traffic on ports 1494 and 2598.
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TLS

Transport Layer Security (TLS) is the latest, standardized version of the TLS protocol. The Internet
Engineering Taskforce (IETF) renamed it TLS when it took over responsibility for the development of
TLS as an open standard.

TLS secures data communications by providing server authentication, encryption of the data stream,
and message integrity checks. Some organizations, including U.S. government organizations, require
the use of TLS to secure data communications. These organizations might also require the use of
validated cryptography, such as Federal Information Processing Standard (FIPS) 140. FIPS 140 is a
standard for cryptography.

Citrix Workspace app for Mac supports RSA keys of 1024, 2048, and 3072-bit lengths. Root certificates
with RSA keys of 4096-bit length are also supported.

Note:

Citrix Workspace app for Mac uses platform (OS X) crypto for connections between Citrix Work-
space app for Mac and StoreFront.

The following cipher suites are deprecated for enhanced security:

« Cipher suites with prefix “TLS_RSA_*”

« Cipher suites RC4 and 3DES

o TLS_RSA_WITH_AES_256_GCM_SHA384 (0x009d)
o TLS_RSA_WITH_AES_128_GCM_SHA256 (0x009c)
o TLS_RSA_WITH_AES_256_CBC_SHA256 (0x003d)
o TLS_RSA_WITH_AES_256_CBC_SHA (0x0035)

o TLS_RSA_WITH_AES_128_CBC_SHA (0x002f)

o TLS_RSA_WITH_RC4_128_SHA (0x0005)

o TLS_RSA_WITH_3DES_EDE_CBC_SHA (0x000a)

Citrix Workspace app for Mac supports only the following cipher suites:

+ TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 (0xc030)
+ TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384 (0xc028)
+ TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA (0xc013)

For DTLS 1.0 users, Citrix Workspace app for Mac 1910 and later supports only the following cipher
suite:

+ TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA (0xc013)

Upgrade your Citrix Gateway version to 12.1 or later if you want to use DTLS 1.0. Otherwise, it falls
back to TLS based on the DDC policy.
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The following matrices provide details of internal and external network connections:

Direct connections

DTLS v1.2

Client cipher set VDA cipher set Open FIPS SP800-52 Open FIPS SP800-52 Open FIPS SP800-52

ANY Y
COM Y
Any GOV Y
ANY Y
COM Y
COM GOV Y
ANY Y
COoOM X
GOV GOV Y

TLS DTLS v1.0

Y Y Y Y
X X Y Y
Y Y Y Y
X X Y

X X Y

X X Y

Y Y X Y
X X X X
Y Y X Y

External connections with Citrix Gateway
DTLS v1.2

Client cipher set VDA cipher set Open FIPS SP800-52 Open FIPS SP800-52 Open FIPS SP800-52

ANY Y
CcoM Y
Any GOV Y
ANY Y
coM Y
COoOM Gov Y
ANY Y
COM X
GOV Gov Y

Note:

TLS DTLS v1.0
Y Y Y X
X X Y X
Y Y Y X
X X Y X
X X Y X
X X Y X
Y Y X X
X X X X
Y Y X X

«+ Use Citrix Gateway 12.1 or later for EDT to work properly. Older versions do not support

ECDHE cipher suites in DTLS mode.

« Citrix Gateway doesn’tsupportDTLS 1.2. So, TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
and TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384 aren’t supported. Citrix Gate-
way must be configured to use TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA to work

properly in DTLS 1.0.

Configuring and enabling Citrix Workspace app for TLS

There are two main steps involved in setting up TLS:
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1. Setup SSL Relay on your Citrix Virtual Apps and Desktops and Citrix DaaS (formerly Citrix Virtual
Apps and Desktops service) server. Then, obtain and install the necessary server certificate.

2. Install the equivalent root certificate on the user device.

Installing root certificates on user devices

To use TLS to secure communications between TLS-enabled Citrix Workspace app for Mac and the
server farm, you need a root certificate on the user device. This root certificate verifies the signature
of the Certificate Authority on the server certificate.

macOS X comes with about 100 commercial root certificates already installed. However, if you want
to use another certificate, you can obtain one from the Certificate Authority and install it on each user
device.

Install the root certificate on each device, depending on your organization’s policies and procedures,
instead of prompting users to install it. The easiest and safest way is to add root certificates to the
macOS X keychain.

To add a root certificate to the keychain

1. Double-click the file containing the certificate. This action automatically starts the Keychain
Access application.
2. Inthe Add Certificates dialog box, choose one of the following from the Keychain pop-up menu:

« login (The certificate applies only to the current user.)
« System (The certificate applies to all users of a device.)

3. Click OK.
4. Type your password in the Authenticate dialog box and then click OK.

The root certificate is installed and used by TLS-enabled clients and by any other application using
TLS.

About TLS policies

This section provides information for configuring security policies for ICA sessions over TLS. You can
configure certain TLS settings used for ICA connectionsin Citrix Workspace app for Mac. These settings
are not exposed in the user interface. Changing them requires running a command on the device
running Citrix Workspace app for Mac.
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Note:

TLS policies are managed in other ways - by devices controlled by an OS X server or another
mobile device management solution.

TLS policies include the following settings:

SecurityComplianceMode. Sets the security compliance mode for the policy. If you don’t config-
ure SecurityComplianceMode, FIPS is used as the default value. Applicable values for this setting in-
clude:

« None. No compliance mode is enforced
« FIPS. FIPS cryptographic modules are used
« SP800-52. NIST SP800-52r1 compliance is enforced

defaults write com.citrix.receiver.nomas SecurityComplianceMode SP800
-52

SecurityAllowedTLSVersions. Specifies the TLS protocol versions that are accepted during protocol
negotiation. This information is represented as an array and any combination of the possible values
is supported. When this setting isn’t configured, the values TLS10, TLS11, and TLS12 are used as the
default values. Applicable values for this setting include:

+ TLS10. Specifies that the TLS 1.0 protocol is allowed.
« TLS11. Specifies that the TLS 1.1 protocol is allowed.
« TLS12. Specifies that the TLS 1.2 protocol is allowed.
+ TLS13. Specifies that the TLS 1.3 protocol is allowed.

defaults write com.citrix.receiver.nomas SecurityAllowedTLSVersions -
array TLS11 TLS12

SSLCertificateRevocationCheckPolicy. Improves the cryptographic authentication of the Citrix
server and improves the overall security of the SSL/TLS connections between a client and a server.
This setting governs the handling of a trusted root certificate authority (CA) while opening a remote
session through SSL when using the client for OS X.

When you enable this setting, the client checks whether the server’s certificate is revoked. There are
several levels of certificate revocation list checking. For example, the client can be configured to check
only its local certificate list, or to check the local and network certificate lists. In addition, certificate
checking can be configured to allow users to log on only if all Certificate Revocation lists are verified.

Certificate Revocation List (CRL) checking is an advanced feature supported by some certificate is-
suers. It allows admins to revoke security certificates (invalidated before their expiry date) if there is
cryptographic compromise of certificate private keys, or unexpected changes in the DNS name.

Applicable values for this setting include:
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+ NoCheck. No Certificate Revocation List check is performed.

+ CheckWithNoNetworkAccess. Certificate revocation list check is performed. Only local cer-
tificate revocation list stores are used. All distribution points are ignored. Finding a Certificate
Revocation List isn’t critical for verification of the server certificate that presented by the target
SSL Relay or Citrix Secure Web Gateway server.

+ FullAccessCheck. Certificate Revocation List check is performed. Local Certificate Revocation
List stores and all distribution points are used. Finding a Certificate Revocation List isn’t critical
for verification of the server certificate presented by the target SSL Relay or Citrix Secure Web
Gateway server.

+ FullAccessCheckAndCRLRequired. Certificate Revocation List check is performed, excluding
the root Certificate Authority. Local Certificate Revocation List stores and all distribution points
are used. Finding all required Certificate Revocation Lists is critical for verification.

+ FullAccessCheckAndCRLRequiredAll. Certificate Revocation List check is performed, includ-
ing the root certificate authority. Local Certificate Revocation List stores and all distribution
points are used. Finding all required Certificate Revocation Lists is critical for verification.

Note:

If you don’t set SSLCertificateRevocationCheckPolicy, FullAccessCheck is used as the default

value.

defaults write com.citrix.receiver.nomas SSLCertificateRevocationCheckPolicy
FullAccessCheckAndCRLRequired

Configuring TLS policies

To configure TLS settings on an unmanaged computer, run the defaults command in Terminal.app.

defaults is a command line application that you can use to add, edit, and delete app settings in an 0OS
X preferences list file.

To change settings:

1. Open Applications > Utilities \ > Terminal.

2. In Terminal, run the command:

defaults write com.citrix.receiver.nomas <name> <type> <value>
Where:
<name>: The name of the setting as described earlier.

<type>: A switch identifying the type of the setting, either -string or -array. If the setting type is a
string, this setting can be omitted.
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<value>: The value for the setting. If the value is an array and multiple values need to be specified,
separate the values with a space.

defaults write com.citrix.receiver.nomas SecurityAllowedTLSVersions -
array TLS11 TLS12

Reverting to the default configuration

To reset a setting back to its default:

1. Open Applications > Utilities \ > Terminal.

2. In Terminal, run the command:

defaults delete com.citrix.receiver.nomas <name>
Where:
<name>: The name of the setting as described earlier.

defaults delete com.citrix.receiver.nomas SecurityAllowedTLSVersions

Security settings

Security improvements and enhancements were introduced with Citrix Receiver for Mac version 12.3,
including the following:

« improved security configuration user interface. In previous releases, the command line was the
preferred method to make security-related changes. Configuration settings related to session
security are now simple and accessible from the Ul. This improvement improves the user expe-
rience while creating a seamless method for the adoption of security-related preferences.

« view TLS connections. You can verify connections that use a specific TLS version, encryption
algorithms, mode, key size, and SecurelCA status. In addition, you can view the server certificate
for TLS connections.

The improved Security and Privacy screen includes the following new options in the TLS tab:

« set the compliance mode

+ configure the crypto module

+ select the appropriate TLS version

+ select the certificate revocation list

+ enable settings for all TLS connections
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The following image illustrates the Security and Privacy settings accessible from the Ul:

r

@ Security & Privacy ! C 4l »”
General Accounts File Access Devices
TLS  Smart Card  Privacy
These settings allow you to control how TLS is configured for secure HDX
connections.
Compliance mode: None
Crypto module: Standard
TLS versions; + TLSv1.0, TLSv1.1 and TLSv1.2
Certificate revocation list; TLSv1.1and TLSv1.2
TLSv1.2
TLSv1.0, TLSv1.1, TLSv1.2 and TLSv1.3
Restore Defaults
[
App experience
July 10, 2024
This section describes the following:
+ Application delivery
» Enhanced virtual apps and desktops launch experience for Workspace (Cloud users only)
« App preferences
+ Data collection and monitoring
Application delivery
July 8,2024
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When delivering applications with Citrix Virtual Apps and Desktops and Citrix Daa$, consider the fol-
lowing options to enhance the experience for your users when they access their applications:

Web access mode

Without any configuration, Citrix Workspace app for Mac provides web access mode: browser-based
access to applications and desktops. Users simply open a browser to a Workspace for Web and select
and use the applications that they want. In web access mode, no app shortcuts are placed in the App
Folder on your user’s device.

Self-service mode

Add a StoreFront account to Citrix Workspace app for Mac or configure Citrix Workspace app for Mac to
point to a StoreFront site. Then, you can configure the self-service mode, which enables your users to
subscribe to applications through Citrix Workspace app for Mac. This enhanced user experience is sim-
ilar to that of a mobile app store. In self-service mode you can configure mandatory, auto-provisioned,
and featured app keyword settings as needed. When one of your users selects an application, a short-
cut to that application is placed in the App Folder on the user device.

When they access a StoreFront 3.0 site, your users see the Citrix Workspace app for Mac preview.

When publishing applications on your Citrix Virtual Apps farms, you can enhance the experience for
users accessing those applications through StoreFront stores. Ensure that you include meaningful de-
scriptions for the published apps. The descriptions are visible to your users through Citrix Workspace
app for Mac.

Configure self-service mode

As mentioned previously, you can add a StoreFront account to Citrix Workspace app for Mac or config-
ure Citrix Workspace app for Mac to point to a StoreFront site. Thus, you can configure the self-service
mode, which allows users to subscribe to applications from the Citrix Workspace app for Mac user
interface. This enhanced user experience is similar to that of a mobile app store.

In self-service mode, you can configure mandatory, auto-provisioned, and featured app keyword set-
tings as needed.

+ Automatically subscribe all store users to an app by appending the string ‘KEYWORDS:Auto’to
the app description when publishing it in Citrix Virtual Apps. The app is provisioned automati-
cally without requiring a manual subscription when users log in to the store.

+ Advertise applications to users or make commonly used applications easier to find by listing
them in the Citrix Workspace app for Mac Featured list. To list apps in the Mac Featured list,
append the string *xKEYWORDS : Featured** to the app description.
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For more information, see StoreFront documentation.

Enhanced virtual apps and desktops launch experience for Workspace

July 10, 2024

The opening experience of Citrix resources has been enhanced to be more intuitive, informative, and
user-friendly. From the 2311 version, this feature is supported for custom web stores and hybrid
launch.

&  Citrix Workspace  Edit  Window Help. 0 @ ¢ ¥ &= =W = Q B Fri3Nov 11:34AM

@Citrix Workspace

Good morning
Friday, November 03, 2023

Home  Apps  Desktops

Excel 2016

The launch progress notification now appears at the lower-right corner of your screen. A progress
status of the resources, which are in the process of being opened is shown. You cannot retrieve the
notification once you dismiss it. The notification stays for a few seconds from the time you start the
session. If the session fails to start, then the notification shows the failure message.
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@ WSVDA
Close

0 Failed to start

Your session "WSVDA" did not launch successfully due to
error code "2519". Please contact your administrator for
more information about the error.

4ABESB08-9D94-4A40-8DB3-1A828EBOCA3A

If the problem persists, contact your admin with this
transaction ID.

b

This feature is supported on cloud, on-premises and custom web portals deployments.

App preferences

July 16, 2024

Opened apps appear in the dock with native app icons

Previously, clicking virtual apps in the Citrix Workspace app triggered the Citrix Viewer where these
apps would be available. If you open many apps, the apps or its instances are opened in the Citrix
Viewer. You can view the open apps by right-clicking the Citrix Viewer icon.
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Presentationl - PowerPoint
Presentation2 - PowerPoint

Sign in to your account - Google Chrome
Documant] - Ward

Dptlans

Show All Windows

Starting with the 2305 version, when you open virtual apps, they appear in the Dock (bottom-right
corner of the screen) with their respective icons and are easily identifiable. You can then access the
virtual app from the dock itself. If you open multiple instances of an app, these instances aren’t du-
plicates in the Dock but are grouped within one instance in the Dock.

Improved Mission Control and App Expose experience

Previously, using the Mission Control or App Expose feature in a virtual app session resulted in the
overlapping of many windows that were opened.

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 213



Citrix Workspace app for Mac

Google = 4 Google

[Tl

Starting with the 2210 version, when you use the Mission Control or App Expose feature in a virtual
app session and open many windows, the windows do not overlap, and you can easily choose from
among them.
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Enhanced menu bar support

Starting with the 2301 version, the CWA fully supports the Automatically hide and show the menu
bar in full screen option in macOS. For versions earlier than macOS 13, you must navigate to System
Preferences > Dock & Menu Bar and clear the Automatically hide and show the menu bar in full
screen option. FormacOS 13 and later versions, you must navigate to System Preferences > Desktop
& Dock and clear the Automatically hide and show the menu bar in full screen option. You have
the provision to either enable or disable this option. Thisenhancement also supports high DPI scaling.
The mouse position also appears accurate in all the external monitors connected.

The following figure illustrates a window where the menu bar is hidden:

The following figure illustrates a window where the menu bar appears:
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@ Citrix Viewer View Devices Debug

Fecyele Bin

Ju

Adobe
Acrobat DC

Support for horizontal scroll

Previously, Citrix Workspace app for Mac supported only vertical scroll on a trackpad. Starting with
the 2305 version, a horizontal scroll is also supported.

Enhanced auto start experience

Previously, Citrix Workspace app for Mac used to start automatically whenever a computer was turned
on. Starting with the 2304 version, you can choose to disable or enable the auto start feature on Citrix
Workspace app for Mac by navigating to Preferences > General > Start Workspace on system startup.
The auto start setting is enabled by default.

General . ! La

Accounts  File 55 Da
App access across devices: Reconnect apps when | sign in to Workspace
»~ Reconnect apps when | start or refresh apps

Menu bar: & Show Waorksnace in menu har

Auto Start: & Start Workspace on system startup

High DPI: Enable and match client DPI scale settings

Passwords: Delete Passwords...

File download location: | &8 Downloads
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Workspace Control

Workspace Control lets desktops and applications follow users as they move between devices. For
example, clinicians in hospitals to move from workstation to workstation without having to restart
their desktops and applications on each device.

Policies and client drive mappings change appropriately when you move to a new user device. Poli-
cies and mappings are applied according to the user device where you’re currently logged on to the
session. Forexample, a healthcare worker can sign out from a device in the emergency room and sign-
in to a workstation in the X-ray laboratory. The policies, printer mappings, and client drive mappings
appropriate for the session in the X-ray laboratory go into effect for the session in the X-ray labora-
tory.

To configure workspace Control settings

1. Click the down arrow icon B in the Citrix Workspace app for Mac window and choose Prefer-
ences.

2. Click the General tab.

3. Choose one of the following:

+ Reconnect apps when | start Citrix Workspace app. Allows users to reconnect to discon-
nected apps when they start Citrix Workspace app.

« Reconnect apps when | start or refresh apps. Allows users to reconnect to disconnected
apps either when they start apps or when they select Refresh Apps from the Citrix Work-
space app for Mac menu.

View apps, desktops, and Citrix Enterprise Browser from the menu bar through a
quick access menu

You can now view your most recently used or favorite apps and desktops or open a Citrix Enterprise
Browser window by clicking the Citrix Workspace icon in the menu bar. This feature provides easy
access to some of your resources without having to open the Citrix Workspace app.
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©@ @ v

Recents Favorites
Apps

B Access 2016

Concur
Excel 2016

Bitbucket -code
¢ Chrome

View all applications
Desktops

B8 Managed Win10 SIN Desktop

View all desktops

Version: 22.06.0.0 (2206)

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 218



Citrix Workspace app for Mac

If you’ve not configured any accounts, a sign-in prompt appears.

@ © ©)

7/

A maximum of 5 of your recently used or favorite apps or desktops appear in the options under the
Recent and Favorites tabs respectively. To view the other apps in the Citrix Workspace app, click View
all applications. To view the other desktops in the Citrix Workspace app, click View all desktops.
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©@ @ v

Recents Favorites
Apps

B Access 2016

Concur
Excel 2016

Bitbucket -code
¢ Chrome

View all applications
Desktops

B8 Managed Win10 SIN Desktop

View all desktops

Version: 22.06.0.0 (2206)
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You can open the Citrix Workspace Ul by clicking the Citrix Workspace app icon.

| © v

Recents Favorites

You can open the Citrix Enterprise Browser, without opening a web or Saa$ app by clicking the Citrix
Enterprise Browser icon.

¢ [o] ©

Note:

The Citrix Enterprise Browser isn’t available if the configured store doesn’t have any web or Saa$S
apps. Further, it’s available only if your admin has configured Citrix Secure Private Access.
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©@ ©
Signin
Preferences

Check for updates

About

Quit

You can view the following options when you click the Account icon in the top-right corner:

« Preferences

« Check for updates
» About

o Quit
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Quick access menu for StoreFront

Starting with the 2307 version, you can navigate to your favorite apps and desktops quickly and eas-
ily using the quick access feature for on-premises stores. To enable quick access, right-click Citrix
Workspace in the toolbar, navigate to Preferences > General, and then select Show Quick Access
for Storefront experience. This feature allows you to see your favorite data directly from the Mac
menu bar.

HESER0NGOES-NPANERCEC G000 ~w .9

You can enable the quick access feature by using Preferences.

General . 2

Accounts File Access Devices
App access across devices: Reconnect apps when | sign in to Workspace
Reconnect apps when | start or refresh apps

Menu bar: Show Workspace in menu bar

Show Quick Access for Storefront experience

Auto Start: & Start Workspace on system startup

High DPI: Enable and match client DPI scale settings

Passwords: Delete Passwords...

File download location: | Ask for each download £

Administrators can enable or disable the quick access feature by using the Mobile Device Management
(MDM) or Global App Configuration service (GACS) methods.

Enabling or disabling quick access using MDM

To enable quick access through MDM, administrators must use the following settings:

<key>ShowQuickAccessForStoreFront</key>
<false/>

For more information on how to use MDM, see Mobile Device Management.
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Enabling or disabling quick access using GACS

To enable quick access through GACS, administrators must use the following settings:

enableQuickAccessForStoreFront

Support for Activity Manager on the quick access menu for cloud stores

Starting with the version 2405, Citrix Workspace app for Mac supports the Activity Manager feature.
This feature lets end users view and interact with all their active apps and desktop sessions at one
place. You can disconnect or terminate the active sessions directly from the Activity Manager.

To view active sessions in the Activity Manager, select the Citrix Workspace app icon from the menu
bar and then click Activity Manager.

@ € 8 A

Recents Favorites Activity Manager

ON THIS DEVICE

Desktops
B TSVDA
Applications (AWTSVDA-0001) e
Calculator X
/ Paint )4
- Command Prompt X

You can perform the following actions on the active desktop sessions by clicking the respective ellip-
sis(...) button.

» Disconnect: The remote session is disconnected, but the apps and desktops are active in the
background.
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+ Log out: Logs out from the current session. All the apps in the sessions are closed, and any
unsaved files are lost.

« Shut Down: Closes your disconnected desktops.

« Force Quit: Forcefully powers off your desktop in case of a technical issue.

+ Restart: Shuts down your desktop and starts it again.

For active seamless app session, you can terminate the app session by clicking the close (X) button.

For more information, see Activity manager.

Battery status indicator

The battery status of the device now appears in the notification area of a Citrix Desktop session.
To view the battery status within the desktop session, click the Show hidden icons arrow in the
taskbar.

Charging: 100% g

7
[~ oo

Note:

The battery status indicator does not appear for server VDAs.

Citrix Casting

Citrix Casting is used to cast your Mac screen to nearby Citrix Ready workspace hub devices. Citrix
Workspace app for Mac supports Citrix Casting to mirror your Mac screen to workspace hub connected
monitors.

For more information, see the Citrix Ready workspace hub documentation.

Prerequisites

« Latest supported version of Citrix Workspace app.
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+ Bluetooth enabled on the device for hub discovery.

« Both Citrix Ready workspace hub and Citrix Workspace app must be on the same network.

+ Ensure Port 55555 isn’t blocked between the device running Citrix Workspace app and the Citrix
Ready workspace hub.

« Port 55556 is the default port for SSL connections between mobile devices and the Citrix Ready
workspace hub. You can configure a different SSL port on the Raspberry Pi’s settings page. If
the SSL port is blocked, users can’t establish SSL connections to the workspace hub.

« For Citrix Casting, ensure port 1494 isn’t blocked.

Enable Citrix Casting

Citrix Casting is disabled by default. To enable Citrix Casting using Citrix Workspace app for Mac:

1. Goto Preferences.
2. Select Advanced in the panel and then choose Citrix Casting.
3. Select Yes, enable casting.

O Advanced

o g & e

General Accounts File Access Devices Mic & Webcam Keyboard Security & Privacy Advanced

Do you want to enable casting to Workspace Hub enabled devices?

© Yes, enable casting

No, don't enable casting

A notification appears when Citrix Casting is launched and a Citrix Casting icon appears in the menu
bar.

Note:
After enabling, Citrix Casting launches with Citrix Workspace app for Mac automatically every

time until you disable it by selecting No, don’t enable casting in Preferences > Advanced >
Citrix Casting.
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Discover workspace hub devices automatically

To connect to workspace hubs automatically:

1. Onyour Magc, sign in to Citrix Workspace app and ensure that Bluetooth is turned on. Bluetooth
is used to discover nearby workspace hubs.

2. Select the Citrix Casting icon in the menu bar. All Citrix Casting functions are operated through
this menu.

3. The Hub List submenu shows all nearby workspace hubs on the same network. Hubs are listed
in descending order by their proximity to your Mac and display their workspace hub configured
names. All automatically discovered hubs display under Nearby Hubs.

4. Choose the hub that you want to connect to by selecting its name.

Pleea L 3 = <

Not Connected

100% B3 Tue

Hub List Manual
Manage

About
Quit

Nearby Hubs
hub-geg-102
WorkspaceHub-1
NTDB827EB434DF8
hub-automation
NTDB827EB647241
NTDB827EB39CB71
LeiJ-Hub
ComboHub
]

To cancel selection of a workspace hub during connection, select Cancel. You can also use Cancel if
the network connection is poor and connecting is taking longer than usual.

Note:

Occasionally, your chosen hub might not appear in the menu. Check the Hub List menu again
after a few moments or add your hub manually. Citrix Casting receives the workspace hub’s
broadcasting periodically.

Discover workspace hub devices manually

If you can’t find the Citrix Ready workspace hub device in the Hub List menu, add the workspace hub’
s IP address to access it manually. To add a workspace hub:

1. Onyour Magc, sign in to Citrix Workspace app and ensure that Bluetooth is turned on. Bluetooth
is used to discover nearby workspace hubs.
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Select the Citrix Casting icon in the menu bar.
Select Manage in the menu. The Manage hubs window appears.
Click Add new to enter the IP address of your hub.

ok w

After successfully adding the device, the Hub name column displays the hub’s friendly name.
Use this name to identify the hub in the Manual section of the Hub List submenu.

Note:

Currently, only Mirror mode is supported. Mirror is the only available choice in the Display
Mode column.

Disconnect the workspace hub device

You can disconnect your current session and exit the Citrix Ready workspace hub automatically or
manually.

+ To disconnect the screen casting session automatically, close your laptop.

+ To disconnect the screen casting session manually:

1. Select the Citrix Casting icon.

2. In the list of hubs, select the name of your workspace hub. The Disconnect option appears to
the right.

3. Select Disconnect to exit the hub.

O . BE@EB 2 =« 100% @3 Fri 3:04:26

Connected
v HaiyangTest146 Disconnect

Hub List

Manage een Shot PDF Documents
11...32.15 PM
About

Quit

Known issues

+ There are small latency issues when viewing the mirrored screen. In poor network conditions,
latency might be even longer.
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« When SSL is enabled in a Citrix Ready workspace hub and the hub’s certificate isn’t trusted, an
alert window appears. To solve the issue, add the certificate to your trusted certificate list with
the Keychain tool.

Support for Citrix Workspace widgets

Starting with the 2405 version, Citrix Workspace app for Mac supports widgets for quick access to
its virtual apps and desktops. With this feature, you can easily access your favorite virtual apps and
desktops from the widget that is added to your desktop or Notification centre.

Citrix Workspace supports two types of widgets, small and large widgets. The small widget can hold
either one virtual app or desktop. The large widget can hold six favorite virtual apps and desktops
with desktop listed at first.

All Widgets @ Citrix Workspace

F ) Tsvdal9
\ Batteries
WSVDA

L2 Blinkit Calculator

Tsvda19 l  Concur

Calendar

| Notepad

(G citrix Workspace (s

% Clock Quick Access Quick Access
View your favourite apps/desktops at View your favourite apps/desktops at
' a glance. a glance.

! Contacts

For Citrix Workspace app installed on macOS Sonoma, you can add the Citrix Workspace widgets to
the desktop screen. For Citrix Workspace app installed on macOS Ventura and earlier versions, you
can add the Citrix Workspace widgets to Notification centre.

To add Citrix Workspace widgets, do the following steps:

1. Onthe macOS Sonoma devices, right-click on the wallpaper, then choose Edit Widgets. On the
devices running on macOS Ventura or earlier version, open Neotification Centre and click the
Edit Widgets at the bottom of Notification Centre.
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2. In the widget gallery, search for Citrix Workspace. Or click Citrix Workspace from the list to
view its available widgets.
3. Dragthe small or large widgets onto the desktop or Netification Centre as required.

Data collection and monitoring

December 26, 2024

Citrix Analytics

Citrix Workspace app is instrumented to securely transmit logs to Citrix Analytics. The logs are ana-
lyzed and stored on Citrix Analytics servers when enabled. For more information about Citrix Analyt-
ics, see Citrix Analytics.

Customer Experience Improvement Program (CEIP)

What is the Citrix Customer Experience Improvement Program (CEIP) for Citrix Workspace
app?

The Citrix Customer Experience Improvement Program (CEIP) collects configuration and usage data
from the Citrix Workspace app and automatically sends it to Citrix Analytics. This data enables Citrix to
analyze the performance and enhance the quality, functionality, and performance of the Citrix Work-
space app, optimize resource allocation for product development, and support service levels through
effective staffing and infrastructure investment.

All data is used and analyzed solely in aggregate form, ensuring that no individual user or device is
singled out or specifically analyzed. Citrix does not collect any Personally Identifiable Information
(PII) through CEIP, and all data collection is in accordance with relevant industry data privacy and
security standards.

Tools used to gather CEIP Data

Citrix Workspace app for Mac uses Citrix Analytics to collect the CEIP data.

Data collected

The specific CEIP data elements collected by Citrix Analytics are:
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Operating System
Version*

Citrix Enterprise
Browser Usage

Session launch
method

Custom Web Store
Feature Usage

Delete Password
Feature Usage

Note:

Citrix Workspace app
version®

Citrix Virtual Apps and
Desktops Session

Launch Status
Uninstall information

Reconnection
preferences

Auto-update channel

Generic USB
Redirection Usage
Auto-update
preference

Inactivity Timeout
Feature Usage
Global App
Configuration service
Usage

Connection Lease
Details

Store configuration

Auto-update Status

Email Discovery
Feature Usage
Restore Keyboard
Usage

USER GUID

You can stop sending CEIP data except for the operating system and Citrix Workspace app ver-

sions collected for Citrix Analytics indicated by an * in the preceding table.

Which users is CEIP data collected from?

The Citrix Workspace app collects the CEIP data via Citrix Analytics that is configured to include users

from allregions. To ensure that this functionality is in place, update to the most recent version of Citrix

Workspace app.

Can users and administrators disable CEIP data collection?

CEIP data collection can be fully disabled in all jurisdictions as per the following configuration.

Starting with version 2205, you can stop sending CEIP data (except for two data elements - Operating

System version and Citrix Workspace app version) by using the following steps:

1. Onthe Preferences window, select Security and Privacy.
2. Click the Privacy tab.
3. Select No, Thanks to disable CEIP participation.
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® Security & Privacy /a o4 »

General Accounts File Access Devices

TLS Smart Card  Privacy

Customer Experience Improvement Program

As part of our Customer Experience Improvement Program (CEIP), the Workspace
app also collects system, product configuration, and non-identifiable usage data
to improve your experience and Citrix products. Learn more about this program
and your options here Learn More.

Alternatively, you can disable CEIP by running the terminal command:
defaults write com.citrix.receiver.nomas CEIPEnabled -bool NO
To disable CEIP using MDM tools, refer to the schema here and set the following:

<key>CEIPEnabled</key> to <false/>

Additional Information
Citrix handles your data in accordance with the terms of your contract with Citrix. Your data is pro-

tected, according to the Citrix Services Security Exhibit available at the Citrix Trust Center.

HDX and multimedia

December 2, 2024

This section describes about the HDX and multimedia features for the following components:

« Graphics and Display
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+ Optimized Microsoft Teams
« HDX transport
« HDX Direct V1

Browser Content Redirection

February 13,2025

Browser Content Redirection (BCR) enhances the user experience of web browsing within Citrix Vir-
tual Apps and Desktops environments. By offloading the rendering of webpages to the user’s local
machine, BCR reduces server load and improves performance, for complex or resource-intensive web-

sites.

For more information, see Citrix Virtual Apps and Desktops.

How it works

BCR uses the Citrix Workspace app to create a secure browsing environment on the user’s device.
When a user accesses an allowed webpage, the viewport of the browser window is redirected to the
client. The client side browser engine then uses the local machine’s resources to render the page,
resulting in faster loading times and smoother interaction.

Note:

Only the browser viewport is redirected. The viewport is the rectangular area in your browser
where the contentis displayed. The viewport doesn’tinclude the Address Bar, Favorites Toolbar,
or Status Bar. Those items are in the user interface, which is still running on the browser in the

Virtual Delivery Agent.
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CilTIX. soltions Piatfom  Resources  Support  Partners 0 Contactus) 4

Maximize your Citrix
investment: Discover what’s

ANNOUNCING

Citrix strengthens security with
two key acquisitions

With the additions of deviceTRUST and Strong Network,

Citrix builds onits security commitments for our
customers.

Read the blog &2

Key benefits

Browser content redirection manages the web traffic, delivering a superior experience for your users
while reducing strain on your infrastructure. Your organization can benefit in the following ways:

+ Resource optimization: Offloading resource-intensive webpages to user devices helps free up
server capacity and reduce bandwidth consumption. This leads to improved efficiency and
lower hardware and network demands.

+ Enhanced user experience: Delivers a smoother, more responsive browsing experience, even
for graphics-intensive websites. Ensures native-like performance, eliminating lag and boosting
productivity.

+ Improved security: Maintains a secure environment while enabling access to both internal and
external resources.

+ Increased flexibility: Supports diverse use cases, from basic web browsing to complex web
applications requiring proxy traversal or SSO authentication. Manages redirection settings ef-
fortlessly with granular policy controls in Citrix Web Studio.

System requirements
Server side components

Citrix Virtual Apps and Desktops:

+ Long Term Service Release
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- Minimum requirements: Any non end-of-life LTSR Citrix Virtual Apps and Desktops release.
- Recommended: Citrix Virtual Apps and Desktops 2402 or higher.

« Current Release

- Minimum requirement: Any non end-of-life CR Citrix Virtual Apps and Desktops release.
- Recommended: Latest Citrix Virtual Apps and Desktops release.

Browser components:

* Browsers

- Microsoft Edge
- Google Chrome

« Browser redirection extension: Published in both Chrome and Edge web stores.
« Itis recommended to use the latest version of the browsers for best experience.

Client side components

Citrix Workspace app:
Minimum requirement: Version 2411 or higher.

Note:

« For macOS, Browser content redirection package is independent of Citrix Workspace app
andisalways the latest version. Hence, the package is compatible with multiple Citrix Work-
space app versions above the specified minimum version.

« Since Browser Content Redirection is independent of Citrix Workspace app for Mac, its ver-
sion numbering no longer aligns with Citrix Workspace app for Mac.

+ Client side browser engine is not packaged with Citrix Workspace app Mac. Download and
install the client side for Mac on Citrix Downloads.

+ Intel and ARM packages are separate. Hence, you must install the appropriate version that
suits the macOS endpoint.

Configuration

To configure Browser content redirection, follow these steps:

1. Install the client side and server side components according to the system requirements. For
information on extension deployment, see Extension deployment.
2. Configure the studio policies.
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« Web studio policies offer a granular way to configure Browser content redirection to suit
various use cases.

+ The basic policies allow the administrator to configure URLs that must be allowed or not
allowed with Browser content redirection.

+ The URLs can be configured with wild cards.

3. Open a supported web browser and navigate to an allowed URL.

« If the match is found in the allow list, the website is redirected to the client.
« Citrix Workspace app blends the viewport onto the VDA side browser for a seamless expe-
rience.

The color of the extension logo specifies the status of the content redirection. It is one of these three
colors:

+ Green: Active and connected
+ Gray: Not active or idle on the current tab
+ Red: Broken or Not Working
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For more information, see Browser content redirection policy settings.

Note:

« HTML5 video redirection and browser content redirection are independent features. The
HTMLS5 video redirection policies aren’t needed for this feature to work. However, the Citrix
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HDX HTMLS5 Video Redirection Service is used for browser content redirection.
+ Itis recommended to configure all settings through Web Studio rather than using registry

keys.

Graphics and display

July 9,2024

Multiple monitors

You can set Citrix Workspace app for Mac to work in full-screen mode across multiple monitors.

1. Open the Citrix Viewer.
2. From the menu bar, click View and select one of the following options, based on your require-
ment:

+ Enter Full Screen - Full screen on the primary monitor only.
« Use All Displays In Full Screen - Full screen on all connected monitors.

3. Drag the Citrix Virtual Desktops screen between the monitors.

The screen is now extended to all monitors.

Limitations

+ Full-screen mode is only supported on one monitor or all monitors, which are configurable
through a menu item.

« Citrix recommends using a maximum of 2 monitors. Using more than 2 monitors might degrade
session performance or cause usability issues.

+ Full screen mode isn’t available on Macs with a notch.

Support for high DPI

Citrix Workspace app for Mac is now compatible with one high DPI monitor with 4K or 5K resolution.
With this feature, the text, images, and other graphical elements on virtual desktop or app sessions
appear in a size that can be viewed comfortably on these high-resolution monitors.

To enable this feature, navigate to Preferences > General > High DPI.

© 1999-2025 Cloud Software Group, Inc. All rights reserved. 237



Citrix Workspace app for Mac

P )
] General ] ke e »

General File Access Devices Mic & Webcam
App access across devices: Reconnect apps when | sign in to Workspace
Reconnect apps when | start or refresh apps
Menu bar: Show Workspace in menu bar

High DPI: Enable and match client DPI scale settings

File download location: = [& Downloads

Administrators can edit the Display memory limit policy, which specifies the maximum video buffer
size in kilobytes for a desktop session, to suit the display resolution. The default value for the Display
memory Limit policy is 65536 KB and is sufficient for one high DPI monitor with 4K resolution.

For virtual app sessions, the default value of Display memory Limit is sufficient as the app session
doesn’t support more than one display.

Forvirtual desktop sessions, administrators must navigate to Citrix Studio > Policies > Display mem-
ory limit and use a higher value, for example 393216 KB to use High DPI features for more than one
external monitor or 5K resolution monitor.

For more information about the Display memory limit policy, see Display memory limit.
Note:
This feature works with a maximum of two connected monitors.

The number of external monitors you can use with your mac is always limited by the Mac model,
as well as the resolution and refresh rate of each display. Refer to the technical specifications
of your Mac to find out the supported number of external monitors. For more information, see
Connect one or more external displays with your Mac in the Apple support article.

Enhanced notch screen support

Starting with the 2301 version, Citrix Workspace app for Mac supports Macs with a notch display. Macs
support a native notch screen in full screen mode for retina and multi-monitor displays. The area of
the session in notch screen is now much bigger and provides the customers with more screen space.
Thisenhancement also supports high DPI scaling. The mouse position also appears accurate in all the
external monitors connected.

Note:

Ensure not to select the Scale to fit below built-in camera option in the Citrix Viewer. This
optionisn’t selected by default and can be found only on Macs with notch display.
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Desktop toolbar

Users can now access the Desktop Toolbar in both windowed and full-screen mode. Previously, the
toolbar was only visible in full-screen mode. Other toolbar changes include:

« The Home button has been removed from the toolbar. This function can be run by using the
following commands:

Cmd-Tab to switch to the previous active application.

Ctrl-Left Arrow to switch to the previous Space.

Using the built-in trackpad or Magic Mouse gestures to switch to a different Space.

Moving the cursor to the edge of the screen while in full-screen mode displays a Dock
where you can choose which applications to make active.

« The Windowed button has been removed from the toolbar. Follow one of these methods to
switch from full-screen mode to windowed mode:

- On 0SX10.10, click the green window button on the drop-down menu bar.

- On 0S X 10.9, click the blue menu button on the drop-down menu bar.

- On all versions of OS X, select Exit Full Screen from the View menu of the drop-down
menu bar.

+ Support to drag between windows in full screen with multiple monitors.

Hide or show the desktop tool bar in the virtual desktop session

You can customize to hide or show the desktop tool bar completely in the virtual desktop session.

For more information about hiding the desktop tool bar completely, see the CTX202450 support article
in the knowledge center.

Extend multiple monitors in full-screen mode

Starting with the 2203.1 version, you can enter full-screen mode on two or more monitors simultane-
ously. To use this feature, perform the following steps:

1. Open the Citrix Viewer.

2. To use full-screen mode on the other connected monitors, drag the window from your primary
monitor to span into the connected monitors. From the menu bar, select View > Enter Full
Screen. The window goes into full screen mode on those monitors.
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Note:

If you have previously selected the Use All Displays In Full Screen option, ensure to uns-
elect it as this selection extends full screen on all connected monitors.

Citrix recommends using a maximum of 3 monitors, including the primary monitor.

Support to open Citrix Workspace app in maximized mode

Starting with the 2204 version, admins can configure the maximise workspace window prop-
erty in the Global App Configuration service to enable the Citrix Workspace app to open in the maxi-
mized mode by default. For more information about the Global App Configuration service, see Getting
Started.

Support for extending multiple monitors in full-screen mode on up to five monitors

Previously, Citrix supported a maximum of three monitors in full-screen mode, including the primary
monitor.

Starting with the 2311 version, you can now use full-screen mode on up to five monitors, including
the primary monitor, at the same time.

Note

The number of external monitors you can use with your mac is always limited by the Mac model,
as well as the resolution and refresh rate of each display. Refer to the technical specifications
of your Mac to find out the supported number of external monitors. For more information, see

Connect one or more external displays with your Mac in the Apple support article.
You can extend multiple monitors in full-screen mode in the following two ways:

+ Using the menu bar

1. Open the Citrix Viewer.
2. From the menu bar, click View and select Enter Full Screen to extend full screen.
Note:

You can extend the screen to full-screen mode in all connected displays at once by enabling
Use All Displays In Full Screen and then selecting Enter Full Screen from the View menu.

+ Using the green button in the app window

1. Open the Citrix Viewer.
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2. Drag or resize the Citrix Viewer window to make it spread on the monitors that you want to use
in full-screen mode.

3. Move the pointer to the green button in the upper-left corner of the window, then select Enter
Full Screen from the menu that appears or click the green button. The screen is now extended
to monitors that have an intersection with the window.

Admins can edit the Display memory limit policy, which specifies the maximum video buffer size
in kilobytes for a desktop session, to suit the display resolution. The default value for the Display
memory Limit policy is 65536 KB and is sufficient only for up to 2x4K monitors (2x32400KB). Admins
mustincrease this value to use five monitors based on the display resolution. You can edit the Display
memory Limit by navigating to Citrix Studio > Policies > Display memory limit. For more informa-
tion about the Display memory limit policy, see the Display memory limit section in the XenApp and
XenDesktop documentation.

Improved graphics performance

Starting with the 2308 version, the performance of graphics is improved for seamless app sessions.
This feature also optimizes the load on CPU usage.

Support for H.265 video decoding

Starting with the 2402 version, Citrix Workspace app for Mac supports the use of the H.265 video codec
(HEVC) for hardware acceleration of remote graphics and videos. The h.265 video codec (HEVC) sup-
ports YUV 4:2:0 color space by default. H.265 video codec must be supported and enabled on both the
VDA and Citrix Workspace app. If your Mac device doesn’t support H.265 decoding using the VideoTool-
box interface, then the H.265 decoding for graphics policy setting isignored and the session falls back
to the H.264 video codec.

Prerequisites

« VDA 7.16 or later using the following GPUs:

- NVIDIA Maxwell generation GPU or later
- Intel 6th generation GPU or later
- AMD Raven generation GPU or later

+ Enable the Optimize for 3D graphics workload policy on the VDA.
« Enable the Use hardware encoding for video codec policy on the VDA.

On Citrix Workspace app for Mac, this feature is set to be enabled by default.
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To disable this feature through Mobile Device Management (MDM), administrators must use the fol-
lowing settings:

<key>EnableXdecoderForH265</key><false/>
Restart the session for the changes to take effect.
Note:

Run the HDX Monitor 3.x tool to identify if the H.265 video encoder is enabled within the ses-
sion. For more information about the HDX Monitor 3.x tool, see the Knowledge Center article
CTX135817.

Support for extending the desktop session to external monitors automatically

Starting with the 2405 version, Citrix Workspace app supports the extension of desktop sessions to
external monitors automatically. With this feature, when you launch the desktop session on the end-
point, if the external monitors are already connected to the endpoint, then the session is extended
to external monitors automatically. When you disconnect the external monitor, the session can auto-
matically adjust to extend only to the connected monitors.

To enable this feature, go to the View menu in the Citrix Viewer menu bar and select the Use All Dis-
plays in Full Screen option.

& Citrix Viewer View Devices Debug

0@ Enter Full Screen
+ Use All Displays In Full Screen

Optimized Microsoft Teams

July 9,2024

Configuring a preferred network interface

Starting with the 2304 version, you can configure a preferred network interface for media traffic. Run
the following command in the terminal:

defaults write com.citrix.HdxRtcEngine NetworkPreference -int <value>
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Select one of the following values as required:

+ 1: Ethernet
o 2: Wi-Fi

« 3: Cellular

* 4: VPN

« 5: Loopback
« 6: Any

By default and if no value is set, the WebRTC media engine chooses the best available route.

Encoder performance estimator

The HdxRtcEngine.exeisthe WebRTC media engine embedded in Citrix Workspace app that han-
dles Microsoft Teams redirection. The HdxRtcEngine.exe can estimate the best encoding resolu-
tion that the endpoint’s CPU can sustain without overloading. Possible values are 240p, 360p, 480p,
720p, and 1080p.

The performance estimation process uses macroblock code to determine the best resolution that can
be achieved with the particular endpoint. The Codec negotiation includes the highest possible res-
olution. The Codec negotiation can be between the peers, or between the peer and the conference

server.

There are four performance categories for endpoints that have its own maximum available resolu-

tion:
Endpoint performance Maximum resolution Registry key value
Fast 1080p (1920x1080 16:9 @ 30 3
fps)
Medium 720p (1280x720 16:9 @ 30 fps) 2
Slow 360p (640x360 16:9 @ 30fpsor 1
640x480 4:3 @ 30 fps)
Very slow 240p (320x180 16:9 @ 30fpsor 0
320x240 4:3 @ 30 fps)

To set the video encoding resolution value to 360p, run the following command from the terminal:
defaults write com.citrix.HdxRtcEngine OverridePerformance -int 1

For more information about Microsoft Teams optimization, see Optimization for Microsoft Teams.
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Improved experience for optimized Microsoft Teams video conference calls

Starting with the 2304 version, by default simulcast support is enabled for optimized Microsoft Teams
video conference calls. With thissupport, every callis adjusted to the proper resolution for the optimal
call experience. This feature enhances the quality and experience of video conference calls across
various endpoints.

With this improved experience, each user might deliver multiple video streams in different resolutions
(for example, 720p, 360p, and so on). The video resolution depends on several factors including end-
point capability, network conditions, and so on. The receiving endpoint then requests the maximum
quality resolution that it can handle and giving all users the optimum video experience.

Note:

This feature is available only after the roll-out of an update from Microsoft Teams. For informa-
tion on ETA, go to https://www.microsoft.com/ and search for the Microsoft 365 roadmap. When
the update is rolled-out by Microsoft, you can check CTX253754 for the documentation update

and the announcement.

Limiting video resolutions

Administrators who have users on lower-performance client endpoints can choose to limit incoming
or outgoing video resolutions to decrease the impact of encoding and decoding video on those end-
points. Starting from Citrix Workspace app 2304 for Mac, you can limit these resolutions using client
configuration options.

Note:

Users running with restricted resolutions impact the overall video quality of the conference be-
cause the Microsoft Teams server is forced to use the lowest-common-denominator resolution

for all conference participants.

Call constraints are disabled by default on the client with Citrix Workspace app 2304. To enable, ad-
ministrators must set the following client-side configurations with the defaults command:

defaults write com.citrix.HdxRtcEngine <Name> -<Type> <Value>

Name Type Mandatory Accepted values

EnableSimulcast int YES 1-3(setitto1)
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Name Type Mandatory Accepted values
MaxOutgoingResolution int YES 180, 240, 360, 540, 720,
1080 (Microsoft Teams
supported
Resolutions)
MaxIncomingResolution int YES 180, 240, 360, 540, 720,
1080 (Microsoft Teams
supported
Resolutions)
MaxIncomingStreams  int YES 1-8
MaxSimulcastLayers int YES 1-3(setitto1)
MaxVideoFrameRate int NO 1-30
MaxScreenShareFrameRatat NO 1-15

Background blurring and replacement for Citrix Optimized Microsoft Teams

Starting with the 2301 version, Citrix Optimized Microsoft Teams in Citrix Workspace app for Mac now
supports background blurring and background replacement. You can use this feature by selecting
More > Apply Background Effects when you are in a meeting or a P2P call.

Enhancement to sleep mode for optimized Microsoft Teams call
Previously, when you are in an optimized Microsoft Teams meeting, if there’s no mouse or keyboard
interaction, Citrix Workspace app or the optimized Microsoft Teams screen might go to sleep mode.

Starting with the 2305 version, Citrix Workspace app or the optimized Microsoft Teams screen doesn’
t go to sleep mode even if there’s no mouse or keyboard interaction during an optimized Microsoft
Teams meeting.

Screen sharing optimization with Microsoft Teams

Starting with the 2012 version, Citrix Workspace app for Mac supports screen sharing optimization
with Microsoft Teams. For more information, see the following:

+ Optimization for Microsoft Teams
+ Microsoft Teams redirection
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Microsoft Teams optimization support for seamless app sessions

Starting with the 2101 version, Citrix Workspace app for Mac now supports Microsoft Teams optimiza-
tion for seamless app sessions. As a result, you can launch Microsoft Teams as an application from
within the Citrix Workspace app. For more information, see the following:

» Optimization for Microsoft Teams
« Microsoft Teams redirection

Support for Dual Tone Multi Frequency (DTMF) with Microsoft Teams

Starting with the 2101 version, Citrix Workspace app for Mac supports Dual Tone Multi Frequency
(DTMF) signaling interaction with telephony systems (for example, PSTN) and conference calls in Mi-
crosoft Teams. This feature is enabled by default.

Enhancements in Desktop Viewer

When the Desktop Viewer is in full screen mode, the user can select one from all the screens covered
by the Desktop Viewer to share. In the window mode, the user can share the Desktop Viewer window.
In the seamless mode, the user can select one screen from the screens connected to the endpoint
device.

When the Desktop Viewer changes the window mode (maximize, restore, or minimize), the screen
sharing stops.

When the user wants to share the screen, previews for all available screens appear in the screen shar-
ing panel. Making it intuitive for users to select the right one from the previews.

Support for H.264 Advanced Video Coding (MPEG-4 AVC) with Microsoft Teams

Starting with the 2109 version, Citrix Workspace app for Mac supports hardware accelerated H.264
video encoding or decoding. It reduces the load on CPU usage and improves your video conferencing
experience. The multimedia engine of Citrix HDX optimized Microsoft Teams (HdxRtcEngine.exe) now
uses Apple’s Video Toolbox framework for encoding and decoding. This framework compresses and
decompresses video faster and in real time. Also, the offloading of encoding and decoding to the GPU
is optimized. Hardware-accelerated video decoding and encoding are enabled by default if a device
supports it. This enhancement reduces the load on the CPU during multimedia usage when Microsoft
Teams is optimized with HDX.
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Dynamic e911

Starting With the 2112 version, Citrix Workspace app supports dynamic emergency calling. When used
in Microsoft Calling Plans, Operator Connect, and Direct Routing, it allows you to do the following:

+ Configure and route emergency calls.

+ Notify security personnel.

Notification is provided based on the current location of the Citrix Workspace app running on the end-
point. Itis not sent based on the Microsoft Teams client that runs on the VDA. Ray Baum’s law requires
the 911 caller’s dispatchable location to be transmitted to the appropriate Public Safety Answering
Point (PSAP). Starting from Citrix Workspace app 2112.1 for Windows, Microsoft Teams Optimization
with HDX is compliant with Ray Baum’s law. For more information about this feature, see Support for
dynamic e911 in the section Microsoft Phone System.

Request control in Microsoft Teams

Starting with the 2112 version, you can request control during a Microsoft Teams call when a partici-
pant is sharing the screen. Once you have control, you can make selections, edits, or other modifica-
tions to the shared screen.

To take control when a screen is being shared, click Request control at the top of the Microsoft Teams
screen. The meeting participant who’s sharing the screen can either allow or deny your request. When
you’re done, click Release control.

Limitation:

The Request Control option isn’t available during peer-to-peer calls between an optimized user and
a user on the native Microsoft Teams desktop client that is running on the endpoint. As a workaround,
users can join a meeting to get the Request Control option.

Give or take control in Microsoft Teams

Starting with the 2203.1 version, you can use the Give control button to give control of your shared
screen to other users participating in the meeting. The other participants can make selections and
modify the shared screen through keyboard, mouse, and clipboard input. You both now have the
control of the shared screen and you can take back the control anytime.

To take control during screen sharing sessions, any participant can request control access through the
Request control button. The person sharing the screen can then approve or deny the request. When
you have the control, you can control the keyboard and mouse input on the screen shared and release
the control to stop sharing control.
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Note:

This feature is available only after the roll-out of a future update from Microsoft Teams.

Multi-window chat and meetings for Microsoft Teams

Starting with the 2203.1 version, you can use multiple windows for chat and meetings in Microsoft
Teams (1.5.00.5967 or higher) when optimized by HDX in Citrix Virtual Apps and Desktops and Citrix
DaaS. Users can pop out their conversations or meetings in various ways. For details on the pop-out
window feature, see Microsoft Teams Pop-Out Windows for Chats and Meetings on the Microsoft Office
365 site.

If you’re running an older version of Citrix Workspace App or VDA, Microsoft can deprecate the single-
window code in the future. However, you have a minimum of nine months to upgrade to a version of
the VDA/CWA that supports multiple windows (2203 or later).

Note:

This feature is available only after the roll-out of a future update from Microsoft Teams. Got more
details, see the Microsoft 365 roadmap.

Share apps using the ‘Share content’feature in Microsoft Teams

Starting with the 2203.1 version, you can share individual applications, windows, or full screen using
the screen sharing feature in Microsoft Teams. Citrix Virtual Delivery Agent 2109 is a prerequisite for
this feature.

To show a specificapplication, click Share content in your meeting controls and select the application
of interest. After a red border appears around the app you select, peers on the call can see your app.
If you minimize the app, Microsoft Teams displays the last image from the shared app. Maximize the
window to resume sharing.

Enhancements to Optimized Microsoft Teams

In optimized Microsoft Teams, you can now use the video function when more than one virtual desk-
top or app sessionis in use.

App Protection compatibility with HDX optimization for Microsoft Teams

Starting with the 2204 version, full monitor or desktop sharing is disabled when App Protection is
enabled for the delivery group. When you click Share content in Microsoft Teams, the screen picker
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removes the Desktop option. You can only select the Window option to share any open app, if the
VDA is 2109 or higher. If you’re connected to VDA older than 2019, no content is selectable.

Deprecation announcement of the SDP format (Plan B) from WebRTC

Citrixis planning to deprecate the current SDP format (Plan B) support from WebRTC in future releases.
You must use a version of Citrix Workspace app that supports the Unified Plan to continue using certain
optimized Microsoft Teams functionalities.

Upgraded version of WebRTC for the optimized Microsoft Teams

Starting with the 2405 version, the version of WebRTC that is used for the optimized Microsoft Teams
is upgraded to version M117.

HDX transport

July 8,2024

Enlightened Data Transport (EDT)

By default, EDT is enabled in Citrix Workspace app for Mac.
Citrix Workspace app for Mac reads the EDT settings as set in the default.ica file and applies it.
To disable EDT, run the following command in a terminal:

defaults write com.citrix.receiver.nomas HDXOverUDPAllowed -bool NO

Maximum Transmission Unit (MTU) discovery in Enlightened Data Transport (EDT)

Starting with the 2108 version, Citrix Workspace app for Mac supports Maximum Transmission Unit
(MTU) discovery in Enlightened Data Transport (EDT). It increases the reliability and compatibility of
the EDT protocol and provides an improved user experience.

Note:

EDT MTU discovery is supported on macOS Big Sur and later.
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Improved network congestion control

Starting with the 2308 version, the Citrix-proprietary transport protocol called Enlightened Data Trans-
port (EDT) is improved to efficiently control network congestion. This feature improves data through-
put and reduces latency.

Upgraded HDX Reducer to Version 4

Previously, Citrix Workspace app for Mac supported HDX Reducer V3. Starting with the 2402 version,
Citrix Workspace app for Mac supports HDX Reducer V4. This feature reduces the network bandwidth
required for a typical session and improves response time.

HDX direct

December 17, 2024

HDX Direct

Starting with version 2411, Citrix Workspace app for Mac supports HDX Direct transport for the con-
nection between Citrix Workspace app and the Virtual Delivery Agent server. HDX Direct allows client
devices to establish a secure, direct connection with the session host if direct communication is feasi-
ble. For more information, see HDX Direct.

Devices

July 9,2024

This section describes about the features supports for the following devices:

 Audio and Microphone
« Client drive-mapping
» Keyboard

 Printing

+ USB

+ Webcam
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Audio and Microphone

November 26, 2024

Support for WebHID APl in UCSDK

Starting with the 2411 version, Citrix Workspace app for Mac supports the WebHID API to redirect Hu-
man Interface Devices (HIDs) from endpoint to Unified Communication SDK application on the VDI. It
complies with the HID standard for bi-directional communication between the application based on
UCSDK and the HID devices connected to the endpoint.

With this feature, your UCSDK application can interpret HID commands such as call accept, reject,
mute, or unmute within the HDX session for an enhanced user experience. This feature is enabled by
default.

Adaptive audio

You don’t need to configure the audio quality policies on the VDA with the Adaptive audio feature.
Adaptive audio optimizes settings for your environment and replaces legacy audio compression for-
mats to provide an excellent user experience. For more information, see Adaptive Audio.

Improved audio echo cancellation support

Citrix Workspace app supports echo cancellation in adaptive audio and legacy audio codecs. This fea-
tureisdesigned for real-time audio use cases, and itimproves the user experience. Citrix recommends
using adaptive audio.

Client-side microphone input

Citrix Workspace app for Mac supports multiple client-side microphone inputs. You can use locally
installed microphones for:

« Live events, such as softphone calls and Web conferences.
» Hosted recording applications, such as dictation programs.
+ Video and audio recordings.

Digital dictation support is available with Citrix Workspace app for Mac.
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You can choose how to use your microphone and webcam with the virtual app and desktop sessions.
To apply access type to your microphone and webcam, select any of the following access types as per
your requirement on the Mic & Webcam tab in the Preferences settings:

+ Use my microphone and webcam - Provides access to microphone and webcam when it’s con-
nected.

» Dont use my microphone and webcam - No access to microphone and webcam.

+ Ask me each time - Request permission each time when microphone and webcam access is
required.

To apply a background blur effect when using the webcam, select Turn on background blur effect
when using webcam.

Support for multiple audio devices

Starting with the 2311 release, Citrix Workspace app for Mac displays all available local audio devices
in a session with their names. In addition, plug-and-play is also supported.

Store-based configuration of microphone and webcam access

Starting with the 2307 version, the microphone and webcam access per store are included as part of
the client-selective trust feature. This enhancement allows you to provide access to a microphone
and webcam on a per store basis.

To enable microphone and webcam access for a store, you must select Preferences > Mic & Webcam.
In the Mic & Webcam tab, select the store and the type of access required for that store.

Support for audio volume synchronization

Previously, audio volume control is independent between the Virtual Delivery Agent (VDA) and your
device. You’ve to adjust the volume on both sides to maintain the desired volume. Also, if you’ve
muted the volume in your device, then it restricts to unmute the volume in the VDA.

Starting with the 2402 version, Citrix Workspace app for Mac supports synchronization of audio vol-
ume between the VDA and your audio devices. You can now tune the volume using the VDA audio
volume slider and have the same volume on your device and the other way around. By default, this
feature is enabled.

To enable this feature, you need to use VDA version 2308 or later. For more information, see audio
volume synchronization in the Citrix Virtual Apps and Desktops documentation.

To enable audio volume synchronization on the VDA, configure the following registry value and restart
the machine:
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For Server OS VDA:

+ Key: HKEY_LOCAL_MACHINE\SOFTWARE\WOW®6432Node\Citrix\Audio
+ Value name: EnableVolumeSync

« Value type: DWORD

+ Valuedata: 1

For Desktop OS VDA:

+ Key: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\Audio
+ Value name: EnableVolumeSync

+ Value type: DWORD

+ Valuedata: 1

To disable this feature through Mobile Device Management (MDM), administrators must use the fol-
lowing settings:

<key>EnableVolumeSync</key><false/>

Restart the session for the changes to take effect.

Loss tolerant mode for audio

Starting with the 2402 version, Citrix Workspace app supports loss tolerant mode (EDT lossy) for au-
dio redirection. This feature improves the user experience for real-time streaming when users are
connecting through networks with high latency and packet loss. By default, this feature is enabled.

To enable this feature, you need to use VDA version 2311 or later. For more information, see Support
for audio over loss-tolerant mode (Preview) in the Citrix Virtual Apps and Desktops documentation.

To disable this feature through Mobile Device Management (MDM), administrators must use the fol-
lowing settings:

<key>EdtUnreliableAllowed</key><false/>

Restart the session for the changes to take effect.

Enable Packet Loss Concealment to improve audio performance

Starting with the 2405 version, the jitter buffer mechanism is improved, and the Packet Loss Conceal-
ment (PLC) is added for the Adaptive audio codec. PLC helps to reconstruct the lost data packets. This
enhancement helps to improve the packet loss tolerance and jitter tolerance and thus improves audio
performance for loss tolerant mode (EDT lossy) for audio.

To enable this feature, you also need to enable the Loss tolerant mode for the audio feature.
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This feature is enabled by default.
To disable this feature through Mobile Device Management (MDM), administrators must use the fol-
lowing settings:

<key> PacketLossConcealmentEnabled</key><false/>

After running the command, restart the session for the changes to take effect.

Client drive mapping

July 8,2024

During the session, Client drive mapping allows you to access local drives on the user hardware de-
vice. The user hardware devices can be CD-ROM drives, DVDs, and USB memory sticks. When a server
configuration allows client drive mapping, you can access locally stored files and work on them during
sessions. You can also save them either on a local drive or on a drive on the server.

Citrix Workspace app for Mac monitors the directories in which user hardware devices are typically
mounted on the user device. It can automatically map any new ones that appear during a session to
the next available drive letter on the server.

You can configure the level of read and write access for mapped drives using the Citrix Workspace app
for Mac preferences.

To configure read and write access for mapped drives

1. On the Citrix Workspace app for Mac home page, click the down arrow icon K, and then click
Preferences.

2. Click File Access.

3. Select the level of read and write access for mapped drives from the following options:

+ Read and Write

« Read only

» No access

+ Ask me each time

4. Log off from any open sessions and reconnect to apply the changes.
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Keyboard

December 12,2024

Enhanced keyboard and IME diagnostics tool

Starting with version 2411, a new self-service command-line tool hosted in Windows Virtual Delivery
Agent (VDA) is supported by Citrix Workspace app for Mac to diagnose keyboard and Input Method
Editor (IME) related issues. This tool meets various user requirements, provides platform versatility,
and caters to personalized needs. The keyboard and IME functions depend on different configurations
and capabilities in VDAs and Citrix Workspace apps. Incorrect settings in the VDA or client side might
result in unexpected input behavior.

With this tool, you can easily identify issues that were previously difficult to find.

+ Checks for consistency between VDA policy and client keyboard layout sync mode.

« Checks for client keyboard layout and VDA keyboard layout, and provides best practices.

« Checks the remote language bar setting and provides best practices.

+ Checks system shortcut pass-through configurations, accessibility permissions, and full
screen mode status to suggest best practices.

Prerequisites:

+ Citrix Workspace app for Mac 2411 or higher.
« Virtual Delivery Agent 2411 or higher.

The command line tool is hosted in Windows VDA as CtxKbImeDiagnostics.exe. Theinterfaces
are as follows:

Interface

CtxKbimeDiagnostics

CtxKbimeDiagnostics

[-Vv]

Description

Shows diagnostic results for
current user’s ICA sessions.

Shows setting information and
diagnostic results for current
users ICA sessions.

Note

If the user has admin privilege,
it shows diagnostics for all
active ICA sessions. If the user
has no admin privilege, it
shows diagnostics for the
current user’s ICA sessions.
Admin privilege shows
diagnostics for all active ICA
sessions.
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Interface

Description

Note

CtxKbimeDiagnostics
[-v] [-s Session_Id]

CtxKbimeDiagnostics
[-s Session_Id]

CtxKbimeDiagnostics
[-s Session_Id] [-V]

CtxKbimeDiagnostics
[-h]
CtxKbimeDiagnostics

[-V]

Shows setting information and
diagnostic results for this
session.

Shows diagnostic results for a
specific session.

Shows all setting information
and diagnostic results for a
specific session.

Shows supported arguments,
parameters, and examples.

Shows current tool version.

Admin privilege can query
other ICA sessions. Normal
users can query their own
sessions.

Admin privilege can query
other ICA sessions. Normal
users can query their own
sessions.

Admin privilege can query
other ICA sessions. Normal
users can query their own

sessions.
Help interface.

Keyboard layout synchronization

Keyboard layout synchronization enables you to switch between the preferred keyboard layouts on

the client device. This feature is disabled by default. After you enable this feature, the client keyboard

layout automatically synchronizes to the virtual apps and desktops.

To enable keyboard layout synchronization, go to Preferences > Keyboard and select “Use local key-

board layout, rather than the remote server keyboard layout.”

Note:

1. Usingthelocal keyboard layout option activates the client IME (Input Method Editor). Users

workingin Japanese, Chinese, or Korean can use the server IME. They must disable the local

keyboard layout option by clearing the option in Preferences > Keyboard. The session will

revert to the keyboard layout provided by the remote server when they connect to the next

session.

2. The feature works in the session only when the toggle in the client is turned on and the

corresponding feature enabled on the VDA. A menu item,”Use Client Keyboard Layout,”

in Devices > Keyboard > International is added to show the enabled state.

Starting with version 2210, Citrix Workspace app for Mac supports three different keyboard layout

synchronization modes:
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« Sync only once - when session starts —Based on the CTXIME value in the Conf1ig file, the
client keyboard layout is synchronized to the server when the session launches. Any changes
you make to the client keyboard layout during the session do not take effect immediately. To
apply the changes, sign out and sign in to the app. The Sync only once - when session starts
mode is the default keyboard layout for the Citrix Workspace app on Mac.

« Allow dynamic sync - This option synchronizes the client keyboard layout to the server when
you change the client keyboard layout.

« Don’t sync - Indicates that the client uses the keyboard layout present on the server.

Prerequisites

+ Enable the Unicode Keyboard Layout Mapping feature on the Windows VDA. For more informa-
tion, see Knowledge Center article CTX226335.

« Enable the Dynamic Keyboard layout sync feature on the Linux VDA. For more information, see
Dynamic keyboard layout synchronization.

« Whenusing Windows Server 2016 or Windows Server 2019, navigate to the HKEY_LOCAL_MACHINE\Softwar
registry path and add a DWORD value with the key name DisableKeyboardSync and set the
value to 0.

Configure keyboard layout

Citrix Workspace app for Mac provides the Ul to configure the three different keyboard layout synchro-
nization modes.

To configure keyboard layout synchronization using the GUI:

1. From the Citrix Workspace app icon in the menu bar, click the account icon in the top-right cor-
ner and navigate to Preferences > Keyboard.

The Keyboard layout synchronization settings appear.

2. Select from one of the following options:

« Synconly once - when session starts - Indicates that the keyboard layout is synced to the
VDA only once at the session launch. Unicode keyboard input mode is the recommended
option for the Sync only once —~when the session starts

« Allow dynamic sync - Indicates that the keyboard layout is synced dynamically to the
VDA when the client keyboard is changed in a session. Unicode keyboard input mode is
the recommended option for the Allow dynamic sync mode.
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« Don’t sync - Indicates that the client uses the keyboard layout present on the server, ir-
respective of the keyboard layout that is selected in the client. Scancode keyboard input
mode is the recommended option for Don’t sync. You must make sure that the client key-
board layout is the same as the keyboard layout on the VDA if you select Unicode for the
Don’t Sync option.

Limitations

+ Using the keyboard layouts listed in “Supported Keyboard Layouts in Mac”works while using

this feature. When you change the client keyboard layout to a non-compatible layout, the layout

might be synced on the VDA side, but functionality can’t be confirmed.

+ Remote apps that run with elevated privileges can’t be synchronized with the client keyboard

layout. To work around this issue, manually change the keyboard layout on the VDA or disable
UAC.

« When a user is working within an RDP session, it’s not possible to change the keyboard layout

usingthe ALt + Shiftshortcuts whenRDP isdeployed as an app. As aworkaround, you can

use the language bar in the RDP session to switch the keyboard layout.

Keyboard layout support for Windows VDA

Language on Mac Input Source on Mac Applicable Mac OS version
English ABC All
English ABC - India All
English u.s. All
English U.S. International - PC All
English Dvorak All
English Dvorak - Left-Handed All
English Dvorak - Right-Handed All
English British All
English British - PC All
English Canadian English All
English Australian All
English Irish All
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Language on Mac

French
French
French
French
French
French
German
German
German
Spanish
Spanish
Spanish
Spanish
Swedish
Swedish
Swedish
Czech
Danish
Finnish
Hungarian
Italian
Italian
Italian
Greek
Dutch
Dutch
Russian
Russian

Croatian

Input Source on Mac

French

French - Numerical
Canadian French - CSA
Canadian —CSA
Swiss French
French - PC
German

Austrian

Swiss German
Spanish

Spanish - 1SO
Spanish —Legacy
Latin American
Swedish

Swedish —Legacy
Swedish - Pro
Czech

Danish

Finnish

Hungarian

Italian

Italian - Typewriter
Italian -QZERTY
Greek

Belgian

Dutch

Russian

Russian - PC

Croatian - PC

Applicable Mac OS version

All
All
11,12
13
All
All
All
All
All
All
10,11
12,13
All
All
12,13
10,11
All
All
All
All
All
10,11
12,13
All
All
All
All
All
All
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Language on Mac

Input Source on Mac

Applicable Mac OS version

Slovak Slovak All
Slovak Slovak - QWERTY All
Turkish Turkish F All
Turkish Turkish Q All
Portuguese Brazilian All
Portuguese Brazilian - ABNT2 All
Portuguese Brazilian —Legacy 12,13
Portuguese Brazilian - Pro 10,11
Portuguese Portuguese All
Ukrainian Ukrainian - PC 10,11
Ukrainian Ukrainian 12,13
Belarusian Belarusian All
Slovenian Slovenian All
Estonian Estonian All
Latvian Latvian All
Polish Polish - Pro 10,11
Polish Polish 12,13
Icelandic Icelandic All
Norwegian Norwegian All
Japanese Katakana All
Japanese Half-width Katakana All
Japanese Romaji All
Japanese Full-width Romaji All
Japanese Hiragana All
Japanese Alphanumeric (Google) All
Japanese Hiragana (Google) All
Japanese Katakana (Google) All
Japanese Half-width Katakana (Google) All
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Language on Mac

Japanese

Korean

Chinese, Simplified
Chinese, Simplified
Chinese, Traditional
Chinese, Traditional
Chinese, Traditional

Chinese, Traditional

Input Source on Mac

Full-width Alphanumeric
(Google)
2-Set Korean

Pinyin - Simplified
Sogou pinyin

Pinyin - Traditional
Cangjie - Traditional
Zhuyin - Traditional

Sucheng - Traditional

Keyboard layout support for Linux VDA, Swiss French

Language on Mac

English
English
English
English
English
English
English
English
English
English
English
English
French
French
French

French

Input Source on Mac

ABC

ABC - India

u.s.

U.S. International - PC
Dvorak

Dvorak - Left-Handed
Dvorak - Right-Handed
British

British - PC

Canadian English
Australian

Irish

French

French - Numerical
Canadian French - CSA
Canadian —CSA

Applicable Mac OS version

All

All
All
All
All
All
All
All

Applicable Mac OS version

All
All
All
All
All
All
All
All
All
All
All
All
All
All
11,12
13
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Language on Mac

French
French
German
German
German
Spanish
Spanish
Spanish
Spanish
Bulgarian
Bulgarian
Swedish
Swedish
Swedish
Czech
Danish
Finnish
Hungarian
Italian
Italian
Italian
Greek
Belgian
Dutch
Romanian
Russian
Russian
Croatian

Slovak

Input Source on Mac

Swiss French
French - PC
German

Austrian

Swiss German
Spanish

Spanish - ISO
Spanish —Legacy
Latin American
Bulgarian
Bulgarian —Standard
Swedish
Swedish —Legacy
Swedish - Pro
Czech

Danish

Finnish
Hungarian
Italian

Italian - Typewriter
Italian -QZERTY
Greek

Belgian

Dutch

Romanian - Standard

Russian
Russian - PC
Croatian - PC
Slovak

Applicable Mac OS version

All
All
All
All
All
All
10,11
12,13
All
10,11,12
13
All
12,13
10,11
All
All
All
All
All
10,11
12,13
All
All
All
All
All
All
All
All
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Language on Mac

Slovak
Turkish
Turkish
Portuguese
Portuguese
Portuguese
Portuguese
Portuguese
Ukrainian
Ukrainian
Belarusian
Slovenian
Estonian
Polish
Polish
Icelandic
Norwegian
Japanese
Japanese
Japanese
Japanese
Japanese
Japanese
Japanese
Japanese
Japanese

Japanese

Korean

Input Source on Mac

Slovak - QWERTY
Turkish F

Turkish Q
Brazilian
Brazilian - ABNT2
Brazilian —Legacy
Brazilian - Pro
Portuguese
Ukrainian - PC
Ukrainian
Belarusian
Slovenian
Estonian
Polish - Pro

Polish

Icelandic
Norwegian
Katakana
Half-width Katakana
Romaji

Full-width Romaji
Hiragana
Alphanumeric (Google)
Hiragana (Google)
Katakana (Google)

Half-width Katakana (Google)

Full-width Alphanumeric

(Google)
2-Set Korean

Applicable Mac OS version

All
All
All
All
All
12,13
10,11
All
10,11
12,13
All
All
All
10,11
12,13
All
All
All
All
All
All
All
All
All
All
All
All

All
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Language on Mac

Chinese, Simplified
Chinese, Simplified
Chinese, Traditional
Chinese, Traditional
Chinese, Traditional

Chinese, Traditional

Input Source on Mac

Pinyin - Simplified
Sogou pinyin

Pinyin - Traditional
Cangjie - Traditional
Zhuyin - Traditional
Sucheng - Traditional

Applicable Mac OS version

All
All
All
All
All
All

By default, the keyboard layout synchronization feature is turned on. To control this feature alone,

open the Config file in the ~/Library/Application Support/Citrix Receiver/ folder, locate the “En-

ableIMEEnhancement”setting and turn the feature on or off by setting the value to “true”or “false,”

respectively.

Note:

The setting change takes effect after restarting the session.

Keyboard input mode enhancements

Citrix Workspace app for Mac provides the Ul to configure the keyboard input mode.

To configure keyboard input mode by using the GUI, do the following:

1. From the Citrix Workspace app icon in the menu bar, click the account icon in the top-right cor-

ner and navigate to Preferences > Keyboard.

The Keyboard input mode settings appear

2. Select from one of the following options:

+ Scancode -Sends the key position from the client-side keyboard to VDA and VDA generates

the corresponding character. Applies server-side keyboard layout.

+ Unicode - Sends the key from the client-side keyboard to VDA and VDA generates the same

character in VDA. Applies client-side keyboard layout.

This enhancement is enabled by default.
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® Keyboard = J - b

General Accounts File Access Devices

Choose keyboard shortcuts to send commands to your applications.
Send Control character using: 3 Commanad (left) or ~~ Control B
Send Alt character using:  3£°C Command (left)-Option <
Keyboard layout synchronization settings:  Sync only once - when session starts ﬂ

Keyboard input mode settings: Unicode B

Mote: Scancode is the recommended option for the "Don't sync® setting.
Send Windows logo key using 3 Command (right)

Send special keys unchanged (press 3 Command (left) for some keys)
Show the remote language bar for the published applications

Changes will take effect once you reconnect to this application.

Learn more
Restore Defaults

For example, consider a scenario where you’re using a US international keyboard layout and the VDA
isusing the Russian keyboard layout. When you choose Scancode and type the key next to Caps Lock,
the scancode “1E”is sent to the VDA. The VDA then uses “1E”to display the character “d”. If you choose
Unicode and type the key next to Caps Lock, the character “a”is sent to the VDA. So, even if the VDA
uses the Russian keyboard layout, the character “a”appears on the screen.

Citrix recommends the following keyboard input mode for the different keyboard layout sync op-
tions:

» Scancode mode for Don’t Sync option.
« Unicode mode for Allow dynamic sync and Sync only once - when session starts
Note:
The keyboard configuration changes take effect once you reconnect to the application.
You can change the configuration of Keyboard input mode in the Citrix Workspace app Ul. However,

for best performance, use the Citrix-recommended modes for different scenarios, physical keyboards,
and client devices.

Language bar

You can choose to show or hide the remote language bar in an application session using the GUI. The
language bar displays the preferred input language in a session. In earlier releases, you might change
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this setting using only the registry keys on the VDA. Starting with Citrix Workspace for Mac version 1808,
you can change the settings using the Preferences dialog. The language bar appears in a session by
default.

Note:

This feature is available in sessions running on VDA 7.17 and later.

Configure showing or hiding the remote language bar

1. Open Preferences.
2. Click Keyboard.
3. Click or unclick Show the remote language bar for the published applications.

Note:

The setting changes take effect immediately. You can change the settings in an active session.

The remote language bar does not appear in a session if there’s only one input language.

Support synchronization for more keyboard layouts

Starting with the 2304 version, Citrix Workspace app for Mac supports keyboard layout synchroniza-
tion for the following layouts or Input Method Editors (IMEs):

+ English ABC
+ English ABC - India
Chinese, Traditional: Zhuyin - Traditional

+ Chinese, Traditional: Sucheng - Traditional
« Google Japanese IME
« Sougou Chinese IME

Support for non-English-language Input Method Editors (IME) keyboard layouts

Support for non-English language IME keyboard layouts continues to work uninterrupted after the
Carbon APIs are deprecated with the Cocoa APls.

Windows special keys

Citrix Workspace app for Mac provides several options and easier ways to substitute special keys such
as function keys in Windows applications with Mac keys. Use the Keyboard tab to configure the op-
tions you want to use, as follows:
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Send Control character using: Lets you choose whether to send Command-character key-
stroke combinations as Ctrl+character key combinationsin a session. Select “Command or Con-
trol”from the pop-up menu to send familiar Command-character or Ctrl-character keystroke
combinations on the Mac as Ctrl+character key combinations to the PC. If you select Control,
you must use Ctrl-character keystroke combinations.

Send Alt character using: Lets you choose how to replicate the Alt key within a session. If
you select Command-Option, you can send Command-Option and keystroke combinations as
Alt+ key combinations within a session. Alternatively, if you select Command, you can use the
Command key as the Alt key.

Send Windows logo key using Command (right): Lets you send the Windows logo key to your
remote desktops and applications when you press the Command key on the right side of the
keyboard. If this option is disabled, the right Command key has the same behavior as the left
Command key according to the above two settings in the preferences panel. However, you can
still send the Windows logo key using the Keyboard menu; choose Keyboard > Send Windows
Shortcut > Start.

Send special keys unchanged: Lets you disable the conversion of special keys. For example,
the combination Option-1 (on the numeric keypad) is equivalent to the special key F1. You can
change this behavior and set this special key to represent 1 (the number one on the keypad)
in the session. To do this, select the “Send special keys unchanged”checkbox. By default, this
checkbox isn’t selected so Option-1 is sent to the session as F1.

You send the function and other special keys to a session using the Keyboard menu.

If your keyboard includes a numeric keypad, you can also use the following keystrokes:

PC key or action

Mac options

INSERT 0 (the number zero) on the numeric keypad.
Num Lock must be off; you can turn this on and
off using the Clear key; Option-Help

DELETE Decimal point on the numeric keypad. Num Lock
must be off; you can turn this on and off using
the Clear key; Clear

F1to F9 Option-1to -9 (the numbers one to nine) on the
numeric keypad

F10 Option-0 (the number zero) on the numeric
keypad

F11 Option-Minus Sign on the numeric keypad

F12 Option-Plus Sign on the numeric keypad
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Windows shortcuts and key combinations

Remote sessions recognize most Mac keyboard combinations for text input, such as Option-G to input
the copyright symbol ©. Some keystrokes you make during a session, however, do not appear on the
remote application or desktop. The Mac operating system interprets them. This can result in keys
triggering Mac responses instead.

You might also want to use certain Windows keys, such as Insert, that many Mac keyboards do not
have. Similarly, some Windows 8 keyboard shortcuts display charms and app commands, and snap
and switch apps. Mac keyboards do not mimic these shortcuts. However, these can be sent to the
remote desktop or application using the Keyboard menu.

Keyboards and the ways keys are configured can differ widely between machines. Citrix Workspace
app for Mac therefore offers several choices to ensure that keystrokes can be forwarded correctly to
hosted applications and desktops. These keystrokes are listed in the table. The default behavior is
described. If you adjust the defaults (using the Citrix Workspace app or other preferences), different
keystroke combinations might be forwarded and other behavior might be observed on the Remote
PC Access.

Important

Certain key combinations listed in the table aren’t available when using newer Mac keyboards.
In most of these cases, keyboard input can be sent to the session using the Keyboard menu.

Conventions used in the table:

« Letter keys are capitalized and do not imply that the Shift key must be pressed simultaneously.

+ Hyphens between keystrokes indicate that keys must be pressed together (for example, Control-
Q).

« Character keys create text input and include all letters, numbers, and punctuation marks. Spe-
cial keys do not create input by themselves but act as modifiers or Controllers. Special keys
include Control, Alt, Shift, Command, Option, arrow keys, and function keys.

+ Menu instructions relate to the menus in the session.

+ Depending on the configuration of the user device, some key combinations might not work as
expected, and alternative combinations are listed.

+ Fn refers to the Fn (Function) key on a Mac keyboard. The function key refers to F1 to F12 on
either a PC or Mac keyboard.
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Windows key or key combination

Mac equivalents

Alt+character key

Alt+special key

Ctrl+character key

Ctrl+special key

Ctrl/Alt/Shift/Windows logo +
function key

Ctrl+Alt
Ctrl+Alt+Delete

Delete

End

Esc

FltoF12

Home
Insert
Num Lock
Page Down
Page Up

Spacebar

Command-Option-character key (for
example, to send Alt-C, use
Command-0Option-C)

Option-special key (for example,
Option-Tab); Command-Option-special
key (for example, Command-0ption-Tab)

Command-character key (for example,
Command-C); Control-character key (for
example, Control-C)

Control-special key (for example,
Control-F4); Command-special key (for
example, Command-F4)

Choose Keyboard > Send Function key >
Control/Alt/Shift/Command-
Function key

Control-Option-Command

Control-Option-Fn-Command-Delete;
Choose Keyboard > Send Ctrl-Alt-Del

Delete; Choose Keyboard > Send Key >
Delete; Fn-Backspace (Fn-Delete onsome
US keyboards)

End; Fn—-Right Arrow

Escape; Choose Keyboard > Send Key >
Escape

F1to F12;Choose Keyboard > Send Function
Key > F1 to F12

Home; Fn-Left Arrow

Choose Keyboard > Send Key > Insert
Clear

Page Down; Fn—-Down Arrow
Page Up; Fn-Up Arrow

Choose Keyboard > Send Key > Space
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Windows key or key combination Mac equivalents
Tab Choose Keyboard > Send Key > Tab
Windows logo Command (Right) key (a keyboard preference,

enabled by default); Choose Keyboard > Send
Windows Shortcut > Start

Key combination to display charms Choose Keyboard > Send Windows Shortcut >
Charms

Key combination to display app commands Choose Keyboard > Send Windows Shortcut >
App Commands

Key combination to snap apps Choose Keyboard > Send Windows Shortcut >
Snap

Key combination to switch apps Choose Keyboard > Send Windows Shortcut >
Switch Apps

Use Input Method Editors (IME) and international keyboard layouts

Citrix Workspace app for Mac allows you to use an Input Method Editor (IME) on either the user device
oron the server.

When client-side IME is enabled, users can compose text at the insertion point rather than in a separate

window.
Citrix Workspace app for Mac also allows users to specify the keyboard layout they want to use.
To enable client-side IME

1. From the Citrix Viewer menu bar, choose Keyboard > International > Use Client IME.
2. Ensure that the server-side IME is set to direct input or alphanumeric mode.
3. Use the Mac IME to compose text.

To indicate explicitly the starting point when composing text

« From the Citrix Viewer menu bar, choose Keyboard > International > Use Composing Mark.

To use server-side IME

« Ensure that the client-side IME is set to alphanumeric mode.
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Mapped server-side IME input mode keys

Citrix Workspace app for Mac provides keyboard mappings for server-side Windows IME input mode
keys that aren’t available on Mac keyboards. On Mac keyboards, the Option key is mapped to the
following server-side IME input mode keys, depending on the server-side locale:

Server-side system locale Server-side IME input mode key

Japanese Kanji key (Alt + Hankaku/Zenkaku in Japanese
keyboard)

Korean Right-Alt key (Hangul/English toggle on Korean
keyboard)

To use international keyboard layouts

« Ensure both client-side and server-side keyboard layouts are set to the same locale as the de-
fault server-side input language.

Restore default keyboard settings

If you had previously modified the keyboard preferences in the Citrix Workspace app, you can now
restore the default keyboard settings. To restore the keyboard settings to its default values, open the
Citrix Workspace app and navigate to Preferences > Keyboard. Then, click Restore Defaults and
click Yes to confirm.

Deprecation of International menu from the keyboard settings

Previously, you can enable or disable the Use Client IME, Use Composing Mark and Use Client key-
board layout features in the Citrix viewer by navigating to Devices > Keyboard>International.

From the 2311 version, the International menu for the keyboard settings in the Citrix Viewer is dep-
recated. From this version, the client-side IME is enabled by default.

Support for system shortcuts on HDX desktop sessions

Previously, the system keyboard shortcuts such as Option-Command-ESC, Command-Space bar,
Command-Tab, Control-Command-Q, Shift-Command-Q, Control Up/Down/Left/Right took ef-
fect only on macOS locally since they were consumed by macOS at first.

Starting with the 2402 version, Citrix Workspace app for Mac supports passing the macOS system key-
board shortcuts to the VDA (HDX session) in window mode and full-screen mode. This feature allows
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you to set preferences on how the system shortcut must take effect on macOS locally or the HDX desk-
top session in window or full-screen mode.

The following options in the keyboard settings allow you to control the system shortcuts:

+ Local device: The system shortcuts can take effect only on macOS locally. It does not affect the
HDX session. The Local device option is the default option.

+ Fullscreen HDX session only: The system shortcuts take effect on HDX sessions when the ses-
sionisin full-screen mode. If the session isin window mode or there are no active sessions, then
the system shortcuts have no effect on HDX sessions.

+ Active HDX session: The system shortcuts take effect on HDX sessions when the session is in
window mode and full-screen mode. If there is no active HDX session or the active session win-
dow on the front, then the system shortcuts can take effect only on the macOS locally.

To enable the system shortcuts to take effect on the HDX session, open the HDX session. In the Citrix
Viewer menu bar, navigate to Devices > Keyboard > System shortcuts take effect on and select
Fullscreen HDX session only or Active HDX session.

Note:

When enabling system shortcuts for HDX sessions, you are prompted to provide accessibility ac-
cess to Citrix Viewer to use this feature. To provide accessibility access to Citrix Viewer, click
Open System Settings in the dialog box and enable accessibility access to Citrix Viewer. For

more information, see Allow accessibility apps to access your Mac in the Apple support article.

Send Ctrl-Alt-Del I
Webcam »  Send Windows Shortcut >

Send Key >

Send Function Key >

System shortcuts take effecton > | + Local device H
; @® © @ Rdsl Fullscreen HDX session only : AWTSVDA-1M

Active HDX sess3n

X B

Alternatively, you can enable the system shortcuts to take effect on HDX sessions in full-screen or win-
dow mode by navigating to Preferences > Keyboard. Select Fullscreen HDX session only or Active
HDX session options from the System shortcuts take effect on drop-down menu.
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@ Keyboard L '. L b

zeneral Accounts File Access Deyices

Choose keyboard shortcuts to send commands to your applications.
Send Control character using: 8 Command (left) ar ™ Control
Send Alt character using: 3™ Command {left)-Option Ei
Keyboard layout synchronization settings:  Sync only once - when session starts

Keyboard input mode settings: Unicode

Mote: Scancode is the recommended aption for the "Don't syne” setting.

System shortcuts take effect on: [ERTIR: e |

Mote: Citrix Viewer requires Accessibility permis: Fullscreen HDX session only B
shiartcuts on HDX sessions. N .
Active HDX session
Send Windows logo key using 3 Commana [rigni)

Send special keys unchanged (press 3 Command [left) for same keys)
Show the remote language bar for the published applications

Changes will take effect once you reconnect to this application.

LEarn more
Restore Defaults

Enhancement to the keyboard Settings

Starting with the 2405 version, Citrix Workspace app now provides an improved keyboard settings
user interface (Ul) by categorizing setting options and adding helpful tip icons.

The following settings are now available as secondary options under the Unicode input mode set-
ting:
+ Send Control character using

- This setting specifies an alternative key to act as the Control key (often used for shortcuts
like Ctrl+C for copy) within the virtual session. On different keyboards or operating sys-
tems, the Control key might be in different locations, so this setting allows customization

to maintain consistency for a better user experience.

+ Send Alt character using

- This setting specifies which key can act as the Alt key (used for accessing alternate func-
tions of keys, like Alt+Tab for switching windows).

+ Send Windows logo key using Command (right)
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- This setting specifies the right Command key on a Mac keyboard to function as the Win-

« Send

dows logo key. This setting is particularly useful for macOS users who use the Command
key frequently but need the functionality of the Windows logo key when using Windows
or applications that recognize it.

special keys unchanged (press Command (left) for some keys)

- This setting keeps certain special keys (like function keys, escape, etc.) unchanged in their

Printing

July 9,2024

function, except when the left Command key is pressed. It allows for a hybrid approach
where the default behavior of special keys is retained, but pressing the left Command key

modifies their behavior if needed.

] i »

@ Keyboard

General Accounts File Access Devices

System shortcuts take effect on: Local device i

Keyboard layout synchronization settings:  Sync only once - when session starts

Keyboard input mode settings: Unicode i
Choose keyboard shortcuts configuration for Unicode mode:
Send Control character using: 3 Command (left) or ~ Control e
Send Alt character using: ™. Command (left)-Option

Send Windows logo key using 3 Command (right)

Send special keys unchanged (press ¥ Command (left) for some keys)

Show the remote language bar for the published applications

Changes will take effect once you reconnect to this application.
Learn more Restore Defaults

Starting with the 2203.1 release, you can use PDF universal printing when printing from a Mac device.
If you choose to use PDF Universal Printing, you no longer need to install the HP Color LaserJet 2800
Series PS driver when auto-creating printers with Universal Print Driver.

PostScript Printing

By default, the auto-redirected client printers are created with the Citrix UPD with PostScript support.
For more information, see support article CTX296662.
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Verify the settings for the Universal Print Driver Priority, Universal Print Driver Usage, and Client
Printer Redirection are all set to default. Also ensure that you’ve installed the HP Color LaserJet 2800
Series PS driver on the VDA.

For more information about installing the driver, see support article CTX140208.

PDF Universal Printing

Prerequisites:

« Citrix Workspace app for Mac version 2112 or later - Enables consumption of PDF print streams
for Citrix Workspace app for Mac.

« Citrix Virtual Apps and Desktops version 2112 or later - Enables PDF universal printing for auto-
created client printers.

« Enable the Client printer redirection policy in the Citrix Studio or web console.

@ > Auto-create PDF Universal Printer
User setting -ICA\Printing\Client Printers Edit
Enabled (Default: Disabled)

Unselect

Q > Auto-create client printers
User setting -ICA\Printing\Client Printers Edit
Auto-create all client printers (Default: Auto-create all client printers)

Unselect

@ > Client printer redirection
User setting -ICA\Printing Edit
Allowed (Default: Allowed)

Unselect

@ > Universaldriver preference %%
User setting -ICA\Printing\Drivers Edit
EMF.XPS,PCL5¢c,PCL4,PDF,PS (Default: EMF;XPS;PCL5c;PCL4;PS)

Unselect

° > Universal print driver usage
User setting -ICA\Printing\Drivers Edit

: o . . . . Unselect
Use universal printing only if requested driver is unavailable (Default: Use u...

*%%* “PDF” needs to be added manually if absent from the Universal Driver Preference policy

You can print via PDF once you configure either or both of the following options:

1. Provide a single PDF Universal Printer created in each session.
2. Use the UPD for regular auto-created printers.

Provide a single PDF Universal Printer created in each session

To enable creation of the PDF Universal Printer in sessions from a Mac client or any other PDF en-
abled client endpoint, go to Citrix Studio or the web console and enable the Auto-Create PDF uni-
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versal printer policy.
Once the policy is enabled, the PDF universal printer is created in the session. The printer is called
Citrix PDF Printer.

Use this printer in a session to generate a PDF output that delivers to the client. Also, send the pdf out-
put to the default PDF handling application on the endpoint. For the macOS client, this PDF handling
application is typically the built-in Preview application, but it could be any registered PDF handling
application such as Adobe Acrobat Reader.

Use the UPD for regular auto-created printers

To enable PDF universal printing for all redirected client printers in a session, visit Citrix Studio or a
web console from a Mac client. Then, configure the Universal print driver priority policy to place the
PDF metafile format in before PS within the priority list.

After this configuration, the Citrix PDF Universal Driver replaces the HP Color LaserJet 2800 Series
PS driver on the host for automatically created printers. The automatically created printers use a
universal driver with a Mac client that can print PDFs.

When using one of the auto-created printers in a session, PDF is used as the intermediate format of
the print job. But the print output flows directly to the selected client-attached printer.

Support for printing PDF documents with selected orientation

Starting with the 2405 version, you can now print PDF documents with the correct orientation whether
it’s portrait or landscape. This feature ensures that the printed output aligns perfectly with the in-
tended layout. This feature is enabled by default.

USB

September 16, 2024

Support for managing composite USB device redirection using DDC policies
Starting with the 2409 version, you can manage the composite USB device redirection using the DDC
policies.

With this release, Citrix Workspace app for Mac supports the following policies which help you to man-
age the usage of the composite USB device redirection:
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Client USB device redirection

« Client USB device redirection rules
Client USB device redirection rules (Version 2)

+ Allow existing USB devices to be automatically connected
+ Allow newly arrived USB devices to be automatically connected

Note:
For more information about configuring the preceding policies, see Client USB device redirection in
the Citrix Virtual Apps and Desktops document.

Desktop Viewer’s updates according to the polices:

« If the Client USB device redirection policy is set to Prohibited on DDC, the Devices on the
toolbar is set to insensible and the Devices option on the Citrix Workspace app - Preferences
screen won’t be visible.

« Based on the values set for Allow existing USB devices to be automatically connected and Al-
low newly arrived USB devices to be automatically connected policies, the following check-
boxes might be enabled or disabled on the Devices option on the Citrix Workspace app - Pref-
erences screen:

- When a session starts, connect devices automatically.
- When a new device is connected while a session is running, connect devices automatically.

Limitation:

If the users only redirect one interface of a composite USB device for an application, then the other
interfaces can’t be used by other applications.

USB redirection

HDX USB device redirection enables redirection of USB devices to and from a user device. A user can
connect a flash drive to a local computer and access it remotely from a virtual desktop or a desktop
hosted application.

During a session, users can plug and play devices, including Picture Transfer Protocol (PTP) devices.
For example:

+ Digital cameras, Media Transfer Protocol (MTP) devices such as digital audio players or portable
media players

+ Point-of-sale (POS) devices, and other devices such as 3D Space Mice, Scanners, Signature Pads
and so on.
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Note:

Double-hop USB is not supported for desktop-hosted application sessions.

USB redirection is available for the following:

« Windows
« Linux
* Mac

By default, USB redirection is allowed for certain classes of USB devices, and denied for others. To
restrict the types of USB devices made available to a virtual desktop, update the list of USB devices
supported for redirection. More information is provided later in this section.

Tip
Where security separation between the user device and server is needed, ensure that you inform
users about the types of USB devices to avoid.

Optimized virtual channels are available to redirect most popular USB devices, and provide superior
performance and bandwidth efficiency over a WAN. Optimized virtual channels are usually the best
option, especially in high latency environments.

Note:

For USB redirection purposes, Citrix Workspace app for Mac handles a SMART board the same as

a mouse.

The product supports optimized virtual channels with USB 3.0 devices and USB 3.0 ports. Forexample,
a CDM virtual channel is used to view files on a camera or to provide audio to a headset. The product
also supports Generic USB Redirection of USB 3.0 devices connected to a USB 2.0 port.

Some advanced device-specific features, such as Human Interface Device (HID) buttons on a webcam,
might not work as expected with the optimized virtual channel. Use the Generic USB virtual channel
as an alternative.

Certain devices are not redirected by default, and are only available to the local session. For example,
it would not be appropriate to redirect a NIC that is directly attached via internal USB.

To use USB redirection:

1. Connect the USB device to the device where Citrix Workspace app for Mac is installed.

2. You are prompted to select the available USB devices on your local system.
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Win10 SIN Desktop

Choose the devices you want to connect to your virtual session

3Dconnexion SpaceNavigator
& Apple Inc. iPhone
‘Wacom Co.,Ltd. STU-430

3. Select the device you want to connect and click Connect. If the connection fails, an error mes-
sage appears.

4. In the Preferences window Devices tab, the connected USB device is listed in the USB panel:
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] Devices

n| R B & — & O

e e e,
General File Access Devices Mic & Webcam Keyboard Security & Privacy Advanced

UsB

You can use devices on your local machine and the remote session, depending on the
virtual channel support for the device (optimized or generic) and policy restrictions.

Learn More
Device Current Connection Redirect to Session Virtual Channel
e - Local hi Poli tricted
Apple Inc. Bluetooth USB. .. gt ot frin el
Video Local machine - A
Apple Inc. FaceTime HD C... Remote session x Optimized
@ e hi Redirect G »
3Dconnexion SpaceNavigator Leoal machine g okl =
Storage Local machine

/ imi -~
Western Digital My Book 1230 Remote session ’ Optimized
Audio Local machine o= %
Microsoft Microsoft LifeCh... Remote session - Uplmized

When a session starts, connect devices automatically

When a new device is connected while a session is running, connect the device
automatically

COM Ports
COM Port Device
COM1 None >
COM2 None o
COM3 None >
COM4 None >

5. Select the type of virtual channel (Generic or Optimized) for the USB device.

6. A message is displayed. Click to connect the USB device to your session:

USB Devices Detected
Click to connect the devices to your session.
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Use and remove USB devices

Users can connect a USB device before or after starting a virtual session. When using Citrix Workspace
app for Mac, the following applies:

« Devices connected after a session starts immediately appear in the USB menu of the Desktop
Viewer.

« If a USB device is not redirecting properly, sometimes you can resolve the problem by waiting
to connect the device until after the virtual session has started.

+ To avoid data loss, use the Windows Safe removal menu before removing the USB device.

Supported USB devices

With Apple announcing the deprecation of Kernel Extensions (KEXT), Citrix Workspace app for Mac
migrated to the new user mode USB framework TOUSBHost provided by Apple. This article lists the
supported USB devices.

USB devices that are compatible with USB redirection The following USB devices work seam-
lessly with USB redirection:

« 3DConnexion SpaceMouse

« Mass Storage Devices

+ Kingston DataTraveler USB Flash Drive

+ Seagate external HDD

+ Kingston/Transcend Flash drive 32 GB/64 GB
« NIST PIV smartcard /reader

+ YubiKey

USB devices that fail with USB redirection The Transcend SSD external Hard disk device is not
compatible with USB redirection:

Unverified USB Devices There are plenty of devices, unverified by Citrix, for successful USB redi-
rection with Citrix Workspace app for Mac. Here are some of these devices:

« Other Hard Disks

« Special Keys on the keyboard and headsets that use a custom HID protocol
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Support for Mass Storage devices

We have seen that not all types of Mass Storage devices can be redirected successfully. For the devices
which fail to redirect, there is an optimized virtual channel called Client Drive mapping. Using the
Client Drive mapping, access to the mass storage devices can be controlled through the policies on
the delivery controller.

Support for Isochronous devices Generic USB redirection doesn’t support the Isochronous class
of USB devicesin Citrix Workspace app for Mac. Theisochronous mode of data transferin a USB specifi-
cationindicates devices that stream the timestamped data at a constant rate. For example: WebCames,
USB Headphones, and so on

Support for Composite devices A USB composite device is a single gadget that can perform more
than one function. For example: multi-function printers, iPhone, and so on. Currently, Citrix Work-
space app for Mac does not support redirection of composite devices to the Citrix Virtual Apps and
Desktops and Citrix DaaS session.

Alternatives for unsupported USB devices There are optimized virtual channels that can handle
devices that are not supported with generic USB redirection. These virtual channels are optimized for
speed when compared to generic USB redirection. Some examples are as follows:

« Webcam redirection: Optimized for raw webcam traffic. Microsoft Teams Optimization Pack
has its own method of webcam redirection. Hence, it does not fall under the Webcam redirec-
tion virtual channel.

+ Audio redirection: Optimized to transfer Audio streams.

+ Client Drive Mapping: Optimized for redirecting mass storage devices to the Citrix Virtual Apps
and Desktops and Citrix Daa$S (formerly Citrix Virtual Apps and Desktops service) session. For
example: Flash Drives, Hard Disks, DVD ROM/RW, and so on.

Webcam

November 26, 2024
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Support for plug and play webcam redirection

Starting with the 2411 version, Citrix Workspace app for Mac supports plug and play (PnP) webcam
redirection for Linux VDA and Windows VDA. With this feature, when you connect a built-in or exter-
nal camera to your device, it is automatically detected in the virtual sessions. If you unplug a camera
form the device, Citrix Workspace app for Mac can promptly detect the change and remove the dis-
connected cameras from your selection options in the virtual sessions.

Support for continuity camera

Starting with the 2305 version, you can use the iPhone as your webcam with the continuity camera.
For a seamless connection, mount your iPhone such that its camera is available to the Mac device.
You must select Webcam > Automatic Camera Selection for the iPhone to appear automatically on
the Mac device as an external camera. You can switch to any other camera manually, for example by
selecting Webcam > FaceTime HD Camera. The Continuity Camera works wired or wirelessly and
provides a high-quality image.

Prerequisites

« This feature is supported on a Mac device running on macOS version 13.

« This feature is supported on an iOS device running on iOS version 16.

+ You must be signed into the same Apple account in the Citrix Workspace app on both your iOS
device and Mac device.

« For a wired connection, the iPhone must be connected to the Mac device through a USB.

» Forawireless connection, the iPhone and Mac devices must be in proximity and have Bluetooth
and Wi-Fi turned on.

Some of the advantages are:

+ Center Stage - Keeps the image within the frame as you move around.

+ Portrait mode - Blurs the background of the image.

+ Studio Light - Provides a bright effect on the image. It dims the background and illuminates
the image.

» Desk View —-The iPhone splits the Ultra Wide camera feed into two. It shows the desk and faces
both at the same time.

+ Share Windows - The iPhone splits the Ultra Wide camera feed into two. It shows the desk and
faces both at the same time. The share windows function available in the video conferencing
apps can be used to share the Desk View feed.
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Support for background blur for webcam

Starting with the 2402 version, Citrix Workspace app for Mac supports background blur when using
a webcam. You can enable the background blurring feature by navigating to Preferences > Mic &
Webcam and select Turn on blur when using webcam.

o Mic & Webcam [ i »

General File Access Devices

Choose how to use your microphone and webcam with your applications:

Use my microphone and webcam
Don't use my microphone and webcam
© Ask me each time

Turn on blur when using webcam

Session experience

March 3, 2025

Seamless drag and resize improvements

Starting with version 2411, the seamless drag and resize enhancement feature is automatically en-
abled when Citrix Workspace app for Mac connects to a Windows VDA version 2311 or later. This en-
hancement provides a smoother drag and resize experience for virtual apps, ensuring seamless inter-
action. This feature requires user-provided Accessibility permissions. If Citrix Viewer does not have
the necessary permissions, a prompt appears requesting Accessibility permission.
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Accessibility Access

Permission must be enabled in system settings

Citrix Viewer requires "Accessibility" permission in your device's
system settings to enable a smooth dragging and resizing
experience for your virtual apps. Select Open system settings,
then select the toggle next to Citrix Viewer.

Cancel Open system settings

Support for Rapid Scan

Starting with the 2409 version, Citrix Workspace app for Mac supports the Rapid scan feature. You
can use this feature to scan multiple documents with an iOS device, and then transfer those scanned
documents to a Mac device using the Citrix Workspace app for Mac and iOS.

If you’re signed into Citrix Workspace on both your Mac and iOS device, you can use Rapid Scan to
scan documents with your iPhone or iPad. The scanned files are saved on your Mac, and you can also
access them remotely from a virtual desktop using Client Drive Mapping. This feature works for both
cloud and on-premise stores.

Prerequisites:

+ Ensure that both devices are logged into the same Citrix Workspace account.
+ Both devices must be connected to the same Wi-Fi network.
« The Citrix Workspace app for Mac must be version 2409 or higher.

How to Use Rapid Scan:

1. Open the Citrix Workspace app on your Mac.

2. Long-press (or right-click) the Citrix Workspace icon in the Dock or menu bar.
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@  Citrix Workspace Edit Window Help

o Oi About Citrix Workspace |

Preferences... ¥,

Rapid Scan
© ™

Services >

~ Hide Citrix Workspace ¥H

{Q) Hide Others NoeH |

Show All Apps
E Quit Citrix Workspace 20 | Recents Favorites
M1 Racktane = %

v [ Citrix Workspace

Applications >
Rapid Scan
Options >

Show All Windows
Hide
Quit

3. Select Rapid Scan from the menu. A QR code appears on your Mac screen.
4. OnyouriOS device, go to Settings and tap Rapid Scan.

5. Scan the QR code displayed on your Mac using your iOS device.
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6. When the confirmation window appears on your Mac, click Yes to establish the connection.
You can now use your iOS device to scan documents.

7. Choose to save the scanned files in PDF or JPEG format.
8. By default, the scanned documents are saved to the Downloads folder on your Mac.

9. After the download is complete, click Open in Finder on your Mac to locate the scanned docu-

ments.
Access scanned documents from a Virtual Desktop:

1. Client Drive Mapping (CDM) must be enabled to access your Mac’s storage drives inside the Vir-
tual Desktop. This allows you to transfer files between your Mac and the Virtual Desktop. Please
contact your administrator to enable this feature.

2. Once CDM is enabled, your local drives is visible in the Virtual Desktop.

3. When prompted, allow Read & Write permissions to access your local disk from the Virtual Desk-
top.

4. Navigate to the folder where the scanned documents are stored (the Downloads folder by de-
fault) and copy the files to the Virtual Desktop’s storage.

Connection Strength Indicator

Starting with version 2409, Citrix Workspace app for Mac supports the Connection Strength Indicator
(CSI) on the Desktop Viewer toolbar. This feature displays a network strength icon that alerts you
of network issues. By clicking the icon, you can view real-time connection statistics for the client,
gateway, and VDA, and copy diagnostic information to share with IT for advanced troubleshooting.

Prerequisites

« macOS version must be at least Monterey or above.

+ Telemetry service must be supported on Windows VDA (enabled by default from VDA 2405 and
2402 CU1).

» Telemetry service must be enabled on Linux VDA from version 2311.

+ Telemetry service must be enabled on Mac VDA from Phase | Public TP.

Note:

To use this feature, the new Toolbar feature needs to be enabled. For more information, see

Enhanced Desktop Viewer toolbar.
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Enhanced virtual desktop screen resizing experience

Starting with the 2409 version, Citrix Workspace app for MAC ensures a smooth transition and pre-
vents black screens and flickers when resizing or stretching your virtual desktop screen. This feature
is enabled by default.

Enhanced desktop launch experience

Starting with version 2409, Citrix Workspace App for Mac ensures an enhanced desktop launch ex-
perience. You’ll experience a seamless, flicker-free transition to your desktop without intermediate
screens. The app also eliminates black screens and flickering during resizing or stretching, providing
a stable and modern interface. This feature is enabled by default.

Enhanced clipboard support for HTML text, files, and folders

Starting with version 2409, Citrix Workspace app for Mac supports the seamless copying and pasting of
HTML-formatted text, files, and folders between a Mac local app and a virtual app or desktop session
running through Citrix Workspace app for Mac.

HTML text

Whether you’re working locally or in a virtual session, this functionality ensures that HTML content
is accurately retained during the copy-and-paste process. With this feature, you can copy and paste
large HTML text between local and virtual sessions without any restrictions.
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To enable the HTML format for clipboard, you need to add an entry for CF_HTML and any other in
“Client clipboard write allowed formats”and “Session clipboard write allowed formats”in the ICA pol-
icy settings.

Note:

+ Client clipboard write allowed formats does not apply if the Client clipboard redirection
policy is set to Prohibited or Restrict client clipboard write policy is disabled.

« Session clipboard write allowed formats does not apply if the Client clipboard redirec-
tion policy is set to Prohibited or Restrict session clipboard write policy is disabled.

Files and folders

With this feature, you can do the following:

« Users can copy files and folders between the native Mac client and virtual desktops.

+ Users can copy HTML content between the native Mac client and HDX sessions, and between
HDX sessions.

« Admins can set policies to control the scope of copy-paste capabilities.

« Ensures no corruption in copied files, folders, and content.

The copy and paste of files and folders is enabled by default in the clipboard redirection policy. For
more information, see Client clipboard redirection.

Session reliability and auto client reconnect

Session reliability keeps sessions active and on the user’s screen when network connectivity is in-
terrupted. Users continue to see the application that they’re using until network connectivity re-
sumes.

With session reliability, the session remains active on the server. To indicate that connectivity is lost,
the user’s display freezes until connectivity resumes on the other side of the tunnel. Session reliability
reconnects users without reauthentication prompts.

Important

« Citrix Workspace app for Mac users can’t override the server setting.
« With Session reliability enabled, the default port used for session communication switches
from 1494 to 2598.

You can use session reliability with Transport Layer Security (TLS).
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Note:

TLS encrypts only the data sent between the user device and Citrix Gateway.

Using session reliability policies

The session reliability connections policy setting allows or prevents session reliability.

The session reliability timeout policy setting has a default of 180 seconds, or three minutes. Though
you can extend the time the session reliability keeps a session open, this feature is convenient to the
user. Therefore, it does not prompt the user for reauthentication.

Tip
Extending session reliability timeouts might cause a user to get distracted and walk away from
the device, leaving the session accessible to unauthorized users.

By default, incoming session reliability connections use port 2598, unless you change the port number
in the session reliability port number policy setting.

You can configure the Auto client reconnect authentication policy setting to prompt users to reau-
thenticate when reconnecting to interrupted sessions.

If you use both session reliability and auto client reconnect, the two features work in sequence. Ses-
sion reliability closes, or disconnects, the user session after the amount of time you specify in the
Session reliability timeout policy setting. After that, the auto client reconnect policy settings take
effect, attempting to reconnect the user to the disconnected session.

Note:

Session reliability is enabled by default at the server. To disable this feature, configure the policy

managed by the server.

Configuring session reliability from Citrix Studio

By default, session reliability is enabled.
To disable session reliability:
1. Launch Citrix Studio.

2. Open the Session Reliability connections policy.
3. Set the policy to Prohibited.
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Create Policy

x Select settings
Studio =

(Al Versions) - Session Reliability - A
Settings: 0 selected View selected only

Settings

= e ¥ Session reliability connections Select

kol kol Computer setting - ICA\Session Reliability
Summary Mot Configured (Default: Allowed)
P Session reliability port number Select

Computer setting - ICA\Session Reliability
Not Configured (Default: 2598)
* Session reliability timeout Select
Computer setting - ICA\Session Reliability
Mot Configured (Default: 180 seconds)

Cance

Configuring session reliability timeout

By default, the session reliability timeout is set to 180 seconds.
Note:

Session reliability timeout policy can be configured only with XenApp and XenDesktop 7.11 and
later.

To modify session reliability timeout:

1. Launch Citrix Studio.

2. Open the Session reliability timeout policy.
3. Edit the timeout value.

4. Click OK.

Configuring auto client reconnection using Citrix Studio

By default, auto client reconnection is enabled.
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To disable auto client reconnection:

1. Launch Citrix Studio.
2. Open the Auto client reconnect policy.
3. Set the policy to Prohibited.

Create Policy

H Select settings
Studio ;
]
[ (Al Versicns) - | l Auto Client Reconnect - P
Settings: 0 selected View selected only
Settings
i Mita ¥ Auto client reconnect Select
kol bl Computer setting - ICAVuto Client Reconnect
Summary Mot Configured (Default: Allowed)
* Auto client reconnect authentication Select

Computer setting - ICA\Auto Client Reconnect
Mot Configured (Default: Do not require authentication)

w

Auto client reconnect logging Select
Computer setting - ICA\Auto Client Reconnect
Mot Configured (Default: Do not log auto-reconnect events)

-

Auto client reconnect timeout Select
Computer setting - ICAMuto Client Reconnect
Mot Configured (Default: 120 seconds)

¥ Reconnection Ul transparency level Select
Computer satting - ICA\Auto Client Reconnect
Mot Configured (Default: 80 %)

Cance |

Configuring Auto client reconnection timeout

By default, the Auto client reconnection timeout is set to 120 seconds.
Note:

Auto client reconnect timeout policy can be configured only with XenApp and XenDesktop 7.11
and later.

To modify auto client, reconnect timeout:

1. Launch Citrix Studio.
2. Open the Auto client reconnect policy.
3. Edit the timeout value.
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4. Click OK.
Limitations:

On a Terminal Server VDA, Citrix Workspace app for Mac uses 120 seconds as the timeout value
irrespective of the user settings.

Configuring the Reconnect user interface Transparency

The Session User Interface is displayed during a session reliability and auto client reconnect attempts.
The Transparency level of the user interface can be modified using Studio policy.

By default, Reconnect Ul Transparency is set to 80%.

To modify Reconnect user interface Transparency level:

Launch Citrix Studio.

Open the Reconnect Ul Transparency level policy.
Edit the value.

Click OK.

> wnN e

Auto client reconnect and session reliability interaction

There are mobility challenges associated with switching between various access points, network dis-
ruptions, and display timeouts related to latency. These create challenging environments when try-
ing to maintain link integrity for active Citrix Workspace app for Mac sessions. Citrix enhanced session
reliability and auto reconnection technologies resolve this issue.

This feature allows users to reconnect to sessions automatically after recovery from network disrup-
tions. These features, enabled by policies in Citrix Studio, can be used to improve the user experi-
ence.

Note:

Auto client reconnection and session reliability timeout values can be modified using the de-
fault.ica file in StoreFront.

Auto client reconnection

Auto client reconnection can be enabled or disabled using Citrix Studio policies. By default, this fea-
tureis enabled. For information about modifying this policy, see the auto client reconnection section
earlier in this article.

Use the default.ica file in StoreFront to modify the connection timeout for AutoClienreconnect. By
default, this timeout is set to 120 seconds (or two minutes).
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Setting Example Default

TransportReconnectRetryMaxTSecbradsportReconnectRetryMaxTSecb2ls=60

Session reliability

Session reliability can be enabled or disabled using Citrix Studio policies. By default this feature is
enabled.

Use the default.ica file in StoreFront to modify the connection timeout for session reliability. By de-
fault this timeout is set to 180 seconds (or three minutes).

Setting Example Default

SessionReliabilityTTL SessionReliabilityTTL=120 180

How auto client reconnection and session reliability work

When auto client reconnection and session reliability are enabled for a Citrix Workspace app for Mac,
consider the following:

+ Asession window is grayed out when a reconnection is in progress. A countdown timer displays
the amount of time remaining before the session is reconnected. Once a session is timed out,
it’s disconnected.

By default, the reconnect countdown notification starts at 5 minutes. This timer value represents the
combined default values for each of the timers (auto client reconnection and session reliability), 2 and
3 minutes respectively. The following image illustrates the countdown notification which appears in
the upper right portion of the session interface:
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Tip
You can alter the grayscale brightness used for an inactive session using a command prompt. For
example,defaults write com.citrix.receiver.nomas NetDisruptBrightness

80. By default, this value is set to 80. The maximum value can’t exceed 100 (indicates a
transparent window) and the minimum value can be set to 0 (a fully blacked out screen).

« Users are notified when a session successfully reconnects (or when a session is disconnected).
This notification appears in the upper right portion of the session interface:
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« Asession window which is under auto client reconnect and session reliability control provides
an informational message indicating the state of the session connection. Click Cancel Recon-
nection to move back to an active session.

Service continuity

Service continuity removes or minimizes the dependency on the availability of components that are
involved in the connection process. Users can launch their virtual apps and desktops regardless of
the health status of the cloud services.

For more information, see the Service continuity section in the Citrix Workspace documentation.

Support for service continuity in the Safari browser

Starting with the 2206.1 version, the Citrix Workspace service continuity feature is supported for the
Safari browser. Users must install Citrix Workspace app for Mac and the Citrix Workspace web exten-
sion. Service continuity removes (or minimizes) the dependency on the availability of the components
involved in the connection process. It allows you to connect to your virtual apps and desktops regard-
less of the cloud services’health status. For more information about the service continuity feature,
see section Service continuity.
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Enhancement to Permanent Client Access License (CAL) for Remote Desktop Sessions

Starting with the 2204 version, if you’re running CAL in your environment to access remote desktops,
when the client ID is greater than 15 characters, you can launch the remote desktop session with a

permanent license.

To enable this feature, admins must configure the defau'lt. i ca file by doing the following:

1. In the StoreFront server, navigate to C:\inetpub\wwwroot\Citrix<StoreName>\App_Data and
open the defau'lt. ica file with any editor.
2. Add the following lines in the [WFClient] section:

isRDSLicensingEnabled=0n

Troubleshooting

December 26, 2024

Support for log collection when session launch fails

Starting with version 2411, Citrix Workspace app for Mac supports direct log collection when session
launch fails, allowing for quicker troubleshooting and easier access to logs.

rd g

? EDaaS-BLR3-W10-P

) Close
0 Failed to start

Launch timed out...

C23CA1DB-5BF8-49EA-SDF5-... Collect logs

If the problem persists, contact your admin with this
transaction ID.
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Send feedback on Citrix Workspace app

Starting with the 2307 version, Citrix Workspace app for Mac supports the Send feedback feature. The
Send feedback option allows you to inform Citrix about any issues you might encounter while using
the Citrix Workspace app. You can also send suggestions to help us improve your Citrix Workspace
app experience.

You must select Help > Send feedback to view and fill the issue details in the Send feedback form.
You can add details like the examples provided in the form.

& Send feedback

Provide a descriptive title*
|

Tell us more*

Logs

Basic logs are attached. We recommend you click 'Record my issue' to
capture detailed logs.

For more information, see Log collection

( Record my issue ) WorkspaceLogs_2023_07_18-14_23_43.zip Tl

Attachments
Screenshots or screen recordings of the problem.

Choose files

Your feedback will be used to improve Citrix Workspace app. If you don't
use the Mail app on your Mac, please send feedback to cwa-mac-
feedback@cloud.com with files added manually.

You can attach the existing log files or generate new log files. To generate log files, click Record my is-
sue > Start Recording and then reproduce the issue. After the issue is reproduced, click Stop Record-
ing. The log file is saved automatically and replaces the existing logs with the reproduced logs.
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Note:

Citrix does not collect any Personally Identifiable Information (PIl) from the logs.

You can attach screenshots or screen recordings describing the issue to help us understand what you’
re experiencing. Click Choose files and add the attachments describing your issues, such as screen-
shots or screen recordings. You can attach a maximum of four files.

Onceyou’ve entered the necessary information, click Send to have a new email automatically created
in your Mail app with the information you added. From there, click the Send button to share the
feedback with Citrix.

Note:

If you aren’t using the default Mail app, then send feedback to cwa-mac-feedback@cloud.com
from your mail client. Add the issue details, log files, screenshots, or screen recordings to the

email manually.

Log collection

Starting with the 2304 version, Citrix Workspace app for Mac supports the Log collection feature. Log
collection simplifies the process of collecting logs for Citrix Workspace app. The logs help Citrix to
troubleshoot, and, in cases of complicated issues, provide support.

Starting with the 2402 version, the log collection feature is enhanced to collect and email additional
log data. With this feature, you can easily collect all the required log information at once.

The following additional log data are collected using this feature:

« Crash report for Citrix Process

« Citrix related files under preferences

« Citrix related files launchagents and Llaunchdaemons
« Citrix related files under application or Citrix receiver

You can collect logs using the GUI.
Collecting logs:
1. Open Citrix Workspace app.
2. Right-click on Citrix Workspace in the toolbar and click Preferences > Advanced.

3. Select Logging.
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Updates  Citrix Casting = Logging

Session logging: | Full

Store logging: | Verbose
Log files: 20 log files

Email Log Files

4. Select one of the following session log levels:

+ Basic (Default): Minimum logs are collected for basic troubleshooting.

« Connection Diagnostics: Identifies errors while connecting. All logging is enabled up un-
til the point when the session is deemed successful.

» Verbose: Captures everything including the connection diagnostics. Once enabled, the
Citrix Workspace app will store up to 10 session logs after which they’re deleted starting
with the oldest to maintain 10 logs.

Note:

Selecting the Full logging option can impact performance and must be used only while
troubleshooting an issue because of the amount of data. Do not enable full logging during
normal use. Enabling this level of logging triggers a warning dialog that must be acknowl-

edged for you to continue.

5. Select one of the following store log levels:

+ Disabled (Default): Minimum logs are collected for basic troubleshooting.
« Normal: Only store communication logs are collected.
+ Verbose: Detailed authentication and store communication logs are collected.

6. Click Email Log Files to collect and share logs as a .zip file.

Sentry

Sentry is used to collect app logs to analyze issues and crashes to improve product quality. Citrix does
not collect or store any other personal user information or use Sentry for feature analytics data. For
more information about Sentry, go to [https://sentry.io/welcome/].
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Support for resetting Citrix Workspace app

Starting with the 2405 version, Citrix Workspace app for Mac supports the Reset App Data option. This
features allows users to quickly resolve issues resulting from conflicts caused by cache or settings by
resetting the app and get unblocked without external assistance.

When you reset the Citrix Workspace app:

+ The app is reverted to its default state (similar to just after fresh installation).
+ All cache is cleared.

« Any added stores are removed.

+ Preference settings are return to their default state.

How to Reset Citrix Workspace app

1. Open the Citrix Workspace app.

2. Onthe menu bar, navigate to Help > Reset App Data.
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& Citrix Workspace Edit Window Help
Search
Citrix Workspace Help
Logging...
Email Log Files

" Send feedback
Reset App Data

Check For Updates

Citrix Workspace

3. Click Continue.
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Are you sure you want to Reset Citrix Workspace app?

Resetting will delete your favorited apps and desktops, as well
as accounts and configurations and return Citrix Workspace

app to default settings. It will also close all active sessions.

Warning: You should reset Citrix Workspace app only to
resolve serious problems.

Cancel Continue

4. Click Quit

Reset Citrix Workspace

Citrix Workspace app is reset to the
default settings.

Deprecation

February 5, 2025

This article gives you advance notice of the phase-out of platforms, Citrix products, and features so
thatyou can make timely business decisions. Citrix monitors customer use and feedback to determine
when they are withdrawn. Announcements can change in subsequent releases and might not include
every deprecated feature or functionality.

Deprecated items are not removed immediately. Citrix continues to support them in this release but
they will be removed in the future.
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Item

XenApp Services (also
known as PNAgent)

Support for HDX Real
Time Optimization
Pack for Skype for

Business
macOS version

Monterey (12)

Support for WebRTC
SDP format (Plan B)

macOS version Big Sur
(11)

Citrix Workspace apps
for macOS (Intel (x86)
build)

macOS version
Catalina (10.15)

macOS versions High
Sierra (10.13) and
Mojave (10.14)

Removed/To be
removed in

To be removed in July
2025

To be removed in
February 2025

To be removed in
January 2025

Removed in February
2024

Removed in July 2024
(2405)

Removed in April 2024

Removed in July 2023
(2307)

Removed in
September 2020 (2009)

Deprecation
announced in

February 2025 (2411)

September 2024 (2409)

September 2024 (2409)

2311

September 2023 (2308)

April 2022 (2204)

April 2023 (2304)

August 2020 (2008)

Alternative

Within Citrix
Workspace app,
connect to stores using
the store URL rather
than the XenApp
Services URL

Upgrade Citrix
Workspace app to a
supported version.

Use the supported
operating system as
given in the Supported
operating systems
section.

Upgrade Citrix
Workspace app to a
supported version.
Use the supported
operating system as
given in the Supported
operating systems
section.

Citrix Workspace app
for MacOS that uses
Universal Architecture.
Use the supported
operating system as
given in the Supported
operating systems
section.

Use the supported
operating system as
given in the Supported
operating systems
section.
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